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Notice

The company reserves the right to revise this publication or to change its contents without notice. Information
contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or
any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear
in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse)
of this publication.

This publication and any accompanying software may not, in whole or in part, be reproduced, translated, trans-
mitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators
of this publication, except for copies kept by the user for backup purposes.

Brand and product names mentioned in this publication may or may not be copyrights and/or registered trade-
marks of their respective companies. They are mentioned for identification purposes only and are not intended
as an endorsement of that product or its manufacturer.
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FCC Statement

(Federal Communications Commission)

You are cautioned that changes or modifications not expressly approved by the party responsible for compliance
could void the user's authority to operate the equipment.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in
a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not in-
stalled and used in accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

* Re orient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

» Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
» Consult the service representative or an experienced radio/TV technician for help.

Operation is subject to the following two conditions:

1. This device may not cause interference.
And

2. This device must accept any interference, including interference that may cause undesired operation of the
device.
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FCC RF Radiation Exposure Statement:

1.

This Transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

This equipment complies with FCC RF radiation exposure limits set forth for an uncontrolled environment. This
equipment should be installed and operated with a minimum distance of 20 centimeters between the radiator
and your body.

\ A/
ZAS
Warning
Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not ex-

pressly approved by the manufacturer for compliance with the above standards could void your authority to operate the
equipment.

If your purchase option includes both Wireless LAN and 3.75G modules, then the appropriate antennas will be installed.
Note that In order to comply with FCC RF exposure compliance requirements, the antenna must not be co-located or operate
in conjunction with any other antenna or transmitter.
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IMPORTANT SAFETY INSTRUCTIONS

Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury
to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet
basement or near a swimming pool.

2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There
may be a remote risk of electrical shock from lightning.

3. Do not use the telephone to report a gas leak in the vicinity of the leak.

4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may
explode. Check with local codes for possible special disposal instructions.

5. This product is intended to be supplied by a Listed Power Unit with an AC Input of 100 - 240V, 50 - 60Hz, DC
Output of 20V, 6A OR 18.5V, 6.5A minimum AC/DC Adapter.

CAUTION

Always disconnect all telephone lines from the wall outlet before servicing or disassembling this equipment.

TO REDUCE THE RISK OF FIRE, USE ONLY NO. 26 AWG OR LARGER, TELE-
COMMUNICATION LINE CORD

This Computer’s Optical Device is a Laser Class 1 Product




Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

1.
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Don’t drop it, or expose it to shock. If the computer falls, the case and the components could be damaged.

Do not expose the computer
to any shock or vibration.

Do not place it on an unstable
surface.

Do not place anything heavy
on the computer.

Keep it dry, and don’t overheat it. Keep the computer and power supply away from any kind of heating ele-
ment. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly dam-

aged.

Do not expose it to excessive
heat or direct sunlight.

@

Do not leave it in a place
where foreign matter or mois-
ture may affect the system.

Don't use or store the com-
puter in a humid environment.

Do not place the computer on
any surface that will block the
Vents/Fan Intakes.
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Avoid interference. Keep the computer away from high capacity transformers, electric motors, and other
strong magnetic fields. These can hinder proper performance and damage your data.

Follow the proper working procedures for the computer. Shut the computer down properly and don’t forget
to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

Do not turn off the power
until you properly shut down
all programs.

Do not turn off any peripheral
devices when the computer is
on.

Perform routine maintenance
on your computer.

Do not disassemble the com-
puter by yourself.

Take care when using peripheral devices.

Use only approved brands of
peripherals.

Unplug the power cord before
attaching peripheral devices.
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Power Safety
The computer has specific power requirements:

» Only use a power adapter approved for use with this computer.

» Your AC/DC adapter may be designed for international travel but it still requires a 7Il,<
steady, uninterrupted power supply. If you are unsure of your local power specifications, Power Safety
consult your service representative or local power company. Warning

» The power adapter may have either a 2-prong or a 3-prong grounded plug. The third Before you undertake
prong is an important safety feature; do not defeat its purpose. If you do not have access any upgrade proce-

to a compatible outlet, have a qualified electrician install one. dures, make sure that
you have turned off the

power, and discon-

*  When you want to unplug the power cord, be sure to disconnect it by the plug head, not
by its wire.

. nected all peripherals
» Make sure the socket and any extension cord(s) you use can support the total current e

and cables (including

load of all the connected devices. telephone lines). It is
» Before cleaning the computer, make sure it is disconnected from any external power advisable to also re-
supplies (i.e. AC/DC adapter or car adapter). move your battery in
order to prevent acci-
dentally turning the
Do not plug in the power Do not use the power cord if | Do not place heavy objects machine on.
cord if you are wet. it is broken. on the power cord.

\1
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Battery Precautions

« Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.

« Do not remove any batteries from the computer while it is powered on.

« Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even
if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly
result in fire.

 If you do not use the battery for an extended period, then remove the battery from the computer for storage.

» Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.

» Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qual-
ified service personnel.

» Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries
may explode or leak if exposed to fire, or improperly handled or discarded.

» Keep the battery away from metal appliances.

» Affix tape to the battery contacts before disposing of the battery.

* Do not touch the battery contacts with your hands or metal objects.

\ A/
ALK
Battery Disposal & Caution
The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life,

under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with
your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the
manufacturer. Discard used battery according to the manufacturer’s instructions.

VI
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Cleaning

Do not apply cleaner directly to the computer; use a soft clean cloth.
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing

Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the
computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the
power supply. Then refer servicing to qualified service personnel under any of the following conditions:

*  When the power cord or AC/DC adapter is damaged or frayed.

 If the computer has been exposed to rain or other liquids.

 If the computer does not work normally when you follow the operating instructions.

« If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
 If there is an unusual odor, heat or smoke coming from your computer.

S
&
Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and
screw(s) before turning the computer on.
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Travel Considerations

Packing
As you get ready for your trip, run through this list to make sure the system is ready to go:

Check that the battery pack and any spares are fully charged.

Power off the computer and peripherals.

Close the display panel and make sure it's latched.

Disconnect the AC/DC adapter and cables. Stow them in the carrying bag.

The AC/DC adapter uses voltages from 100 to 240 volts so you won't need a second voltage adapter. However,
check with your travel agent to see if you need any socket adapters.

Put the notebook in its carrying bag and secure it with the bag’s straps.

If you're taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters
and/or cables.

8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both hard-
ware and software. Make sure your documents are prepared.

SN
ALK

Power Off Before Traveling

agprwNPE

N o

Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a
notebook which is powered on in a travel bag may cause the vent(s)/fan intake(s)/outlet(s) to be blocked. To prevent your
computer from overheating make sure nothing blocks the vent(s)/fan intake(s)/outlet(s) while the computer is in use.
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On the Road

In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting,
keep these points in mind:

Hand-carry the notebook - For security, don’t let it out of your sight. In some areas, computer theft is very
common. Don’t check it with normal luggage. Baggage handlers may not be sufficiently careful. Avoid knock-
ing the computer against hard objects.

Beware of Electromagnetic fields - Devices such as metal detectors & X-ray machines can damage the com-
puter, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and
disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). Note:
Some airports also scan luggage with these devices.

Fly safely - Most airlines have regulations about the use of computers and other electronic devices in flight.
These restrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make
sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

Get power where you can - If an electrical outlet is available, use the AC/DC adapter and keep your battery(ies)
charged.

Keep itdry - If you move quickly from a cold to a warm location, water vapor can condense inside the computer.
Wait a few minutes before turning it on so that any moisture can evaporate.

Xl
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Developing Good Work Habits

Developing good work habits is important if you need to work in front of the computer for long periods of time.
Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or
other joints. The following are some tips to reduce the strain:

< Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the
level of your elbow. Keep your forearms, wrists, and hands in a relaxed position.

» Your knees should be slightly higher than your hips. Place your feet flat on the floor or on
a footrest if necessary.

¢ Use a chair with a back and adjust it to support your lower back comfortably.

« Sit straight so that your knees, hips and elbows form approximately 90-degree angles
when you are working.

e Take periodic breaks if you are using the computer for long periods of time.

Remember to:

e Alter your posture frequently.

»  Stretch and exercise your body several times a day.

»  Take periodic breaks when you work at the computer for long periods of time. Frequent
and short breaks are better than fewer and longer breaks.

Xl
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Lighting
Proper lighting and comfortable display viewing angle can reduce eye strain and muscle fatigue in your neck and
shoulders.

Position the display to avoid glare or reflections from overhead lighting or outside sources of light.

Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
Position the display directly in front of you at a comfortable viewing distance.

Adjust the display-viewing angle to find the best position.

LCD Screen Care

To prevent image persistence on LCD monitors (caused by the continuous display of graphics on the screen for
an extended period of time) take the following precautions:

Set the Windows Power Plans to turn the screen off after a few minutes of screen idle time.

Use a rotating, moving or blank screen saver (this prevents an image from being displayed too long).
Rotate desktop background images every few days.

Turn the monitor off when the system is not in use.

X1l
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Quick Start Guide

Chapter 1. Quick Start Guide

Overview

This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the
computer and to getting your system started. The remainder of the manual covers the following:

e Chapter 2 A guide to using some of the main features of the computer e.g. the storage devices (hard disk,
optical device, 7-in-1 card reader, ExpressCard/34/54), TouchPad & Mouse, Audio & Printer.

e Chapter 3  The computer’s power saving options.

e Chapter 4  The installation of the drivers and utilities essential to the operation or improvement of some of the
computer’s subsystems.

e Chapter 5  An outline of the computer’s built-in software or BIOS (Basic Input Output System).

e Chapter 6  Instructions for upgrading your computer.

» Chapter 7 A quick guide to the computer’s Bluetooth, PC Camera, Wireless LAN, Fingerprint, 3.75G/
HSPA, TV Tuner and RAID modules (some of which may be optional depending on your pur-
chase configuration).

e Chapter 8 A troubleshooting guide.

» Appendix A Definitions of the interface, ports/jacks which allow your computer to communicate with external
devices.

» Appendix B Information on the NVIDIA Video driver controls.

» Appendix C The computer’s specification.

» Appendix D Information specific to the Windows 7 OS.

. |
Overview 1 -1
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Advanced Users

If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful
to refer to “What to Install” on page 4 - 1, “BIOS Utilities” on page 5 - 1 and “Upgrading The Computer” on
page 6 - 1 in the reminder of the User’s Manual. You may also find the notes marked with a /Z of interest to you.

Beginners and Not-So-Advanced Users

If you are new to computers (or do not have an advanced knowledge of them) then
4 the information contained in the Quick Start Guide should be enough to get you up
Notes and running. Eventually you should try to look through all the documentation (more
Check the light colored detailed descriptions of the functions, setup and system controls are covered in the
boxes with the mark . remainder of the User’s Manual), but do not worry if you do not understand every-
above to find detailed in- = thing the first time. Keep this manual nearby and refer to it to learn as you go. You
tors foatire. e <™ | may find it useful to refer to the notes marked with a #as indicated in the margin.
For a more detailed description of any of the interface ports and jacks see “Interface

(Ports & Jacks)” on page A - 1.

Warning Boxes

No matter what your level please pay careful attention to the warning and safety information indicated by the
2 symbol. Also please note the safety and handling instructions as indicated in the Preface.

1-2 Overview
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Not Included

Operating Systems (e.g. Windows Vista/Windows 7) and applications (e.g. word processing, spreadsheet and da-
tabase programs) have their own manuals, so please consult the appropriate manuals.

4

Drivers

If you are installing new system software, or are re-configuring your computer for a different system, you will need to install
the drivers listed in “ Drivers & Utilities” on page 4 - 1. Drivers are programs which act as an interface between the com-
puter and a hardware component e.g. a wireless network module. It is very important that you install the drivers in the order
listed. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed. If
your system hasn't been properly configured (your service representative may have already done that for you); refer to
Chapter 4 for installation instructions.

Ports and Jacks

See Appendix A for a description of the interface (ports & jacks) which allow your computer to communicate with external
devices, connect to the internet etc.

. |
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System Startup

1. Remove all packing materials.

2. Place the computer on a stable surface.

3. Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.

4. Attach the AC/DC adapter to the DC-In jack at the rear of the computer, then plug the AC power cord into an
outlet, and connect the AC power cord to the AC/DC adapter.

Use one hand to raise the lid/LCD to a comfortable viewing angle (do not exceed 120 degrees); use the other
hand (as illustrated in Figure 1 - 1 below) to support the base of the computer (Note: Never lift the computer by
the lid/LCD).

o

4

Shutdown

Note that you should always shut your computer down by choosing the Shut Down command from the Lock Button Menu
in Windows Vista. This will help prevent hard disk or system problems.

Figure 1 - 1 - Opening the Lid/LCD

1 -4 Overview
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System Software

Your computer may already come with system software pre-installed. Where this is 7£l<
not the case, or where you are re-configuring your computer for a different system, TV Tuner Module
you will find the following operating systems are supported. Support
: : Note that the TV Tuner
Operating System & Version Note module (factory) option in
Windows Vista - with Service Pack 2 In order to run Windows Vista/Windows 7 th;n\c,i\;ai\rl]vdso\l,\slssnpep;gegez)f
without limitations or decreased performance, el softwarelwhichicomes
Windows 7 your computer requires a minimum 1GB of built-in to the Windows
system memory (RAM). Vista Home Premium and

Ultimate Editions only.

Table 1 -1 - Operating Systems Supported

If your purchase includes a

RAID & AHCI Setup TV Tuner option, and you

Note that setting up a RAID, or AHCI mode, needs to be done prior to installing the o rtfe-conf(ijg;ring your sy

. o . ,, em for a different system,

Windows OS (see “Setting Up SATA RAID or AHCI Modes” on page 7 - 60). e el el el

Home Premium or Ulti-

mate Editions of Windows

4 Vista only. Note that Win-

Windows Vista/Windows 7 ,dOWS Med_|a i) 5 e

included in Starter or

This manual refers to the Windows Vista OS. For any information specific to Windows 7 see Ap- Home Basic versions of
pendix D. Make sure you install Windows Vista Service Pack 2 (or a Windows Vista version which Windows 7.

includes Service Pack 2) before installing any drivers. Go to the Microsoft website for download
details, or contact your service center.

Overview 1-5
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Model Differences

This notebook series includes two different model types that differ as indicated in the table below (see Appendix D).

Feature Model A Model B
Display Type 15.6" HD (1366 * 768) / HD+ (1600 * 900) / FHD 17.3" FHD (1920 * 1080) / HD+ (1600 * 900) 16:9
Supported (1920 * 1080) 16:9 Wide Screen LED Panel Wide Screen LED Backlit Panel
vid nVIDIA® GeForce GTX 280M
Controler OR nVIDIA® GeForce GTX 280M
nVIDIA® GeForce GTX 260M
RAID Supported Not Supported RAID Level 0/1 Supported
Mini-Card Slot 2 for UMTS/HSPA 3.75G Module for TV Tuner Card
Design

Table 1 - 2 - Model Differences

1 - 6 Model Differences



System Map: Front View - Model A
ﬁ

Wireless Device
Operation Aboard Aircraft

The use of any portable electronic trans-
mission devices aboard aircraft is usually
prohibited. Make sure the module(s) are
OFF if you are using the computer aboard
aircraft.

Use the key combinations to toggle power
to the 3.75G/HSPA/WLAN/Bluetooth
modules, and check the LED indicator
icon to see if the modules are powered on
or not (see /

).

Touchpad Buttons
(valid operation area)

Quick Start Guide

Figure 1 -2
Front View
(Model A Computers)

1. Built-In PC Camera

(Optional)

LCD

Power Button

Speakers

LED Hot Key

Buttons

LED Status

Indicators

Keyboard

Built-In Microphone

9. Touchpad &
Buttons

10. LED Power
Indicators

arwdn

o

© N

Note: The Fingerprint
Reader module is optional
for Model A computers.

System Map: Front View - Model A 1-7
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Figure1-3
Front View

(Model B Computers)

System Map: Fr

ont View - Model B

N A
2

1. Built-In PC Camera Wireless Device
(Optional) Operation Aboard Aircraft
2. LCD The use of any portable electronic
3. LED Status transmission devices aboard air-
Indicators craft is usually prohibited. Make
4. LED Hot Key sure the module(s) are OFF if you
Buttons are using the computer aboard air-
5. LED Power Button crait
6. Speakrs e
7. Ke_yboard, Fnoodiles, and check the LED indi-
8. Built-In Microphone cator icon to see if the modules are
9. Touchpad & powered on or not (see
Buttons /
10. Consumer Infrared )-
Transceiver (for
Optional TV Tuner)
11. LED Power
Indicators

Note: The Fingerprint
Reader module is optional )

for Model B computers.

’! }

Touchpad Buttons (valid operation area)

1 - 8 System Map: Front View - Model B
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LED Indicators A further two LED power indicators on the front right
of the computer provide information on the comput-

The LED indicators on the LED strip just below the ¢ power status.

LCD panel on the computer display helpful informa-
tion about the current status of the computer when il- Icon Color Description
luminated. Orange DC Power is Plugged In
Icon Description D"/(D Green The Computer is On
Blinking Green The Computer is in Sleep
% Hard Disk Activity g Mode
—~ Number Lock Activated Orange The Battery is Charging
(to activate press Fn & Num LK) m Green The Battery is Fully Charged
) .
Caps Lock Activated o The Battery Has Reached
Blinking Orange Critically Low Power Status
- Scroll Lock Activated
(to activate press Fn & Scr Lk) .
Table 1 - 4 - LED Power Indicators
The (optional) Wireless LAN Module is Powered
((con)
A On
((%.T,)] The (optional) Bluetooth Module is Powered On

Table 1 - 3 - LED Status Indicators

LED Indicators 1 -9
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4

Other Keyboards

Hot Key Buttons & Keyboard

The LED hot key buttons give instant access to the default Internet browser and e-
mail program, and allow you to toggle Silent Mode with one quick button press.

If your keyboard is
damaged or you just Hot Key Function
want to make a
change, you can use
any standard USB key-
board. The system will
detect and enable it
automatically. Howev-
er special functions/
hot-keys unique to the
system’s regular key-
board may not work.

Activate the Default E-Mail Browser (Note that In Windows 7 without Outlook/
Outlook Express installed this button has no function. If Outlook/Outlook Express are
installed then the button will activate the application)

Activate the Default Internet Program

Toggle *Silent Mode (for power saving)

2% G

Table 1 - 5- LED Hot Key Buttons

*When enabled, Silent Mode will reduce fan noise and save power consumption.

Hold down the Fn Key Note this may reduce computer performance.
and either NumLk or

NumLk & ScrLk

ScrLk to enable num- /
ber or scroll lock, and
check the LED indica- Special Characters

tor for status. - . -
Some software applications allow the number-keys to be used with Alt to produce special characters.

These special characters can only be produced by using the numeric keypad. Regular number keys (in
the upper row of the keyboard) will not work. Make sure that NumLKk is on.

1-10 Hot Key Buttons & Keyboard
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Quick Start Guide

The keyboard has a numerical keypad on the right for easy numeric data input, and features function keys to
allow you to change operational features instantly. See Table 1 - 6, on page 1 - 12 for full function key combi-

nation details.

= Fi F2_| [F3 _ Fe 1 fFs | fre _0 (Fr__) (/8 __1 (P8 1 (Fl0_ TF11_ F12__
¥ ® | @ @ @ @ @ 68 @ @& @ @ |

= ! @ # $ Function Keys & * ( ) -

~ 1 2 3 4 5 6 7 8 9 0 -

FlaylPausekey (w1 (E 1R [T [y J[u |1 1o ][P [t

[

p— Alls |o]lF Ife 1[# I[v |Ix ]It ][

_ z |{x e Ifv 18 N [M™ ][ |[> ][

cl D a Alt Alt B cirl

Fn Key

Figure 1 - 4 - Keyboard

PrtSc
SysRq

Pause Ins Del
et ||| G| @i | |/ #
NumLk &

«—Backs SCrLKk Keys
Del

} H 7 8 9
1 \ Home T Pglp
+— Enter 4 5 6
Numerical Keypad
. 1 2 3
> Shift )
! &2 | | gng | PgDn
0 Enter
H*‘ ( H :.'F -| : :Er !.'_; —

Keyboard 1-11
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Function/Hot Key Indicators

The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down. In addition
to the basic function key combinations; visual indicators are available when the hot key utility is installed.

Fn Keys Function Fn Keys Function
Fn+~ Play/Pause (in Audio/Video Programs) Fn + F5/F6 Volume Decrease/Increase OQ GQ
At dl T ¢!
3.75G Module Power .
Fn+_ [zi Toggle* Fn+F7 Display Toggle
Fn+F1 Touchpad Toggle Fn + F8/F9 Br|ghtr:ess Decrease/ Q’Q _m
ncrease nmanm / f
Turn LCD Backlight Off PC Camera Power " B = '
Fn+F2 (Press a key to or use TouchPad to turn on) Fn+F10 Toggle on) ~»g &
4 4
Fn+F3 Mute Toggle on ) ) Fn + F11 WLAN Module Power on L | (iore : y
" Toggle ’
4 4 | e 4
En+ E4 Sleep Toggle En+ E12 Bluetooth Module Power I» & 7> @
Toggle A
*Silent Mode Toggle e g *When enabled, Silent Mode will reduce fan noise and save power
99 oo Ko/ consumption. Note this may reduce computer performance.
4 4

Table 1 - 6 - Function & Hot Key Indicators

1-12 Function/Hot Key Indicators
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System Map: Left View Figure 1-5
= Left View

1. RJ-11 Modem Jack
2. USB 2.0 Port
3. Mini-IEEE 1394

Port
- 4. 7-in-1 Card Reader
Model B —_ ' 5. Optical Device
— - Drive Bay (for DVD
= - r Device)

6. Cable (CATV)
Antenna Jack*

*Enabled with Optional TV
7-in-1 Card Reader Tuner Only

The card reader allows you to use the most popular digital storage card formats:

MMC (MultiMedia Card) / SD (Secure Digital) / MS (Memory Stick) /
MS Pro (Memory Stick Pro) / MS Duo (requires PC adapter) /
Mini SD (requires PC adapter) / RS MMC (requires PC adapter)

Mini-IEEE 1394 Port

The Mini-IEEE 1394 port only supports SELF POWERED IEEE 1394 devices. Make sure
you install the Firewire IEEE 1394 driver (see page 4 - 6).

.|
System Map: Left View 1 - 13
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Disk Eject Warning

Don't try to eject a CD/DVD while the system is ac-
cessing it. This may cause the system to “crash”. Stop
the disk first then eject it, or press the stop button
twice.

CD/DVD Emergency Eject

If you need to manually eject a CD/DVD (e.g. due to
an unexpected power interruption) you may push the
end of a straightened paper clip into the emergency
eject hole. Do not use a sharpened pencil or any ob-
ject that may break and become lodged in the hole.
Don't try to remove a floppy disk/CD/DVD while the
system is accessing it. This may cause the system to
“crash”.

4

Changing DVD Regional Codes

Go to the Control Panel and double-click Device
Manager (Hardware and Sound), then click the +
next to DVD/CD-ROM drives. Double-click on the
DVD-ROM device to bring up the Properties dialog
box, and select the DVD Region (tab) to bring up the
control panel to allow you to adjust the regional code
(see “DVD Regional Codes” on page 2 - 5).

DVD region detection is device dependent, not OS-
dependent. You can select your module’s region
code 5 times. The fifth selection is permanent. This
cannot be altered even if you change your operating
system or you use the module in another computer.

.|
1-14 System Map: Left View



System Map: Right View

Model A

Quick Start Guide

N

o0k w

© N

10.

Figure 1 - 6
Right View

Headphone-Out
Jack
Microphone-In
Jack

Line-In Jack
S/PDIF-Out Jack
USB 2.0 Port
ExpressCard Slot
(see page 2 - 7)
e-SATA Port
DVI-Out Port
Security Lock Slot
(Model B Only)
Power Button
(Model A Only)

System Map: Right View 1 - 15
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Figure 1- 7 System Map: Rear View

Rear View

1. Vent/Fan Intake/
Outlet

2. Security Lock

Slot (Model A

Only)

HDMI-Out Port

DC-In Jack

2 * USB Ports

RJ-45 LAN Jack

Rear Cover

(Model B Only)

No Ok

\ A/
’Q‘ HDMI-Out Port

Overheating Note that the HDMI-Out Port supports video and audio signals to attached external dis-
plays (also see “HDMI Audio Configuration” on page B - 11).

To prevent your comput-

er from overheating
make  sure  nothing \—)
blocks the vent(s)/fan in-

take(s) while the com-
puter is in use.

1-16 System Map: Rear View
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System Map: Bottom View - Model A

Figure 1-8
Bottom View
4 (Model A

Battery Information & Computers)
Always completely dis- ’ g 1) 1. Battery
charge, then fully charge, a R 2. Component Bay
new battery before using it. Cover
Completely discharge and 3. Vent/Fan Intake/
charge the battery at least Outlet

once every 30 days or after
about 20 partial discharges.
See “Battery Information”

on page 3 - 10 for full in-
structions.

Note: the 3.75G/HSPA
USIM Card is located un-
der the Component Bay
Cover.

CPU
The CPU is not a user serviceable part.

Overheating

To prevent your computer from overheating make sure nothing blocks the Vent/Fan Intake
while the computer is in use.

System Map: Bottom View - Model A 1-17
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System Map: Bottom View - Model B

Figure 1 -9
Bottom View
(Model B 4
Computers) Battery Information
1. Battery Always completely dis-
2. Component Bay charge, then fully charge, a
Cover new battery before using it.
3. Vent/Fan Intake/ Completely discharge and
Outlet charge the battery at least
4. Speaker once every 30 days or after

about 20 partial discharges.
See “Battery Information”

on page 3 - 10 for full in-
structions.

The CPU is not a user serviceable part.

Overheating

To prevent your computer from overheating make sure nothing blocks the Vent/Fan Intake
while the computer is in use.

1-18 System Map: Bottom View - Model B



Quick Start Guide
Windows Vista Start Menu & Control Panel

Most of the control panels, utilities and programs within Windows Vista (and most other Windows versions) are
accessed from the Start menu. When you install programs and utilities they will be installed on your hard disk
drive, and a shortcut will usually be placed in the Start menu and/or the desktop. Right-click the Start menu
icon 4, and then select Properties if you want to customize the appearance of the Start menu.

@) oeurogoms |

#1 Windows Update
<

‘ Open e Imternet

Explore o Emal

o
Search... u

Properties 7 Programs

= s, Documents
| Open All Users >

m‘ Explore All Users
T

B Control Panel

v
|=# Printers
L Taskbar and Start Menu

- "Tues

X0 'gbghéle;_cigs:—éic"_\;/iéw

e Start Sea O -

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features
in Windows (e.g. power, video, network, audio etc.). Windows Vista provides basic controls for many of the fea-
tures, however many new controls are added (or existing ones are enhanced) when you install the drivers listed
in Table 4 - 1, on page 4 - 3. To see all controls it may be necessary to toggle to Classic View on.

Windows Vista Start Menu & Control Panel 1 - 19
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Video Features

You can configure display options, from the Display Settings control panel in Windows as long as the appro-
priate video driver is installed. For more detailed video information see “NVIDIA Video Driver Controls” on
page B - 1.To access Display Settings in Windows:

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).

2. Click Adjust screen resolution under the Appearance and Personalization menu (or double-click
Personalization > Display Settings).

Move the slider to the preferred setting in Resolution: @ (Figure 1 - 11 on page 1 - 21).

Click the arrow, and scroll to the preferred setting In Colors: @(Figure 1 - 11 on page 1 - 21).

Click Advanced Settings (button) @ (Figure 1 - 11 on page 1 - 21).

Click GeForce..... (tab).

Click Start the NVIDIA Control Panel @ (Figure 1 - 11 on page 1 - 21) to access the control panel.
The NVIDIA Control Panel can also be accessed by right-clicking the desktop, and then clicking NVIDIA
Control Panel (or from the NVIDIA Control Panel in the Windows control panel).

4

Video Card Options

©No O~

Note that card types, specifications and drivers are subject to continual updates and changes. Check with your service
center for the latest details on video cards supported (see “Video Adapter Options” on page C - 2 for details).

1 - 20 Video Features
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Display Devices & Options

Besides the built-in LCD, you can also use an external VGA monitor (CRT)/external Flat Panel Display or
TV (connected to the DVI-Out port/HDMI-Out port) as your display device.

(& Diaplay Setsi & Generic P Manitor and NVIDIA GeForer GTX 7800 Proper. SSS B 00 ComlParel =]
T = | B b ton bobio Doy tep
Moritor I Adscter Monter | Q e - Q) | [T Aeancessetings +
Color Maragemant " GeFason G 2800 =
Drag the icans te match your maniors, | isestity Monitars o [3) Set Up Multiple Displays e U
e L e ottt
o

ﬂ nvinia
L Selet the ey you want touse.
Lt G I
Lovking for the NVIDIA Diapley Cortrel Panel?
0 ofthe MDA antrl parels have heen conschdnied o a sngie

sophcetion, tve NVIDIA Cortrol Panel. & can B¢ lsunched from the Windows
Cortrcd Parsl o by right <icking en Live Windows desklop.

STV

1. Genenie P Mortes on NVIDIA GeFesce (T 250M -

Besolution: Celars
Low ] High Highest (32 ba) el

1920 by 1200 pieds

{ow do 1 get the best displey? .WMdsﬂmnge

e [

| J - T — omrpsee

Figure 1 - 11 - Display Settings & NVIDIA Control Panel

NVIDIA Display Mode Description

Single One display device is used.

Clone Both connected displays output the same view

Dualview Both connected displays are treated as separate devices, and act as a virtual desktop

Table 1 - 7 - Display Modes Available

Video Features 1 - 21
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Power Options

The Power Options (Hardware and Sound menu) control panel icon in Windows (see page 1 - 18) allows you
to configure power management features for your computer. You can conserve power by means of power plans
and configure the options for the power button, sleep button, computer lid (when closed), display and sleep
mode from the left menu. Note that the Power saver plan may have an affect on computer performance.

Click to select one of the existing plans, or click Create a power plan in the left menu and select the options to
create a new plan. Click Change Plan Settings and click Change advanced power settings to access further con-
figuration options.

Pay attention to the instructions on battery care in “Battery Information” on page 3 - 10.

S 199+ Cortet et 1 P Oy + e ot =] 4y | Soim 7

5 « Power Options

Battery life: 900
Performance: 999

Battery life: 990900
Performance: : 00

) High performance Battery ffe; 00
Change plan settings Performance: 908800

Note: Sleep is the default power saving state in Windows Vista
Figure 1 - 12 - Power Options

1 - 22 Power Options
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Chapter 2. Features & Components

Overview

Read this chapter to learn more about the following main features and components
of the computer:

Hard Disk Drive

Optical (CD/DVD) Device
7-in-1 Card Reader
ExpressCard Slot

TouchPad and Buttons/Mouse
Gesture Configuration
Adding a Printer

. |
Overview 2 - 1
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Hard Disk Drive

SN

’Ll‘ The hard disk drive is used to store your data in the computer. The hard disk can be

Power Safety taken out to accommodate other 2.5" serial (SATA) hard disk drives (see “Storage”
S e eper-efl  on page C - 3) with a height of 9.5 mm.

cess any of the internal L .
SO i e The hard disk is accessible from the bottom of your computer as seen below. For fur-

ool ther details see “Upgrading the Hard Disk Drive(s)”” on page 6 - 4.
that the machine is not

connected to the AC
power, and that the ma-
chine is turned off. Also
ensure that all peripher-
al cables, including
phone lines, are discon-
nected from the comput-

Model A ! Model B

els

Figure2-1
Hard Disk Location

2 - 2 Hard Disk Drive
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Optical (CD/DVD) Device

There is a bay for a 5.25" optical (CD/DVD) device (12.7mm height). The actual de- Z
vice will depend on the module you purchased (see “Storage” on page C - 3). The Sound Volume
optical device is usually labeled “Drive D:” and may be used as a boot device if Adjustment

properly set in the BIOS (see “Boot Menu” on page 5 - 12). How high the sound vol-
ume can be set depends

Loading Discs on the setting of the vol-
ume control within Win-

To insert a CD/DVD, press the open button @ and carefully place a CD/DVD onto | gows. Click the Volume
the disc tray with label-side facing up (use just enough force for the disc to click onto | icon on the taskbar to
the tray’s spindle). Gently push the CD/DVD tray in until its lock “clicks” and you | check the setting (see
are ready to start. The busy indicator @ will light up while data is being accessed, | Cesture Configura-
or while an audio/video CD, or DVD, is playing. If power is unexpectedly interrupt-
ed, insert an object such as a straightened paper clip into the emergency eject hole
© to open the tray.

tion” on page 2 - 9).

Figure 2 - 2
Optical Device

Optical (CD/DVD) Device 2 - 3
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Handling CDs or DVDs

7\[:1% Proper handling of your CDs/DVDs will prevent them from being damaged. Please
follow the advice below to make sure that the data stored on your CDs/DVDs can be

CD Emergency Eject
accessed.

If you need to manually

gjecta CD (e.g-due to I\ RGR{el[[e)WWIgls)

an unexpected power

LIEERT RS CIER eV« Hold the CD or DVD by the edges; do not touch the surface of the disc.
EEREERCIE SRS  «  Use a clean, soft, dry cloth to remove dust or fingerprints.
f;{g'g}fi?ﬁgrg‘;‘gejﬂg « Do not write on the surface with a pen.

L SENEE el ¢ Do not attach paper or other materials to the surface of the disc.
GNeRETEEE R ETER ¢ Do not store or place the CD or DVD in high-temperature areas.
SUSCRREIEIREESUIIESE o Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
SRR e . Do not bend the CD or DVD.

db lodged i -
%ne hofe(?ome =S8l . Donot drop or subject the CD or DVD to shock.

Disk Eject Warning

Don't try to remove a
CD/DVD while the sys-
tem is accessing it. This
may cause the system
to “crash”.

.|
2 - 4 Optical (CD/DVD) Device
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DVD Regional Codes

To change the DVD regional codes see “Changing DVD Regional Codes” on
page 1 - 14.

DVD Regional Coding

Table2-1

8 g g S — . .
Region Geographical Location . - : DVD Regional Coding
| General | DVD Region | Volumes | Diiver, | Details|
Most DVDs are sncoded for play in spec Toplay
1 USA, Canada resprilges VI sy el o s ack your BV vt
play discs from that region by selecting @ geograshic arca from the
following fist.
Western Europe, Japan, South CALTION, “Youi i Ghainge the esian 2 rled b of G
2 . . Aiter Changes remairing reaches 6o, you cannet change the region even
Afrlca, M |dd|e East & Egypt i you reinstall Windows or move your DVD drive to a diferent computer.

Changes remaining: 5

South-East Asia, Taiwan, South

To changs the curent regian, sslsct a gsographic arsa, and then dick OK

3 Korea, The Philippines, Indonesia, ,
United Arab Emirates -
Hong Kong Orited Kingdom
Uruguay
4 South & Central America, Mexico, e £
. Watican City -
Australia, New Zealand >
Curert Region: [Not Selected
5 N Korea, Russia, Eastern Europe, Newireosn | edo

India & Most of Africa

6 China

Optical (CD/DVD) Device 2 - 5



Features & Components

4

Card Reader Cover

Make sure you keep the
rubber cover provided in

the card reader when
not in use. This will help
prevent foreign objects
and/or dust getting in to
the card reader.

Figure 2 -3
Left View

1. Card Reader

7-in-1 Card Reader

The card reader allows you to use some of the latest digital storage cards. Push the
card into the slot and it will appear as a removable device, and can be accessed in
the same way as your hard disk (s). Make sure you install the Card Reader driver
(see “CardReader” on page 4 - 6).

* MMC (MultiMedia Card) e MS Duo (requires PC adapter*)
» SD (Secure Digital) * Mini SD (requires PC adapter*)
e MS (Memory Stick) * RS MMC (requires PC adapter™*)

e MS Pro (Memory Stick Pro)

*Note: The PC adapters are usually supplied with these cards.

~Model B

2 - 6 7-in-1 Card Reader
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ExpressCard Slot

The computer is equipped with an ExpressCard/34/54 slot that reads Express Card/
34 and ExpressCard/54 formats. ExpressCards are the successors to PCMCIA (PC
Cards). Make sure you install the Card Reader driver (see “CardReader” on page 4
- 6).

ExpressCard/54 is used for applications which require a larger interface slot, e.g.
CompactFlash card reader. The number denotes the card width; 54mm for the Ex-
press Card/54 and 34mm for the ExpressCard/34.

Inserting and Removing ExpressCards
» Align the ExpressCard with the slot and push it in until it locks into place (as

pictured in the generic figure below).
» To remove an ExpressCard, simply press the card to eject it.

4

ExpressCard
Slot Cover

Make sure you keep the
rubber cover provided in

the ExpressCard slot
when not in use. This
will help prevent foreign
objects and/or dust get-
ting in to the Express-
Card Slot.

Figure 2 -4
Left View

1. Express Card
Slot

Figure 2 -5
Inserting &
Removing Express
Cards

ExpressCard Slot 2 - 7
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TouchPad and Buttons/Mouse

The TouchPad is an alternative to the mouse; however, you can also add a mouse to
your computer through one of the USB ports. The TouchPad buttons function in

Mouse Driver

If you are using an ex- much the same way as a two-button mouse.
ternal mouse your op- . . . "
erating system may be Once you have installed the TouchPad driver (see “TouchPad” on page 4 - 6) you
able to auto-configure can configure the functions by double-clicking the TouchPad driver icon g on the
_VOUf"m‘?US@ dU”I“Q Its taskbar. You may then configure the TouchPad tapping, buttons, scrolling (tap the
Installation or only en- £ 45 and bottom right of the TouchPad to scroll), pointer motion and sensitivity op-
able its basic functions. .
e tions to your preferences.
device's user docu- [ 2 Mouseproperic: . === ﬁFMm w-
mentation for details. ' [ Whesl | Hardware I Fingersensing Pad | Buttons Pointers | Pointer Options \
| Buttons | Painters | Pointer Optiens | Wihee! | Hardware | Finger sensing Pad
Button configuration Available information and configuration items:
T Swich iy ool sscorefang biktons - e
. Seletd this check box to make the b;tilnunr; o éhe p o
FIgU re 2 - 6 ggrgel:ecnﬂnnge;:duéjvsaeg'g?rr‘gpnmamun f - ¥ Show tray icon

i @@ W Action feedback icon
Mouse Properties :

Double-click speed ~Typing Detection —
Double-click the folder to test your setting.  the

I Disable pad wh i
folder does not open or close, try using a slower isable pad when typing

setting. e Adjust the slider to set the interval after which the pad is
Speed:  Slow 5] Fast resctvated.
shorter longer
ClickLock Co e
[ Tum on ClickLock Seffings.. 0.5 sec
Enables you to highlight or drag without holding down the mouse
button. To set, briefly press the mouse button. To release, click the
mouse button again

2 - 8 TouchPad and Buttons/Mouse
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Gesture Configuration

The Gesture Configuration control allows you to configure specific gesture func-
tion settings on the surface of the TouchPad for various applications.

You can configure Gestures from the Finger-sensing Pad tab in Mouse Properties:

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).

2. Click Mouse (Hardware and Sound).

3. Click Finger-sensing Pad (tab) and select Click On Pad from Available
information and configuration items.

4. Click Configure in Gesture Configuration to access the user configurable settings.

¥ Mouse Properties n] Configure Applications for Gestures @
| Buttons | Painters | Pointer Options | Hardware [(Fingersensing Pad 1n the configuration table below, you can add, modify or delete applications for
gesture function settings.
Awailable information and corfiguration items
| -
He [Cick On Pad -] Flgure 2-7
ick reTercon and Typing Detection Name: Version  File L5 M P t
Click On Pad — ouse Froperties -
sln [ |B ! MOZILLA FIREFOX
= Gesture
L [N ms ExceL B . .
[~ Gesture Configuration ;T MS IE = CO nfl g u ratl on
(. | Press the button to configure applications and gestures. e | 4
‘ O I_' MS IEs 6. iexplore.exe
‘ | ! MS IMAGEVIEW(XP)
S~—— =
B ' MS MPLAYER10 10. wmplayer, exe
i_' M3 MPLAYER.11 it wmplayer.exe | =
I Import ] | Expart | I Add ] | Modify | | Delete |
Default Restore
i (i [ 5 - Lo ] [ cond |

TouchPad and Buttons/Mouse 2 - 9
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Audio Features

You can configure the audio options on your computer from the Sound “ control
panel in Windows, or from the Realtek HD Audio Manager g icon in the taskbar/
control panel (right-click the taskbar gfj icon bring up an audio menu). The volume

The sound volume level | may also be adjusted by means of the Fn + F5/F6 key combination.
is set using the volume

4

Sound Volume
Adjustment

control within Windows - [0 Rl o A
(and the volume func- -n..]]] Sonnd Manages - : e
tion keys on the comput- [—— ] - .;:/""“"""
er). Click the volume . S = o !
icon in the t_askbar to % S S B Tl i— (g8 | {Sooepees
check the setting. - || | [ .| Foom Coestn | et ermat. ®
i l @ Windows Media Player | ) . S - ‘
: M & I
B' 3& Volume Control - r'w—rn"] E J _\ Dusrm‘
/v"- B | . I .
Lol Sound Recorder
i Right-click the icon Pibanoe sk
) to access the menu B
above. il
i .
| % REALTEK (m] (i)
Figure2-8 ! - ] |
Realtek Audio
Manager

2 - 10 Audio Features
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Adding a Printer

The most commonly used peripheral is a printer. The following conventions will
help you to add a printer; however it is always best to refer to the printer manual for
specific instructions and configuration options.

USB Printer

Most current printers have a USB interface connection. You may use any one of the
ports to connect the printer.

Install Instructions:

1.

arwbd

Set up the printer according to its instructions (unpacking, paper tray, toner/ink car-
tridge etc.).

Turn ON the computer.

Turn ON the printer.

Connect the printer’'s USB cable to one of the USB ports on the computer.
Windows will identify the printer and either load one of its own drivers or ask you
to supply one. Follow the on-screen instructions.

Parallel Printer

This is still a very common type of printer. The install instructions are in the sidebar,
however you will need to purchase a parallel to USB converter.

Adding a Printer 2 - 11

4

Parallel Printer

After setting up the print-
er attach the parallel ca-
ble to the printer.

Connect the printer's
parallel cable to the Par-
allel to USB converter,
and then plug the con-
verter into the USB port.

Turn ON the printer,
then turn ON the com-
puter.

Windows will identify the
printer and either load
one of its own drivers or
ask you to supply one.
Follow the on-screen in-
structions.
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Power Management
Chapter 3. Power Management P
Overview OB Nwike

To conserve power, especially when using the battery, your computer power man- | Power  management

P functions will vary slight-
agement conserves power by controlling individual components of the computer ly depending on your

(the monitor and hard disk drive) or the whole system. This chapter covers: operating system. For
more information it is
e The Power Sources best to refer to the user’s

« Turning on the Computer EE @ 7o EREE:

ing system.
« Power Plans a
» Power-Saving States (Note: All pictures used
» Configuring the Power Buttons on the following pages

are from the Windows

 Battery Information .
Vista OS.)

The computer uses enhanced power saving techniques to give the operating system Hibernate Mode In
(OS) direct control over the power and thermal states of devices and processors. For | Windows Vista SP1
example, this enables the OS to set devices into low-power states based on user set- _ :

. . . .. If you are using Win-
tings and information from applications. dows Vista SP1 with

4GB RAM installed, see
page 8 - 12 for informa-
tion on Hibernate.

. |
Overview 3 - 1



Power Management

The Power Sources

Z The computer can be powered by either an AC/DC adapter or a battery pack.

Silent Mode
Use the WP key to tog- | AC/DC Adapter
gle Silent Mode to re- | Use only the AC/DC adapter that comes with your computer. The wrong type of AC/

duce fan noise and save | 1 aapter will damage the computer and its components.
power consumption.

Note this may reduce | 1 Attach the AC/DC adapter to the DC-in jack at the rear of the computer.
computer perfonmance. 2. Plug the AC power cord into an outlet, and then connect the AC power cord to the
AC/DC adapter.
3. Raise the lid/LCD to a comfortable viewing angle.
4. Press the power button to turn “On”.

Battery

The battery allows you to use your computer while you are on the road or when an
electrical outlet is unavailable. Battery life varies depending on the applications and
the configuration you're using. To increase battery life, let the battery discharge
completely before recharging (see “How do | completely discharge the battery?”
on page 3 - 14).

We recommend that you do not remove the battery. For more information on the bat-
tery, please refer to “Battery Information” on page 3 - 10.

. |
3 - 2 The Power Sources
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Turning on the Computer

Now you are ready to begin using your computer. To turn it on simply press the pow- Z
er button on the front panel. Shut Down

Note that you should al-
When the computer is on, you can use the power button as a Sleep/Hibernate hot- | ways shut your comput-
key button when it is pressed for less than 4 seconds (pressing and holding the power | erdown by choosing the
button for longer than this will force the computer to shut down). Use Power Op- | Shut Down command

. . . . . from the Lock Button
tions (Hardware and Sound menu) control panel in Windows Vista to configure | vicnu in Windows Vis-

this feature. ta. This will help prevent
hard disk or system
problems.

/ Connect To Switch User
Log Off

Control Panel Leck
Forced Off

Default Programs Restart

If the system “hangs”, and the Ctrl + Alt + Del key combination doesn’t work, press the pow- Help and Support =i

Hibernate

er button for 4 seconds, or longer, to force the system to turn itself off. - Shurt Down
l-'.-ﬁ’ JETINGE

Power Button Sleep

Search

Sleep is the default power mode when the power button is pressed for less than 4 seconds.
You may configure the options for the power button from the Power Options (Hardware
and Sound menu) control panel in Windows Vista (see your OS’s documentation, or
“Configuring the Power Buttons” on page 3 - 8 for details).

| Windows Vista™

Turning on the Computer 3 - 3
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Power Plans

The computer can be configured to conserve power by means of power plans. You
can use (or modify) an existing power plan, or create a new one.

4

Resuming
Operation

The settings may be adjusted to set the display to turn off after a specified time, and

see Tables - L on § y\cond the computer into Sleep after a period of inactivity.

page 3 - 9 for informa-
tion on how to resume
from a power-saving
state.

Click Change plan settings and then click Change advanced power settings to ac-
cess further configuration options in Advanced Settings.

e
33 « PowerOptions » Edit Plan Settings v | 42 [l search 2|

Change settings for the plan: My Plan 1

[EeRr=c=)

5 Power Options

Password

Advanced settings ‘

It is recommended that

Select the power plan that you want to customize, and
then choose settings that reflect how you want your

you enable a password
on system resume in or-
der to protect your data.

® Putthe computertoslecp: (15 minutes ~| [2hour - [On battery: [ L
Plugged in: Ves
- (= Hard disk B
Flgure 3-1 ' C change advanced power settings P | = Tumoff hard disk after
On battery: 10 Minutes
Power Plan

Advanced Settings

3 - 4 Power Plans

Choose the sleep and display settings that you want your computer to use.

j On battery

£ Pluggedin

@ Tum off the display: [5 minutes ] [20 minutes

Save changes

@

@ Change seftings that are currently unavailable

computer to manage power.

[My Created PLan [Active] v

= Additional settings
= Require a password on wakeup

Plugged in: 20 Minutes
[ Wireless Adapter Settings
@ Sleen

Restore plan defaults




Each Windows power plan will also adjust the processor performance of your ma-
chine in order to save power. This is worth bearing in mind if you are experiencing
any reduced performance (especially under DC/battery power).

Choose High performance for maximum performance when the computer is pow-
ered from an AC power source. Choose the Power saver (bear in mind that this
scheme may slow down the overall performance of the computer in order to save
power) for maximum power saving when the computer is battery (DC power) pow-

ered.

I )5l » Conrotane > Pouer Optos Lo 0]

Require a password on wakeup

Choose what the power

Create a power plan

Choose when to turn off the
display

Change when the computer
sleeps

See also

Personalization

‘Windows Mobility Center

User Accounts

[E=EERES)

@
Select a power plan

Power plans can help you maximize your computer's performance or conserve
energy. Make a plan active by selecting it, or choose a plan and customize it by
changing its power settings. Tell me more about power plans

Plans shown on the battery meter

(7 Balanced Battery life: @20
Change plan settings Performance: @@e

() Power saver Battery life: @00990
Change plan settings Performance: @@

@ High performance Battery life: @@
Change plan settings Performance: #9999

Power Management

Figure 3 -2
Power Plans

Power Plans 3 - 5
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4

Power Button

The Power Button [}
in the Start Menu (in
Classic View use the
Shut Down button |0])
can be used to send the
computer into a power-
saving state.

Sleep Mode &
Mobile PC Battery

A mobile PC in Sleep
uses very little battery
power.

After an extended peri-
od of time the computer
will save any open docu-
ments and applications
to hard disk.

Power-Saving States

You can use power-saving states to stop the computer’s operation and restart where
you left off. Sleep is the default power-saving state in Windows Vista.

Earlier versions of Windows used Stand By and Hibernate as system power-saving
states. Windows Vista combines the features of Stand By and Hibernate into the de-
fault Sleep power-saving state.

Sleep

In Sleep all of your work, settings and preferences are saved to memory before the
system sleeps. When you are not using your computer for a certain length of time,
which you specify in the operating system, it will enter Sleep to save power.

The PC wakes from Sleep within seconds and will return you to where you last left
off (what was on your desktop) without reopening the application(s) and file(s) you
last used.

If your mobile PC in Sleep is running on battery power the system will use only a
minimum amount of power. After an extended period the system will save all the
information to the hard disk and shut the computer down before the battery becomes
depleted.

3 - 6 Power-Saving States



Hibernate

Hibernate uses the least amount of power of all the power-saving states and saves
all of your information on a part of the hard disk before it turns the system off. If a
power failure occurs the system can restore your work from the hard disk; if a power
failure occurs when work is saved only to memory, then the work will be lost. Hi-
bernate will also return you to where you last left off within seconds. You should
put your mobile PC into Hibernate if you will not use the computer for a period of
time, and will not have the chance to charge the battery.

Shut Down

You should shut down the computer if you plan to install new hardware (don’t for-
get to remove the battery and follow all the safety instructions in Chapter 6), plan
to be away from the computer for several days, or you do not need it to wake up and
run a scheduled task. Returning to full operation from shut down takes longer than
from Sleep or Hibernate.

Log Off
Control Panel Lock
Default Programs Restart
Help and Support Sleep
Hibernate
| (V) E = ' Shut Down

Power-Saving States 3 - 7

Power Management

4

Hibernate Mode In
Windows Vista SP1

If you are using Win-
dows Vista SP1 with
4GB RAM installed, see
page 8 - 12 for informa-
tion on Hibernate.

Figure 3-3
Lock Button Menu
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Configuring the Power Buttons

Z The power/sleep button (Fn + F4 key combo) and closed lid may be set to send the

Password computer in to a power-saving state.
Protection

It is recommended that
you enable a password
on wake up in order to Define power buttons and turn on password protection

protect your data,. Choose the power settings that you want for your computer. The changes you make to the settings on this
page apply to all of your power plans,

@@g@ » Control Panel » Power Options » System Settings

@ Change settings that are currently unavailable

However you can dis-
able this setting from the
Power Options menu
by clicking Require a © whentpressthe power buttor: [sieep = -]

Power and sleep buttons and lid settings

] On battery J Plugged in

password on wakeup X
in the left menu, and se- @ whentprestneseppuon (TS

Shut down

lecting the options (click % When [ clase the lid [Steep -] [slesp -
Change settings that
are currently unavail-
able).

Password protection on wakeup

@ Require a password (recommended)
‘When your computer wakes from sleep, no one can access your data without entering the correct
password to unlock the computer. Create or change your user account password

Don't require a password
‘When your computer wakes from sleep, anyone can access your data because the computer isn't

Figure 3-4 locked.

Power Options
Define Power Save changes
Buttons

.|
3 - 8 Configuring the Power Buttons
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Resuming Operation

You can resume operation from power-saving states by pressing the power button, 4
or in some cases pressing the sleep button (Fn + F4 key combo). Closing the Lid
If you have chosen to
Power Status Icon :D‘/L'J Color To Resume send the computer to
Sleep when the lid is
Power Off Off Press the Power Button closed, raising the lid

will wake the system up.

Press the Power Button

Sleep Blinking Green
Press the Sleep Button (Fn + F4 Key Combo)
Off (battery) _
Hibernate Press the Power Button Table 3_ 1
Orange (AC/DC adapter) Resuming
Display Turned Off Green Press a Key or Move the Mouse/Touchpad Operation

4

Power Button

When the computer is on, you can use the power button as a Sleep/Hibernate/Shut Down

hot key button when it is pressed for less than 4 seconds (pressing and holding the power
button for longer than this will force the computer to shut down).

Configuring the Power Buttons 3 - 9
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Battery Information

\ A/
’Ll\ Please follow these simple guidelines to get the best use out of your battery.
Low Battery

EITAE, Battery Power

WHERRGESEAEVASEEEE Y our computer’s battery power is dependent upon many factors, including the pro-
B EEEEV A grams you are running, and peripheral devices attached. You can set actions to be
B R taken (e.g. Shut down, Hlbe'rnate etc.), _and set critical and low battery levels from
S e e e power plan Advanced Settings (see Figure 3 - 1 on page 3 - 4).

erwise, the unsaved

CEERULREEREE SRR Click the battery icon [#[ in the taskbar to see the current battery level and charge
the power is depleted.

connect the AC/DC

) 5 Power Options ER==g
@ 54% available {plugged in, charging) Advanced settings
= Select the power plan that you want to customize, and
\13 then chaose settings that reflect how you want your
Solact B computer to manage power.
Elect @ power pian: @ Change settings that are currentl,
My Plan1 [MyPlan1 v
F' r 3 _ 5 @ Power saver aliattery
|gu e - Critical battery action
& Hi @ Low battery level
Battery Ilcon @:High'pertormance &) Critical battery level
= Low battery notification
(Taskbar) & Battery Onbatten: On L
H Learn how to conserve power Pluagedin: On =
Advanced Settings en & Lo bty acton =
More power options 7 be nothing o]
Windows Mohbility Center w?’o nothing =
eej
T «store plan defauts
—_— : Shut down D B
SRl
< v = el 0 gus AM (om0

3 - 10 Battery Information
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Conserving Battery Power

» Use a power plan that conserves power (e.g Power saver), however note that 4
this may have an affect on computer performance. Windows Mobility

Center

» Lower the brightness level of the LCD display. The system will decrease LCD
brightness slightly to save power when it is not powered by the AC/DC adapter. The Windows Mobility

Center control panel
* Reduce the amount of time before the display is turned off. provides an easy point
of access for information
» Close wireless, Bluetooth, modem or communication applications when they are on battery status, power

not being used. plans used and wireless
device status etc.

» Disconnect/remove any unnecessary external devices e.g. USB devices,
ExpressCards etc.

Bl Windows Mobility Center L
Display N " Fully charged Display
ﬁ brightness C? [ Mute ﬂ (100%5) ] conne-:ted Flgure 3 - 6
| G | Belancea 3 Windows Mobility

Center

Q

Brightness Volume Battery Status External Display

Mo sync 2 :
@ part’:ership: @&p Not presenting

[ Sync settings ] [ Turn on

Sync Center Presentation Settings

Battery Information 3 - 11
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Battery Life

Battery life may be shortened through improper maintenance. To optimize the life

and improve its performance, fully discharge and recharge the battery at least
once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to re-
move the battery for any reason (e.g. long term storage) see “Removing the Battery”
on page 6 - 3.

New Battery

Always completely discharge, then fully charge, a new battery (see “Battery FAQ”
on page 3 - 14 for instructions on how to do this).

Recharging the Battery with the AC/DC Adapter

The battery pack automatically recharges when the AC/DC adapter is attached and
plugged into an electrical outlet. If the computer is powered on, and in use, it will
take several hours to fully recharge the battery. When the computer is turned off but
plugged into an electrical outlet, battery charge time is less. (Refer to “LED Indica-
tors” on page 1 - 9 for information on the battery charge status, and to “Battery In-
formation” on page 3 - 10 for more information on how to maintain and properly
recharge the battery pack.)

.|
3 - 12 Battery Information
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Proper handling of the Battery Pack

» DO NOT disassemble the battery pack under any circumstances 7\[\1’:
» DO NOT expose the battery to fire or high temperatures, it may explode Callion

* DO NOT connect the metal terminals (+, -) to each other
Danger of explosion if
battery is incorrectly re-

o placed.
2 &

Damaged Battery Warning

Replace only with the
same or equivalent type
recommended by the
manufacturer. Discard
used battery according
to the manufacturer’s in-
structions.

Should you notice any physical defects (e.g. the battery is bent out of shape after being
dropped), or any unusual smells emanating from the notebook battery, shut your computer

down immediately and contact your service center. If the battery has been dropped we do
not recommend using it any further, as even if the computer continues to work with a dam-
aged battery in place, it may cause circuit damage, which may possibly result in fire. It is
recommended that you replace your computer battery every two years.

.|
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Battery FAQ

How do | completely discharge the battery?

Use the computer with battery power until it shuts down due to a low battery. Don’t
3 turn off the computer even if a message indicates the battery is critically low, just let

the computer use up all of the battery power and shut down on its own.

1. Save and close all files and applications.

2. Create a power plan for discharging the battery and set all the options to Never.

3. Click Change plan settings (after saving it) and click Change advanced power
settings.

Figure 3-7
Power Plan Create

3 - 14 Battery Information



4. Scroll down to Battery and click + to expand the battery options.
5. Choose the options below (click Yes if a warning appears):

@ Power Options

=)

@ Power Options

Advanced settings |

v Select the power plan that you want to customize, and
@ then choose settings that reflect how you want your
computer to manage power.

¥ Change settings that are currently unavailable

[Di;charge Battery [Active] -

[ Battery -
= Critical battery action
On battery: Shut down
Plugged in: Do nothing
= Low battery level
On battery: 0 %
Plugged in: 0 %
= Critical battery level
On battery: 0 %

Dluoaed in (%0 1] =

m.|

Restore plan defaults

Advanced settings |

v Select the power plan that you want to customize, and
@ then choose settings that reflect how you want your
computer to manage power.

Y Change settings that are currently unavailable

l Discharge Battery [Active] -

On battery: 0 % -
Plugged in: 0 %
= Critical battery level
On battery: 0 %
Plugged in: 0 %
# Low battery notification
=l Low battery action

Plugged in: Do nothing

A e |

Restore plan defaults

Apply

o o |

|

[ ok ]| Canecel

(.2 [ |

J [ domy ]|,

* Low battery levels = 0%
 Critical battery Levels = 0%
* Low battery action = Do Nothing

 Critical battery action (On battery) = Shut Down
 Critical battery action (Plugged in) = Do Nothing

Power Management

Figure 3-8
Power Options
Advanced Settings -
Battery

Battery Information 3 - 15
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How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes

from orange to green.
How do | maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after
about 20 partial discharges.

.|
3 - 16 Battery Information



Drivers & Utilities

Chapter 4: Drivers & Utilities

This chapter deals with installing the drivers and utili-
ties essential to the operation or improvement of some
of the computer’s subsystems. The system takes ad-
vantage of some newer hardware components for
which the latest versions of most available operating
systems haven’t built in drivers and utilities. Thus,
some of the system components won’t be auto-config-
ured with an appropriate driver or utility during oper-
ating system installation. Instead, you need to
manually install some system-required drivers and
utilities.

RAID & AHCI Setup

Note that setting up a RAID, or AHCI mode, needs to
be done prior to installing the Windows OS, and there-
fore before installing the other drivers listed here (see
“Setting Up SATA RAID or AHCI Modes” on page 7
- 60).

What to Install

The Device Drivers & Utilities + User’s Manual disc
contains the drivers and utilities necessary for the
proper operation of the computer.

Table 4 - 1, on page 4 - 3 lists what you need to install
and it is very important that the drivers are in-
stalled in the order indicated (see “Driver Installa-
tion” on page D - 25 for Windows 7 information).

Module Driver Installation

The procedures for installing drivers for the PC Cam-
era, Wireless LAN, Fingerprint, 3.75G/HSPA, TV
Tuner (Consumer Infrared) and RAID modules are
provided in “Modules & Options” on page 7 - 1.

What to Install 4 - 1




Drivers & Utilities

Driver In Stal | at| on 1. Check the driver installation order from Table 4 - 1,
on page 4 - 3 (the drivers must be installed in
Insert the Device Drivers & Utilities + User’s Manual this order) which is the same as that listed in the

disc and click Install Drivers/Option Drivers (button). Drivers Installer menu below.

2. Click to select the driver you wish to install, after
If you wish to install the drivers manually see overleaf installing each driver it will become grayed out. If
for the driver path information. you need to reinstall any driver, click the Unlock
button (you should uninstall the driver first).
Follow the instructions for each individual driver
installation procedure as listed on the following

Figure 4 - 1 - Drivers Installer Screen 1

Figure 4 - 2 - Drivers Installer Screen 2

. |
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Driver - Windows Vista with Service Pack 2 Page Driver - Windows Vista with Service Pack 2 Page

Chipset Page 4 -6 PC Camera Module Page 7 -8

Video Page 4 -6 Wireless LAN Module Page 7 - 17

Modem Page 4 -6 Fingerprint Reader Module Page 7-34
LAN Page 4 - 6 3.75G/HSPA Module (Model A Only) Page 7 - 52

Firewire (IEEE 1394) Page 4 - 6 TV Tuner Module (Model B Only) Page 7 - 58

CardReader Page 4 - 6 i)?tltvilr(])geLIJg SO,:IFS RAID or AHCI Modes (RAID Page 7 - 60

TouchPad Page 4 - 6

Hot Key Page 4 -7

Audio Page 4 -7

Table 4 - 1 - Driver Installation
Manual Driver Installation
Click Browse CD (button) in the Drivers Installer application and browse to the executable file in the appropriate
driver folder.

. |
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Windows Update

After installing all the drivers make sure you enable
Windows Update in order to get all the latest security
updates etc. (all updates will include the latest hotfixes
from Microsoft). See “Windows Update™ on page 4 -
7 for instructions.

4

Windows Vista Service Pack 2

Make sure you install Windows Vista Service Pack 2
(or a Windows Vista version which includes Service
Pack 2) before installing any drivers. Go to the Micro-
soft website for download details, or contact your service
center.

Updating/Reinstalling Individual Drivers

If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.To do
this go to the Control Panel in the Windows OS and
double-click the Programs and Features icon (Pro-
grams > Uninstall a program). Click to select the
driver (if it is not listed see below) and click Uninstall,
and then follow the on screen prompts (it may be nec-
essary to restart the computer). Reinstall the driver as
outlined in this chapter.

If the driver is not listed in the Programs and Fea-
tures menu:

1. Click Start, and click Control Panel (or point to
Settings and click Control Panel).

2. Double-click Device Manager (Hardware and
Sound > Device Manager).

3. Double-click the device you wish to update/reinstall
the driver for (you may need to click “+” to expand
the selection).

4. Click Driver (tab) and click the Update Driver or
Uninstall button and follow the on screen prompts.

4 - 4 Driver Installation



User Account Control (Win Vista)

If a User Account Control prompt appears as part of
the driver installation procedure, click Continue or
Allow, and follow the installation procedure as direct-
ed.

Windows Security Message

If you receive a Windows security message as part of
the driver installation process. Just click “Install this
driver software anyway” or “Install” to continue the
installation procedure.

You will receive this message in cases where the driv-
er has been released after the version of Windows you
are currently using. All the drivers provided will have
already received certification for Windows.

Drivers & Utilities

New Hardware Found

If you see the message “New Hardware Found” dur-
ing the installation procedure (other than when out-
lined in the driver install procedure), click Cancel
to close the window, and follow the installation proce-
dure.

4

Driver Installation General Guidelines

The driver installation procedure outlined in this
Chapter (and in Chapter 7 Options & Modules),
are accurate at the time of going to press.

Drivers are always subject to upgrade and revision
so the exact procedure for certain drivers may differ
slightly. As a general guide follow the default on
screen instructions for each driver (e.g. Next > Next
> Finish) unless you are an advanced user. In many
cases a restart is required to install the driver.

Driver Installation 4 - 5
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Driver Installation Procedure

Insert the Device Drivers & Utilities + User’s Manual
disc and click Install Drivers (button).

Chipset

1. Click 1.Install Chipset Driver > Yes.
2. Click Next > Yes > Next > Next.

3. Click Finish to restart the computer.

Video

1. Click 2.Install Video Driver > Yes.
2. Click Next > Next.
3. Click Finish to restart the computer.

Modem

1. Click 3.Install Modem Driver > Yes.

2. Click OK.

3. The modem is ready for dial-up configuration.

LAN

1. Click 4.Install LAN Driver > Yes.

2. Click Next > Install.

3. Click Finish.

4. The network settings can now be configured.

Firewire (IEEE 1394)
1. Click 5.FireWire drivers > Yes.

2. Click Install.

3. Click Finish.

CardReader

1. Click 6.Install Cardreader Driver > Yes.
2. Click Install.

3. Click Finish.

TouchPad

1. Click 7.Install Touchpad Driver > Yes.

2. Choose the language you prefer and click OK.
3. Click Next > Finish.
4. Click Restart Now to restart the computer.
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Hot Key

1. Click 8.Install Hotkey Utility > Yes. Y
2. Click Next > Install.
3. Click Finish > Finish to restart the computer.

Windows Update

After installing all the drivers make sure you enable Win-
dows Update in order to get all the latest security up-

Audio dates etc. (all updates will include the latest hotfixes
1. Click 9.Install Audio Driver > Yes. rerm) L BeEEi)
2. Click Next. To enable Windows Update make sure you are con-
3. Click Finish to restart the computer. nected to the internet:
Note that after installing the audio driver the system 1. Click Start, and click Control Panel (or point
will not return to the Drivers Installer screen. To in- to Settings and click Control Panel).
stall any of the optional drivers listed overleaf, eject 2. Click Chieck for updates (Security), or
the Device Drivers & Utilities + User’s Manual disc double-click Security Center and click
. . . .. . Windows Update.

and then reinsert |t_(or doul?le—cllck the disc icon in My 3. Double-click Check for updates (button).
Computer), and click Option Drivers (button) to ac- 4. The computer will now check for updates
cess the optional driver menu. (you need to be connected to the internet).

5. Click Install now (button) to install the

updates.

|
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Optional Drivers

See the pages indicated for the driver installation pro-
cedures for any modules included in your purchase op-
tion.

“ 4 Drivers Installer

S W hobits 5 putin S

e follow steps from top to bottom in order to install Option drivers.

Figure 4 - 3 - Drivers Installer - Option Drivers Menu

Bluetooth Module

Note: The operating system is the default setting for
Bluetooth control in Windows Vista, and does not re-
quire a driver. See “Bluetooth Module” on page 7 - 2
for configuration instructions.

PC Camera Module

See the introduction in “PC Camera Module” on
page 7 - 7, and check the installation procedure.

Wireless LAN Module

See the introduction in “Wireless LAN Module” on
page 7 - 16, and check the installation procedure.

Fingerprint Reader Module

See the introduction in “Fingerprint Reader Module”
on page 7 - 34, and check the installation procedure.

3.75G/HSPA Module (Model A Only)

See the introduction in “3.75G/HSPA Module” on
page 7 - 39, and check the installation procedure.
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TV Tuner Module (Model B Only)

See the introduction in “TV Tuner Module” on page 7
- 57, and check the installation procedure for the Con-
sumer Infrared (CIR) driver.

RAID and AHCI Configuration

(RAID for Model B Only)
See the configuration instructions in “Setting Up
SATA RAID or AHCI Modes” on page 7 - 60.

Driver Installation 4 - 9



Drivers & Utilities

4 - 10



BIOS Utilities

Chapter 5: BIOS Utilities -

Overview BIOS Screens

Note that the BIOS
screens pictured on the
following pages are in-

This chapter gives a brief introduction to the computer’s built-in software:

DlagnOStICS The POST (POWGI'-On SEIf TeSt) tended for guidance in
setting up your system’s
Configuration: The Setup utility BIOS.

If your computer has never been set up, or you are making important changes to the

: . . : BIOS versi b-
system (e.g. hard disk setup), then you should review this chapter first and note the ~JE¥ tovfgi';’{;smafh;:’ge

original settings found in Setup. Even if you are a beginner, keep a record of the set- B ERER EVE TR GE =
tings you find and any changes you make. This information could be useful if your FNEESEhEES ekl

screens may appear
slightly different from
those pictured on the
There is one general rule: Don’t make any changes unless you are sure of what you  BEGIEIe =l

are doing. Many of the settings are required by the system, and changing them could
cause it to become unstable or worse. If you have any doubts, consult your service
representative.

system ever needs servicing.

. |
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BIOS Settings
Warning

Incorrect settings can
cause your system to
malfunction. To correct
mistakes, return to Set-
up and restore the Set-
up Defaults with <F9>.

The Power-On Self Test (POST)

Each time you turn on the computer, the system takes a few seconds to conduct a
POST, including a quick test of the on-board RAM (memory).

As the POST proceeds, the computer will tell you if there is anything wrong. If there
is a problem that prevents the system from booting, it will display a system summary
and prompt you to run Setup.

If there are no problems, the Setup prompt will disappear and the system will load
the operating system. Once that starts, you can’t get into Setup without rebooting.

5 - 2 The Power-On Self Test (POST)
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Failing the POST
Errors can be detected during the POST. There are two categories, “fatal” and “non-
fatal”.

Fatal Errors

These stop the boot process and usually indicate there is something seriously wrong
with your system. Take the computer to your service representative or authorized
service center as soon as possible.

Non-Fatal Errors

This kind of error still allows you to boot. You will get a message identifying the
problem (make a note of this message!) followed by the prompt:

e Press <F1> to resume
e <F2>to enter Setup

Press F1 to see if the boot process can continue. It may work, without the correct
configuration.

Press F2 to run the Setup program and try to correct the problem. If you still get an
error message after you change the setting, or if the “cure” seems even worse, call
for help.

.|
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The Setup Program

The Phoenix Setup program tells the system how to configure itself and manage ba-
sic features and subsystems (e.g. port configuration).

Entering Setup

To enter Setup, turn on the computer and press F2 during the POST. The prompt
(Press F2 to Enter Setup) seen on page 5 - 2 is usually present for a few seconds
after you turn on the system. If you get a “Keyboard Error”, (usually because you
pressed F2 too quickly) just press F2 again.

If the computer is already on, reboot using the Ctrl + Alt + Delete combination and
then hold down F2 when prompted. The Setup main menu will appear.

5 - 4 The Setup Program
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Setup Screens

The following pages contain additional advice on portions of the Setup. 2
) ] ] Setup Menus
Along the top of the screen is a menu bar with menu headings. When you select a
heading, a new screen appears. Scroll through the features listed on each screento | Thé  Setup  menus
ke ch to Set shown in this section are
make changes 10 Setup. for reference only. Your
computer's menus will
Instructions on how to navigate each screen are in the box along the bottom of the | indicate the configura- S
screen. If these tools are confusing, press F1 to call up a General Help screen, and “O“daf’pr%p“att_e for your
then use the arrow keys to scroll up or down the page. mocet and opfions.

The Item Specific Help on the right side of each screen explains the highlighted
item and has useful messages about its options.

If you see an arrow » next to an item, press Enter to go to a sub-menu on that sub-
ject. The sub-menu screen that appears has a similar layout, but the Enter key may
execute a command.
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Main Menu

Phoenix SecureCore{tm) Setup Utility

F|gure 5 - 1 - Main Advanced Security
Main Menu :
[} 54: 17] Item Specific Help
System Date: [09/715/72009]
B SATA Port 1 [FULJITSU MHY 212 0BH-(] <Tah>, <Shift-Tah>, or
b SATA Port 2 [Hone] <Enter> selects field.
» SATA Port 3 [Hone]
System Memory: 628 EB
Extended Memory: 2039 MB
BIOS Revision: kA
EBC/EC Firmware Revision: LLLLLL L
VGR Card: dedd bk
VEBIOS Revision: kAo
VBIOS Build Date: LR L L L
Help Select Item Change Values Setup Defaults
Exit Select Menu Select pSub-Menu Save and Exit

System Time & Date (Main Menu)

The hour setting uses the 24-hour system (i.e., @@ = midnight; 13 = 1 pm). If you
can change the date and time settings in your operating system, you will also change
these settings. Some applications may also alter data files to reflect these changes.

. |
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SATA Port 1/2/3/4/5 (Main Menu)

Pressing Enter opens the sub-menu to show the configuration of an HDD/optical de-
vice on the computer’s SATA Port 1/2/3/4/5. Use the Auto (Type:) setting to have
the items configured automatically for you.

System/Extended Memory (Main Menu)
This item contains information on the system memory, and is not user configurable.
The system will auto detect the amount of memory installed.

BIOS Revision/KBC/EC Firmware Revision (Main Menu)
This item contains information on the current BIOS and firmware versions.

VGA Card/VBIOS Revision/VBIOS Build Date (Main Menu)
This item contains information on the current videos card installed, and on the Video
BIOS version.

Main Menu 5 - 7
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Advanced Menu

Phoenix SecureCore{tm} Setup Utility

Advanced Security Boot Exit

Item Specific Help
SATA Mode Selection [RHCT]
Legacy USB Support: [Enabled]
Boot-time Diagnostic Screen: [Disabled]
Legacy 0S5 Boot: [Enabled]
Power On POST Beep: [D05]
Battery Low Alarm Beep: [Di=abled]
Help Select Item Change Values Setup Defaults
Exit Select Menu Select pSub-Menu Save and Exit

Advanced Chipset Control
The sub-menu here allows you to enable/disable Extreme Edition control, if appli-
cable to your system.
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SATA Mode Selection (Advanced Menu)
You may enable/disable SATA RAID or AHCI mode for your hard disks, however ;‘ﬁl’;
you should only enable/disable RAID or AHCI BEFORE installing an operat-
ing system, and after you have backed up all necessary files and data (see sidebar).

SATA Mode
Selection

Legacy USB Support (Advanced Menu) If you have installed the
Choose “Enabled” if you intend to use USB devices in systems which do not nor- BRUGECIERIEEREE S
mally support USB functionality (e.g. DOS). The default setting is “Enabled” and JHRERSEEURIEEINED

; ; : : . AHCI or RAID mode en-
does not need to be changed if you intend to use your USB devices in Windows. abled. DO NOT disable

Boot-time Diagnostic Screen (Advanced Menu) :ge d?:;g?g‘:ﬁe("‘sﬁ?“m"g;z

Use this menu item to enable/disable the Boot-time Diagnostic Screen or Power-On - BRI R o S
Self Test. the Windows Vlsta OS).

Legacy OS Boot (Advanced Menu)

Enable this item to support only system boot from the Legacy OS (e.g Windows Vis-
ta). If disabled the system will attempt to boot from the EFI (Extensible Firmware
Interface) before the Legacy OS.

Figure5-2
Advanced Menu
Power On Boot Beep (Advanced Menu)

Use this menu item to enable/disable the beep as the computer starts up.

Battery Low Alarm Beep (Advanced Menu)
Use this menu item to enable/disable the battery low alarm beep.

Advanced Menu 5 - 9
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Security Menu

Phoenix SecureCore{tm) Setup Utility
Security Menu
The changes you ; Iten Specific Help
make here affect the Siberiisor Fosswrd Is: it
access to the Setup Supervrisor Password
utility itself and also [Enter | controls access to the
’ Set User Password [Enter] setup utility.
access to your ma-
. . Password on boot: [Disabled]
chine as it boots up af-
ter you turn it on.
These settings do not
affect your machine or
network passwords
which will be set in
your software OS.
Help Select Item Change Values Setup Defaunlts
Exit Select Menu Select Sub—Menu Save and Exit
Figure 5-3 Set Supervisor Password (Security Menu)

Security Menu You can set a password for access to the PhoenixBIOS Setup Utility. This will not

affect access to the computer OS, (only the PhoenixBIOS Setup Utility).

Set User Password (Security Menu)
You can set a password for user mode access to the PhoenixBIOS Setup Utility.
This will not affect access to the computer OS, (only the Setup utility) unless you
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choose to set a Password on Boot (see below). Many menu items in the Phoenix-
BIOS Setup Utility cannot be modified in user mode. You can only set the user ;Zl’;
password after you have set the supervisor password.

Password Warning

Password on boot (Security Menu) If you set a boot pass-
Specify whether or not a password should be entered to boot the computer (you may ;’;’Oﬂij(nF;ath‘é‘{f)’rd |(\)1I|15 SE%I
gnly set a password on boot if a supervisor password is enabled). If “Enabled” forget your pa,ssword.

is selected, only users who enter a correct password can boot the system (see the

warning in the sidebar). The default setting is “Disabled”. UL CRMESilEEs of

this could be serious. If
you cannot remember
Note: To clear existing passwords press Enter and type the existing password, then B EES e el
press Enter for the new password (without typing any password entry) and Enter BRulESeeiEEaelmE) s

again to confirm the password clearance. dor and you may |ose all
of the information on

your hard disk.
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Boot Menu

Phoenix SecureCore{tm) Setup Utility

Figure 5 - 4 -

Boot Menu
Item Specific Help
Boot priority order:
2: IDE HDD: FUJITSU MHY2120BH-{S1}) Keys used to view or
3: PCI SCSI: configure devices:
4: USE EKEY: Up and Dovm arrows
5: USE HDD: select a device.
6: PCI BEV: <+> and <-> mores
T: the device up or dowm.
&: <x+ exclude or include
Excluded from boot order: the device to hoot.
: USB FDC: <Shift + 1> enables or
: USB CDROM: disables a device.
Help Select Item Change WValues Setup Defaults
Exit Select Menu Select PSub-Menu Save and Exit

When you turn the computer on it will look for an operating system (e.g. Windows
Vista) from the devices listed in this menu, and in this priority order. If it cannot
find the operating system on that device, it will try to load it from the next device in
the order specified in the Boot priority order. Item specific help on the right is
available to help you move devices up and down the order.
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Phoenix SecureCore{tm) Setup Utility Flgure 5 - 5
Advanced Security Exit Menu
Item Specific Help

Exit Discarding Changes
Load Setup Defaults Exit System Setup and
Discard Changes save your changes to
Save Changes CHOS .

Help Select Item Change Values Setup Defaults

Exit Select Menu Select BSub-Henu Sare and Exit

Choosing to Discard Changes, or Exit Discarding Changes, will wipe out any
changes you have made to the Setup. You can also choose to restore the original Set-
up defaults that will return the Setup to its original state, and erase any previous
changes you have made in a previous session.

. |
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Upgrading The Computer

Chapter 6: Upgrading The Computer

Overview

| ins informai | L
This chapter contains information on upgrading the computer. Follow the steps out- —
lined to make the desired upgrades. If you have any trouble or problems you can con- Warranty Warning

tact your service representative for further help. Before you begin you will need: Please check with your

« A small crosshead or Phillips screwdriver service  representative

. before undertaking an
» Asmall regular slotted (flathead) screwdriver upgrade procedurges tz)/

* An antistatic wrist strap find out if this will VOID
your warranty.

Before working with the internal components you will need to wear an antistatic
wrist strap to ground yourself because static electricity may damage the compo-
nents.

The chapter includes:

* Removing the Battery

» Upgrading the Hard Disk Drive(s)

» Upgrading the Optical (CD/DVD) Device
» Upgrading the System Memory (RAM)

Please make sure that you review each procedure before you perform it.

. |
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Power Safety
Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and disconnect-
ed all peripherals and
cables (including tele-
phone lines). It is advis-
able to also remove your
battery in order to pre-
vent accidentally turning
the machine on.

6 - 2 Overview

When Not to Upgrade
These procedures involve opening the system’s case, adding and sometimes replac-
ing parts.

You should not perform any of these upgrades if:

* Your system is still under warranty or a service contract
* You don’t have all the necessary equipment

* You’re not in the correct environment

* You doubt your abilities

Under any of these conditions, contact your service representative to purchase or re-
place the component(s).

2N\
I

Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember
to replace the cover(s) and screw(s) before turning the computer on.

Upgrading the Processor

If you want to upgrade your computer by replacing the existing processor with a fast-
er/new one you will need to contact your customer service representative. We rec-
ommend that you do not do this yourself, since if it is done incorrectly you may
damage the processor or mainboard.
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Removing the Battery ™

If you are confident in undertaking upgrade procedures yourself, for safety reasons ’Ll\ _

it is best to remove the battery. Warranty Warning
1. Turn the computer off, and turn it over. Please check with your
2. Slide the latch @ in the direction of the arrow. service representative
3. Slide the latch @ in the direction of the arrow, and hold it in place. before undertaking any
4.  Lift the battery out in the direction of the arrow @. upgrade procedures to

find out if this will VOID
your warranty.

Figure 6 -1
Battery Removal
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o Upgrading the Hard Disk Drive(s)

\ A/
’ﬁl\ The hard disk drive can be taken out to accommodate other 2.5" serial (SATA) hard
HDD System disk drives with a height of 9.5mm (h) (see “Storage” on page C - 3). Follow your
SUELUIRE operating system’s installation instructions, and install all necessary drivers and util-

N Rl el ties (See “Driver Installation” on page 4 - 2), when setting up a new hard disk.

fore you begin make sure: . . . .
VIR CECRTEL Al Removing the Hard Disk(s) in the Primary HDD Bay

data Vf’duk‘:"ggt WRESCIEE 1. Turn off the computer, and turn it over and remove the battery.
ye i ' 2. Remove screws @ - @ from the hard disk cover.

You have all the CD-ROMs ) . . . )
and FDDs required to in- 3. Slide the hard disk assembly in the direction of arrow @.

stall your operating system
and programs.

If you have access to the in-
ternet, download the latest
application and hardware
driver updates for the oper-
ating system you plan to in-
stall. Copy these to a
removable medium.

Figure 6 - 2
Hard Disk Bay
Cover Removal

.|
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Upgrading The Computer

Lift the hard disk assembly out of the computer in the direction of arrow @.

Remove the screws @ - @ and the cover bracket @.
Reverse the process to install a new hard disk drive (do not forget to replace all the

screws and covers).

Figure 6 - 3
HDD Assembly
Removal

|

Hard Disk Screws & Cover

The hard disks and covers pictured here may appear slightly different from your model design (these
designs are subject to change and upgrade without notice). Pay careful attention to the screws and

cover bracket orientation.

Upgrading the Hard Disk Drive(s) 6 - 5
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SN
L&

RAID Hard Disks

All hard disks in a RAID
should be identical (the

same size and brand) in
order to prevent unex-
pected system behavior.

Figure 6 - 4
Component Bay
Cover Screws

Removing the Hard Disk in the Secondary HDD Bay (Model B Computers Only)
If you want to configure your hard disks in a RAID configuration then install iden-
tical drives in the primary (see page 6 - 4) and secondary hard disk bays as per the
instructions here. Follow the instructions in “Setting Up SATA RAID or AHCI
Modes” on page 7 - 60 for configuration details. Note a RAID configuration is only
supported by Model B computers.

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the component bay cover and remove screws @ - €.
3. Carefully remove the cover @.

3@
Model B

6 - 6 Upgrading the Hard Disk Drive(s)
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Upgrading The Computer

Slide the hard disk assembly in the direction of the arrow @®.
Lift the hard disk @@ out of the compartment. _\L'X_
Remove screws (B - @ to separate the hard disk from the brackets.

Reverse the process to install a new hard disk drive (do not forget to replace all the
screws and covers).

/ \Y

RAID Hard Disks

All hard disks in a RAID
should be identical (the

same size and brand) in
order to prevent unex-
pected system behavior.

Figure 6 -5
Secondary HDD

Hard Disk Screws & Cover Removal

The hard disks and covers pic-
tured here may appear slightly
different from your model design
(these designs are subject to
change and upgrade without no-
tice). Pay careful attention to the
screws and cover bracket orien-
tation.

Upgrading the Hard Disk Drive(s) 6 - 7
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Upgrading the Optical (CD/DVD) Device

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the component bay cover and remove screws @ - @€ (Model A) or @ -

@ (Model B).

3. Carefully remove the cover @B.

@ 4 g 5

Figure 6 - 6
Component Bay

b Cover Screws

6 - 8 Upgrading the Optical (CD/DVD) Device
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Remove the screw at point @, and use a screwdriver to carefully push out the
optical device at point €.
Reverse the process to install the new device.

Figure 6 - 7
Removing the
Optical Device

Upgrading the Optical (CD/DVD) Device 6 - 9
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Figure 6 - 8
Component Bay
Cover Screws

Upgrading the System Memory (RAM)

The computer has two memory sockets for 204 pin Small Outline Dual In-line (SO-
DIMM) DDRIII (DDR3) type memory modules (see “Memory” on page C - 2 for
details of supported module types).

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the component bay cover and remove screws @ - € (Model A) or @ -

@ (Model B).

2 £ - 1) 4
3

| _ Model A . 7

@ 4 g 5
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3. Carefully remove the cover @®.
4. The RAM is located at point @®. 1

/ \Y

Contact Warning

Be careful not to touch
the metal pins on the
RAM module’s connect-
ing edge. Even the
cleanest hands have
oils which can attract
particles, and degrade
the module’s perfor-
mance.

Model B

’12
L&

Figure 6 -9
Component Bay
Cover Removed

Upgrading the System Memory (RAM) 6 - 11
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5. Gently pull the two release latches on the sides of the memory socket in the

direction indicated by the arrows (@ & @) in Figure 6 - 10.

The RAM module will @ pop-up, and you can remove fit.

Pull the latches to release the second module if necessary.

8. Insert a new module holding it at about a 30° angle and fit the connectors firmly
into the memory slot.

No

Figure 6 - 10
RAM Module
Removal

4

Single Memory
Module Installation

If your computer has a
single memory module,

then insert the module
into the Channel 0
(JDIMM1) socket. In this

CEER Wi [ Ui [er 9. The module’s pin alignment will allow it to only fit one way. Make sure the module
memory socket (the

socket closest to the is seated as far into the slot as it will go. DO NOT FORCE the module; it should fit

mainboard). without much pressure.

10. Press the module in and down towards the mainboard until the slot levers click into
place to secure the module.

6 - 12 Upgrading the System Memory (RAM)
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Chapter 7. Modules & Options -

i Wireless Device
OverVIeW Operation Aboard
This chapter contains information on the following modules, which may come with Aircraft

your computer, depending on the configuration purchased. If you are unsure please B /FEESE T -

contact your service representative. electronic transmission de-
vices aboard aircraft is usu-
o Bluetooth Module ally prohibited. Make sure

the module(s) are OFF if

° PC; Camera Module you are using the computer
*  Wireless LAN Module aboard aircraft.

» Fingerprint Reader Module _

» 3.75G/HSPA Module Important Notice

e TV Tuner Module If your purchase option in-
» Setting Up SATA RAID or AHCI Modes cludes both Wireless LAN

and 3.75G/HSPA modules,

then the appropriate anten-

ﬁ nas will be installed. Note
that In order to comply with

Important Notice - 3.75G/HSPA & Bluetooth/Wireless LAN Modules FCC RF exposure compli-
ance requirements, the an-

In order to comply with FCC regulations you should NOT operate the 3.75G/HSPA module tenna must not be co-

and the Bluetooth/Wireless LAN modules at the same time as this may disrupt radio fre- located or operate in con-
quency, and cause interference. When the 3.75G/HSPA module is powered on, make sure junction with any other an-

that the Bluetooth/Wireless LAN modules are powered off. tenna orransmitter.
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Bluetooth Module

\ A/
. ’Ll‘ _ The operating system’s Bluetooth Devices control panel is used to configure the
Wireless Device Bluetooth settings in Windows Vista, and therefore does not require a driver. Use
Operf.'on A]:tboard the Fn + F12 key combination (see “Function/Hot Key Indicators” on page 1 -
LS 12) to toggle power to the Bluetooth module. When the Bluetooth module is pow-

The use of any portable ered on, the ¢ LED will be illuminated and the on-screen indicator will briefly be
electronic transmission de- displayed

vices aboard aircraft is usu- ’
ally prohibited. Make sure
the module(s) are OFF if

4

Bluetooth Data Transfer

you are using the computer
aboard aircraft.

Use the Fn + F12 key com-
bination to toggle power to
the Bluetooth module, and
check the LED indicator to
see if the module is pow-
ered on or not (see

/

).

Note that the transfer of data between the computer and a Bluetooth enabled device is sup-
ported in one direction only (simultaneous data transfer is not supported). Therefore
if you are copying a file from your computer to a Bluetooth enabled device, you will not be
able to copy a file from the Bluetooth enabled device to your computer until the file transfer
process from the computer has been completed.

Bluetooth Module & Resuming From Sleep Mode

The Bluetooth module’s default state will be off after resuming from the Sleep power-saving
state. Use the key combination (Fn + F12) to power on the Bluetooth module after the com-
puter resumes from Sleep.
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Bluetooth Configuration in Windows Vista

Setup your Bluetooth Device so the Computer Can Find it 4
1. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on. Bluetooth Taskbar
2. Make the device discoverable (to do this check your device documentation). lcon
To Turn the Bluetooth Module On If you cannot see the
1. Press the Fn + F12 key combination to power on the Bluetooth module. Bluetooth icon in the task-
2. A Bluetooth icon EJ will appear in the taskbar (see sidebar). bar, access the Blue-
3. You can then do any of the following to access the Bluetooth Devices control tooth  Devices  control
panel panel. Click Bluetooth
) Settings > Options, and
» Double-click the icon fg to access the Bluetooth Devices control panel. make sure that Show the
» Click Start, and click Control Panel (or point to Settings and click Control Panel), and then Bluetooth icon in the
click Bluetooth Devices (Hardware and Sound). notification area check

« Click/Right-click the icon g and choose an option from the menu. box (Connections) has a
: tick inside it.

Add a Bluetooth Device

shopcBldetooth Redicey Note that you will need to
Send a File check the LED indicator
to see if the module is
powered on or not.

Receive a File

Join a Personal Area Metwork

Add Wireless Device Bluetooth Settings Open Bluetooth Seftings

Figure7-1
9 daems d Bluetooth Devices &
Click lcon Menu

Remove Bluetooth Icon
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To Add a Bluetooth Device

/ 1. Access the Bluetooth Devices control panel and click Bluetooth Settings.
o _ 2. Click Options (tab), and make sure that Allow Bluetooth devices to connect to
Pairing Options this computer check box (Connections) has a tick inside it, and click OK.

3. Click Add Wireless Device in the Bluetooth Devices control panel.

If a device has b - . . S
s 4. Double-click the device you want to pair with the computer.

viously connected then
the pairing option menu
will appear when you at-

Pair with a wireless devic,

tempt subsequent con-

Feﬁtloni.hYou Gl (tIhOOSE | Select a wireless device to pair with this computer

o0 have the computer cre-

ate a pairing code for you, _Nam; Device Cat..

use the device's existing LW Phone M| wess

pairing code or you can | 8] _suoan | @ shsos

pair certain devices with- ‘A W G

out using a code L Bluetooth ;“i Bluetooth
a Phone

3 i Bluetooth

Figure 7 - 2
Pair with a wireless
device l

What should I do if Windows hasn't discovered my device?

=

5. Onfirst connection the computer will provide you with a pairing code to be entered
onto the device.
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6. Enter the code into your Bluetooth enabled device and follow any on-screen
instructions to complete the pairing.

Type the following code into your device L. Figure 7 - 3
Thes will vy that you ane painng with the comect device. Palrlng COdeS Palrlng Code
68242645 The example outlined here shows a connection to Example
e eoypenc o e a mobile device. Other devices e.g. computers,
may have a slightly different connection proce-
g v dure, and may require you to confirm a pairing
o code is correct on both devices. Follow the on-
screen instructions to complete the pairing.
7. Windows will check to see if any drivers are required to complete the pairing.
8. Follow any on-screen instructions on the computer if device drivers are required to
be installed.
9. Click Close.
sz e Figure 7 - 4

Pairing Complete &

Bluetooth Device

Enabled

[ ol o Mo S 1 i
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To Change Settings for the Bluetooth Device
/ + 1. Access the Bluetooth Devices control panel.
2. Click on the device you want to change and click Properties to:

« Change the name of the device (click General, type a new name and click OK).
« Enable/Disable a service (click Services, clear/tick the check box next to the service and click OK).

Bluetooth Help

To get help on Bluetooth

g‘;"zg“i‘lz’; :gld Zﬁz To Make your Computer Discoverable to Bluetooth Devices
< ¢ 1. Access the Bluetooth Devices control panel.

Support from the Start ; . .
menu. Type Bluetooth in 2. Click Bluetooth Settings > Options, and make sure that Allow Bluetooth

the Search Help box, and devices to find this computer check box (Discovery) has a tick inside it.
select an item from the re- 3. Make sure that the Alert me when a new Bluetooth device wants to connect
turned search results to check box (Connections) has a tick inside it, if you want to be notified when a
get more information. Bluetooth device wants to connect.
€} Bluetooth Radio Properties =)
Discovery
[F]liow Bluetooth devices to find this compltert
& To protect your privacy, select this check box only
when you want a Bluetooth device to find this
Flgure 7 - 5 gzising\iema&vdevl(asmgunne(th:thlsmmputer
B | u eto Oth Setti n g S _ lﬂAlErtmE when a new Bluetooth device wants to connect
O p t I ONs 7] show the Bluetooth icon in the notification area
Change settings for 3 Bluetooth enabled device,
e || e e
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PC Camera Module o
If you have included a PC Camera module in your purchase option, make sure that ’Q‘
the PC Camera module is on before installing the driver. Use the Fn + F10 key com- Latest PC Camera

bination (see “Function/Hot Key Indicators” on page 1 - 12) to toggle power to IR (I DI E)

the PC Camera module. When the PC Camera module is powered on, the on- Check the Device Driv-
screen indicator will briefly be displayed. Make sure you install the drivers in the FEEEREEEINESESEEEES
order indicated in Table 4 - 1, on page 4 - 3. WLl 205, 2 ey

accompanying insert
. . . . pages, for the latest up-
There are a number of different camera modules available with this computer model dated information on the
series. You will have the appropriate application installed for your camera. Make PC Camera driver,

sure you access the application via the WebCam desktop shortcut. which may override the
information provided

here.

. |
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PC Camera Driver Installation

\ A/ . . - « -
7[\1: 1. Make sure the module is powered on, then insert the Device Drivers & Util-
PC Camera Screen ities + User’s Manual disc into the CD/DVD drive.
Refresh 2. Click Option Drivers (button).
¢ e g e G 3. Click 1.PC Camera, Web cam > Yes.
cereen refresh rate = I3 Choose the language you prefer and click Next > Next.
e oo+ @ 5. Click Finish to restart the computer.
L e EC Sl 6. Run the camera application program from the shortcut on the desktop (if the
window size, or adjust hardware is turned off use the Fn + F10 key combination to turn it on
the Output Size and/or again).

Color Space Compres-
sion.

To reduce Output Size
and/or Color Space
Compression run the
camera application,
click Options and select
Video Capture Pin. Ad-
just the settings from the
appropriate  pull-down
menu.
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PC Camera Audio Setup
If you wish to capture video & audio with your camera, it is necessary to setup the
audio recording options in Windows.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).

2. Double-click Sound “* (Hardware and Sound).

3. Click Recording (tab).

4. Right-click Microphone (Realtek High Definition Audio) and make sure the item is
not disabled.

5. Double-click Microphone (or select Properties from the right-click menu).

6. Click Levels (tab), and adjust the Microphone and Microphone Boost sliders to

the level required.
7. Click OK and close the control panels.
Run the camera application program from the desktop shortcut.
Go to the Devices menu heading and select Microphone (Realtek....) (it should
have a tick alongside it).
10. Go to the Capture menu heading and select Capture Audio (it should have a tick
alongside it).

© ©

. |
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Figure 7-6 % Sound &= [ Microphone Properties =5
. Playback | Recording | Sgunds General | Levels | Advanced
Audio Setup for PC |
Select a recording device below to modify its settings:
Camera = Microphone
R’ Microphone (T
Realtek High Definition Audio | O e [ Bstsnce |
| =0 | it speed Recagniona |
a Disable !
— Microphone Baast
“® Show Disabled Devices f fi [~20048

v Show Disconnected Devices

Properties... '

Right-click
et Defoul I
Concel Aovly ‘ = ==

Devices | Options  Capture  Zoom  Help Capture | Zoom Help
¥ BisonCarn, ME Pro Start Capture

Stop Capture

v Microphone (Realtek High Defini

v Capture Audio
Set Tirne Limit...
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Camera Application
The WebCam application is a video viewer for general purpose video viewing and 4
testing, and for capturing video files to .avi format.

Pre-Allocating File

1. Run the camera application from the desktop shortcut (it is recommended that you SRS
set the capture file before the capture process - see “Set Capture File” on You may pre-allocate the
page 7 - 12). file size (File > Allocate
2. Goto the Capture menu heading (if you wish to capture audio check “PC Camera File Size/Space) for the
Audio Setup” on page 7 - 9) and select Start Capture. capture file in the camera
3. Click OK/Yes (the file location will be displayed in the pop-up box) to start program (you may need

to set a folder location

capturing the video, and press Esc to stop the capture (you can view the file using frst)

the Windows Media Player).

Pre-allocating space on
the hard disk can improve
the capture quality (par-
ticularly of large capture
files), by reducing the
amount of work the hard
disk has to do in finding
space for the video data
as it is being captured.

See also “Reducing Vid-
eo File Size” on page 7 -
13.
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Set Capture File

Prior to capturing video files you may select the Set Capture File... option in the
File menu, and set the file name and location before capture (this will help avoid ac-
cidentally overwriting files). Set the name and location then click Open, then set the
""Capture file size:" and click OK. You can then start the capture process as on the
previous page.

Note the important information in “Reducing Video File Size” on page 7 - 13 in
order to save file space, and help prevent system problems.

7 - 12 PC Camera Module
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Reducing Video File Size

Note that capturing high resolution video files requires a substantial amount of disk
space for each file. After recording video, check the video file size (right-click the
file and select Properties) and the remaining free space on your hard disk (go to My
Computer, right-click the hard disk, and select Properties). If necessary you can
remove the recorded video file to a removable medium e.g. CD, DVD or USB Flash
drive.

Note that the Windows Vista system requires a minimum of 15GB of free space on
the C: drive system partition. In order to prevent system problems it is recommend-
ed that you save the captured video file to a location other than the C: drive (see “Set
Capture File” on page 7 - 12), limit the file size of the captured video (see “Pre-
Allocating File Size/Space” on page 7 - 11) or reduce video resolution (see below).

To Reduce Video Resolution Qutput Size:

1. Run the camera application program from the desktop shortcut.

2. Go to Options and scroll down to select Video Capture Pin....

3. Click the Output Size drop box and select a lower resolution size in order to
reduce the captured file size.

4. Click OK.

. |
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Eliminating Screen Flicker
If you find that the video screen in the camera program is flickering, you can try to

Properties [ Properties (=]

Property Page | Video Proc Amp | Camera Control l Property Page H-V_\d;FEN;D-l

¥ Auto White Balance RGB gain [¥] Auto White Balance RGE gain
Environmert R | Envj!r.n“ljl:nent f
@ Aol " Tungsten G <l | @ Auto: (7 Tungsten

7 " Daylight (" Fuorescent ‘ ; ©) Dayfight ) Fuorescent

Fot e > — Rotation Frequency
™ Honizontal ™ Vertical " Disable " 50Hz (* BDHz ] Horizontl [ Vertical ! Disable

I™ Effect Mode

1 Effect
Figure 7 -7 :
Video Capture Filter £ e ™ Low Light Mode
. Reset |Re%"e‘.
ok | Cancel | | oK Cancel Apl

adjust the setting in the Video Capture Filter options.

1. Run the camera program from the desktop shortcut.
2. Go to Options and scroll down to select Video Capture Filter....
3. Click either 50Hz or 60Hz under Frequency in Property Page (tab).

7 - 14 PC Camera Module




Modules & Options

Zoom
The WebCam program allows you to zoom the camera in and out.

1. Run the camera application from the desktop shortcut.
2. GotoZoom and select Zoom Out/Zoom In.

I Zoom | Help

Zoom Cut

Figure 7 - 8
Zoom/Setting

foomIn

SN
A&

Snapshot Folder

Taking Still Pictures

The WebCam program allows you to take still pictures.
The Snapshot folder’s

1. Run the camera application from the desktop shortcut. default location is on the
2. Goto Options and select Take Picture. de_sktop. Do not move
3. The picture (in JPEG format) will be placed in the Snapshot folder ﬁ |on the this folder or an error

desktop. j may appear when you

try to take a still picture.

If you accidentally de-
lete or move the folder,
you can create a new
Snapshot folder on the
desktop in order to cap-
ture the files.
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N /
Z &
Wireless Device

Operation Aboard
Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if

you are using the computer
aboard aircraft.

Use the Fn + F11 key com-
bination to toggle power to
the WLAN module, and
check the indicator to see if
the module is powered on
or not (see

/

).

Wireless LAN Module

If you have included an Intel® Wi-Fi Link 5300 Series or 3rd Party 802.11b/g/n
WLAN module in your purchase option, make sure that the Wireless LAN module is
on before installing the driver.

Use the Fn + F11 key combination (see “Function/Hot Key Indicators” on page 1
- 12) to toggle power to the Wireless LAN module. When the WLAN module is
powered on, the () LED will be illuminated and the on-screen will briefly be dis-
played. Make sure you install the drivers in the order indicated in Table 4 - 1, on
page 4 - 3.

The standard driver installation procedure for the Intel® Wi-Fi Link series module
is outlined overleaf. If you want to include Intel® My WiFi Technology as part of
the installation procedure, DO NOT install the driver as per the instructions
overleaf, instead see “Intel® My WiFi Installation & Configuration” on page 7 -
21.

If you have installed the standard driver (as per the instructions overleaf) and wish
to enable Intel® My WiFi Technology at a later point you will need to reinstall the
driver (choose Unlock from the Drivers Installer menu). Follow the driver installa-
tion procedure and choose Modify from the menu when the option appears, and then
follow the remaining installation instructions in “Intel® My WiFi Installation &
Configuration” on page 7 - 21.
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Intel® Wi-Fi Link Series Driver Installation
If you see the message “Found New Hardware” click Cancel to close the window.

1.

ok wn

Make sure the module is powered on, then insert the Device Drivers & Util-
ities + User’s Manual disc into the CD/DVD drive.

Click Option Drivers (button).

Click 2.Wireless Lan > Yes.

Click Next > Next.

Click the button to accept the license and click Next.

Click Next > Next > Finish.

3rd Party 802.11b/g/n Driver Installation

1.

ook wN

Make sure the module is powered on, then insert the Device Drivers & Util-
ities + User’s Manual disc into the CD/DVD drive.

Click Option Drivers (button).

Click 2.Wireless Lan > Yes.

Choose the language you prefer and click Next.

Click Next > Install.

Click Finish.

Note: The operating system is the default setting for Wireless LAN control in Win-
dows Vista (see overleaf).

. |
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4

Intel(R) PROSet/
Wireless

Access the Intel
PROSet Wireless tools
(Statistics and Diagnos-
tic tools) from the Start
menu (Start > Pro-
grams/All  Programs >
Intel PROSet). These
tools provide diagnostic
and statistical informa-
tion only (use the WLAN
control in Windows Vis-
ta to connect to a WLAN
access point).




Modules & Options
Connecting to a Wireless Network
Make sure the Wireless LAN module is turned on.

1. Click the taskbar wireless icon [, and then click Connect to a network (or right-
click the icon [, and then click Connect to a network).

CConnect to a network >

Figure7-9
Taskbar Menus

Mot Connected

:. Wireless networks are available.

Turn on activity animation

Turn pif notification, ofn networks
- e o
Click icon RiGht-&1ick icon
Diagnose and repair
onnect to a network
/ P or Metwaork and Sharing Center

Network and
Sharing Center

You can also use the Net-
work and Sharing Cen-

bl
ter control panel in
WlndOWS (NetWOrk al’ld Select a netwark ta connect ta o
Internet) to connect to " B2
any available wireless LR .L"-* il
networks. .
o v Security-enabled netwark alll |
5- WLAN] Secusity-enabled netwark Al
Figure 7 - 10
Connectto a
Network

/g N Egaipr LY

2. Inthe Show list, click to choose Wireless from the drop-down menu.
3. Alist of currently available networks will appear.

% Connectto anetwork

-

-
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Click a network, and then click Connect.

If you do not see a network you want to connect to, click Set up a connection or

network (a list of options will appear allowing manual searching, and creating a
new network).

o P P
o) ¥ Connectin a network @ W Connect 1o 2 network ﬁ

Connecting to WLAN

S

Choose a connection aption

Figure 7 - 11

A [ v e e o Connecting

G Maraislty tonnect 10 8 wieless network

& Serup s wireless ad hoc (computer-te- comp

3 St up & dal-up cmnection

(o] (s ] [ Conee ]

6. Move the cursor over the taskbar icon [ to see the connection status (see below).

Currently connected to

‘I Metwork.com{WLANL) " .
ez Access: Local only l_l!!_u Figure 7 - 12
Connection Status

#C W) 11:20 AM
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7. To disconnect from the wireless network you can click the taskbar wireless icon [,
7£l< and then select Connect or disconnect to access the network menu, and click

. Disconnect (or right-click the icon [, and then click Disconnect from).
Security Enabled Y

NEIWWS Currently connected to:

| = Network.com(WLANL) i
,‘!
am, Access: Local only !!.!:U

Click icon

You should try to make

sure that any network you || Disconnect or connect to another network

are connecting to is a se- W =
cure network e
' Network and sharing Center = =
ﬁ WLANL Connected !!!!j
Connecting to unsecure net-
works may allow unautho- Security-enabled netwark A 5
rized access to your
computer, documents, web- Security-enabled network o T

sites and files etc.

Set up a connection or network
Open Network and Sharing Center

F | g ure 7 - 13 Metwork.com{WLANL) Disconnect from

Disconnecting onnect to a network

Turn on activity animation

Turn off netification of new networks

Right-click icon

Diagnose and repair

P — Network and Sharing Center
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Intel® My WiFi Installation & Configuration

Intel® My WiFi Technology uses your WLAN module to allow you to connect up
to eight other WiFi enabled devices (e.g. digital cameras, other computers, cell
phones, handheld devices etc.) to your computer (similar to Bluetooth), while still
connecting to the Internet through your WiFi wireless connection. Intel® My WiFi
Technology offers greater range and speed than other personal area networks, and
does not require an access point.

. |
Wireless LAN Module 7 - 21
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Intel® My WiFi Help

To get help on Intel®
My WiFi configuration
and settings, access the
Intel® My WiFi Utility
from the Start menu
(Start > Programs/All
Programs > Intel
PROSet Wireless > Intel
My WiFi Technology), or
by clicking the taskbar
icon @ Click the Help
icon W#H=p and select
a help topic from the
Contents menu.
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Intel® Wi-Fi Link Series My WiFi Driver Installation

d " If you see the message “Found New Hardware” click Cancel to close the window.
Intel(R) PROSet/ 1. Make sure the module is powered on, then insert the Device Drivers & Util-
Wireless ities + User’s Manual disc into the CD/DVD drive.
Access  the  Intel 1 2 Cl!ck Option Drivers (button). _
PROSet Wireless tools | 3- Click L.Install Wireless Lan Driver > Yes.
(Statistics and Diagnos- || 4. Click Next > Next.
tic tools) from the Start | 5. Click the button to accept the license and click Next > Next.
menu (Start > Pro- § 6 Click Custom (button) and click Next.
?r:?eTS/I;’A\Ig Og;‘:graﬁf‘e; 7. Click Intel(R) My WiFi Technology (button) and select “This feature will
e R be installed on local hard drive.
and statistical informa- 1 ntel(R] PROSet/Wirless WiFi Software |
tion only (use the WLAN - (inteD
control in Windows Vis-
ta tO Connect tO a WLAN Click on an icon in the list below to change how a feature is installed. .
access point). e L — i) o Ty s
- =3r| IntelfR) PROSet/Wireless WiF Comnection Uity 52:‘5‘;’!2.?3;.{,‘;‘;,:;'32?”5
FRREI=T | int=I(R) My WiFi Technology | personal network, apart from
= Th.iS'E;dmewillhE'mS!allﬂiunlu(Hur .
Figure 7 _ 14 xu Th\sfeaturew\\lnutbeavawlabli'.
Intel(R) PRO Set
Intel(R) My WiFi
TeC h no I o g y ::”s\::;am Files\Intel}
Installation

8. Click Next > Finish.
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Intel® My WiFi Configuration
You can configure the My WiFi settings as follows.

1. Access the Intel® My WiFi Utility from the Start menu (Start > Programs/All
Programs > Intel PROSet Wireless > Intel My WiFi Technology), or by clicking
the taskbar icon .

2. Click Enable [WEE73
devices listed).

(on the first run of the program there will be no connected

£ Il My W Lty s R | 5 i oy e ey =]

Intel* My WiFi Technology Intel® My WiF Technology

i [ o

s U e\ ) lmrmswvmlhmmﬂﬁ;u.,\p.‘m-.ens-nanlu'mtﬂi EI Figure 7 _ 15
i - :.nr-mumwum Hetwork fame: BOACPTIRE (Profies | Intel® My WiFi
To view svailable W devices, snable Inted® My WiF Technology. \‘_::-:T:‘: o - Utility

Mo devices are comently connected.
T conmisct & e dinicn Lo Uhis compuer, cick ASd tiw Dirvicn,

o previously comnected devices to disply.
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3. Click Start, and click Control Panel (or point to Settings and click Control

Panel).

4. Click Network and Sharing Center (Network and Internet).
5. Click Manage Network Connections.

G

[y T Ty s

Click Manage Network

Figure 7 - 16 Connections — |0
Network and

Sharing Center

;o
. .Iﬁ-m
P b

6. Right-click Intel My WiFi STA (Station) in Network Connections and select

Properties.
oo
Q\:J £ o Metwork sndiekemet » Network Connecters » - ; )
Figure 7 = 17 Nl.l::crngr-:::sa-uwllzmemm e e O L i “..
. . | Intel My WiFi PAN » il WiFi STA - Le<al Avea Connecticn
Intel My WiFi STA W e B St
Properties Right-click Intel My WiFi | & oo ol SR
(Network STA (Station) and select | wuiuws "
Connections) Properties. — e
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7. Click Sharing (tab) and select “Allow other network users to connect through

this computer’s Internet con

o

9. Click OK.

Click “Allow other network
users to connect through
this computer’s Internet

connection”. —_—

Select Intel My WiFi PAN.
—_

nection”.

Select Intel My WiFi PAN under Home Networking Connection.

U Intel WiFi STA Properties

I_Networldng Sharing |

Intemet Coninection Sharing

[¥] Mllow ather network users to connect through this
computer’s Intemet connection

Home networking connection:

el TR

al

Select a private network connection

[F14 Local Area Connection ‘ Flgure 7 - 18
W it My WiFPAN | -
IR | Intel WiFi STA
Using ICS (Intemet Connection Sharing) Properties _
Sharing
[ ok ][ cancsl
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10. A message will appear to inform you that the LAN adapter will be set to use the IP

Fl ure7 - 19 address 192.168.0.1. ' '
|§Address 11. Click Yes to enable Internet Connection Sharing.
Warning | LocaNetwor ]

SR When Internet Connection Sharing is enabled, your LAN adapter will be
H L set to use IP address192.168.0.1. Your computer may lose connectivity

Y/

S with other computers an your network. If these other computers have
static IP addresses, you should set them to obtain their IP addresses
automatically. Are you sure you want ta enable Internet Connection

IP Addresses Sharing?

The Intel® My WiFi de- Ves No
fault gateway IP ad-

dress is 192.168.0.1. 12. Access the Intel® My WiFi Utility from the Start menu (Start > Programs/All
DO NOT use this ad- Programs > Intel PROSet Wireless > Intel My WiFi Technology), or by clicking
dress for any Wireless the taskbar icon 8

Access Point (or any . . e
other static IP address 13. Click Profiles s —

on your network).

Intel" My WiFi Technalogy Qﬂe’l

. Prodtie: Intel Wreless PAI Metwork fame: Do CPTISE [Praties )
Figure 7 - 20 —
Intel® My WiFi e e e -

Ut|||ty To cunmect a new device 1 this computer, chck Add ew Davice.

[ S — —

o previousty comnectad devices to dieplry.
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14. Click Profiles, click Intel Wireless PAN and click Edit.

Profiles

nted Wirekess PAN

B kel My WIS Techvasiogy seffings are saved aa profles.
o 1 15 Bl gt et bt o o 1o L8

|

15. You can change the Profile Name and Network Name to your personal

preferences in General (tab).

4

Profile and Network Names

The Profile Name is the name as
displayed on your computer in the
Network Connections control pan-
el (see Figure 7 - 17 on page 7 -
24).

The Network Name (SSID) is the
name the devices see when they try
to connect to your computer.

Profile Settings e
General |security | sharing | Advanced|

Profile Name:

Inte] Wireless PAN

Network Name (S5I0):

My Notehook Computer

The Profile Name is the name for the Intel® My WiFi Network as it is displayed on this

computer {Example: Home or Office). The Metwork Name {SSID) is the name thata

device will see when connecting to this network.

o —

Modules & Options

Figure 7 - 21
IP Address
Warning

Figure 7 - 22
Intel® My WiFi
Profile Settings -
General
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16. Click Security (tab).

17. Change the Security Type to WEP and the Encryption Type to 64bit.
18. Enter a password (5 characters long) in the Passphrase box.

19. Click OK.

=
Profile Settings @rep

| General | Security iSharing I Advanced |

Security Type: [WEP ) v]

Encryption Type: @4 bit ) v]

Figure 7 - 23
Intel® My WiFi i
Profile Settin gs - Use a passphrase to quickly generate a new key or manually enter a key below.
Secu r|ty Passi rase: (5 ASCII characters)
Key (0-3,4F):
3132333435

Key Index: 3 -
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20. Click Sharing (tab).

21. Make sure Filter Network Traffic and DHCP and DNS Server are Disabled.
22. Click OK.

=
Profile Settings Grep

| General | security | Sharing i.l'-\dvanaed

Internet Connection Sharing and Bridging Filter

This setting prevents devices connected to the Intel® My WiFi Network from accessing
Set Filter Network shared networks through internet connection sharing or network bridging.

Traffic & DHCP

and DNS Servers WLL]D‘“M z
to Disabled. i

— Figure 7 - 24
\ DHCP and ONS Servers

Intel® My WiFi
en enabled, the Intel® My WiFi MNetwork will issue IP addresses and resolve device H : _
connected devices. Disable if other DHCP and DNS servers are available on Profile Settin gs

Sharing

DHCP and DNS 5ervers:< Disabled 2 A

Maote: DHCP and DNS servers are automatically disabled when the network is shared
through internet connection sharing.
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23. Click Advanced (tab).
24. Make sure the Default Channel is set to Channel 1, 6 or 11.
25. Click OK.

Figure 7 - 25
Intel® My WiFi
Profile Settings -
Advanced

7 - 30 Wireless LAN Module

==
Profile Settings @b

| General | security | sharing | Advanced

Default Channel

The channel of the Intel® My WiFi Network will automatically match the associated access
point. If the adapter is not assodated to an access point, the following settings are used for
Intel @ My WiFi Technology:

(LRSSt

fAY FEFY. O
=

oK |" Cancel |
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26. Double-click Intel My WiFi PAN (Personal Area Network) in Network Connections.
27. Click Details to display the Network Connection Details.

=2 o

OQ [ « Networkand Intemet » Network Connections » ~[4] [ search R

ble this network device [ Disgnose this connection >

Name Status DeviceName  Connectivity  Network Category  Owner Type Phone # or .. Flgure 7 26

- Intel My WiFi PAN

Intel WiFi STA ~_| Local Area Connection
e 3%? Network
Connection Details
7 = Network
oflll Intel My WiFi PAN Status [ " ( i
Connections)
[ General |
Connection — i g i
Metwork Connection Details ==
IPv4 Connectivity: Limited
IPv6 Connectivity: Limited Network Connection Details
Mediz State: Enabled Froperty Value
S5ID: MY PAN Connection-specific DN
o Duration: 04:12:34 — Description My WiFi PAN
Speed: 54.0 Mby Physical Address 00-16-EA-05-6107
peads IS DHCP Enabled No
Signal Quality: !!ﬂ! IPv4 IP Address 192.168.0.1
/l\ IPv4 Subnet Mask 255.255255.0
([ Details. .. u Wireless Properties ] IPv4 Defaul Gateway
IPv4 DMS Server
Activity 1Pv4 WINS Server

- NetBIOS over Tepip En Yes
Sent — ~! = Received Linkdocal IPvE Address Fe8D::dcd1:6e63:9df5:4afc %21
s il IPvE Default Gateway

. — a 0 IPvE DMNS Server

[@Eropertes][ [f'gisable H Diagnose ]
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28. Access the Intel® My WiFi Utility from the Start menu (Start > Programs/All
Programs > Intel PROSet Wireless > Intel My WiFi Technology), or by clicking
the taskbar icon E.

29. To add a new device follow the instructions in the devices’ user guide for
connecting to a WiFi network.

30. Click Add New Device in Intel® My WiFi Utility to confirm the security settings

detail.
) Tntel® My WiFi Utility o] B[
® e
Intel® My WiFi Technology
7 E=
u Add New Device
7 Enabled
Compatible WiFi devices can now connect to your computer via Inj Manually configure a device
devices as well as a list of devices that previously connected to th
To add a new device, follow the instructions in the device's user guide for connecting to a WiFi
F i g u re 7 - 27 Profile: MY PAN Network Nam| network using the following security settings:
Intel® My WiFi , . .
. y % Block Device == Delete Devi Network Name(SSID): My Notebook Computer
Utility - et
Ad d N D ) onnected Devices (0) Security Type: WEP
( ew Devi Ce) No devices arg
Encryption Type: 64 bits
To connect a new device to
Security Passphrase: 12345
Previously Connected Devices (1)
i . Security Key: 3132333435
Unnamed Device A
00:22:43:92:FD:95
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Windows Mobility Center

The Windows Mobility Center control panel provides an easy point of access for
information on battery status, power plans used and wireless device status etc.

To access the Windows Mobility Center:

1. Click Start, and click Control Panel (or point to Settings and click Control
Panel).

2. Double-click Windows Mobility Center (Mobile PC).

3. Click the button to Turn wireless off/on, or click the icon [ to access the network
menu.

| Figure 7 - 28
Fully charged !!!ﬁ Coreitid L No display Windows Mobility

(100%:) e connected c
—[ Change wireless network settings. L enter

Balanced - [ Turn wireless off ] I [ Lonnect display

Volume Battery Status Wireless Metwork External Display

No sync g " "
@ part?rers-hips @& Mot presenting

’ Sync settings ] ’ Turn on

Sync Center Bresentation Settings
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4

Help & Manual

Right-click the taskbar icon
[A to bring up the menu to
select Help.

Insert the Device Drivers &
Utilities + User's Manual
disc and click Option Driv-
ers (button). Click Unlock
(button) and then click
3.FingerPrint >Yes.

Click Documentation to
open the folder containing
the manual in .pdf format.

To install the Adobe Acrobat
Reader software to read the
file, insert the Device Driv-
ers & Utilities + User’s Man-
ual disc and click User’s
Manual (button), and click
Install Acrobat Reader
(button).

Fingerprint Reader Module

The optional fingerprint reader provides a high level of security for your comput-
er. A further level of security and control is provided in the BIOS (see “Security
Menu” on page 5 - 11).

The fingerprint reader allows you to:

Access or Lock your computer

Protect sensitive files

Display and file your favorite web pages
Fill in frequently used dialogs

Run your favorite applications

Install the driver as instructed below and configure the reader as outlined on the fol-
lowing pages.

Fingerprint Reader Driver Installation

1.

SouhrwLN

Insert the Device Drivers & Utilities + User’s Manual disc into the CD/
DVD drive.

Click Option Drivers (button).

Click 3.FingerPrint > Yes.

Click Software Installation.

Click Next > Next > Next.

Click Finish > Yes to restart the computer.
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. . \ A/
1. Click Start > Programs/All Programs > Protector Suite > Control Center, or 7£l§

double click the taskbar icon | & (click Initialize).

2. On the first run of the program you will be asked to click the Accept button to

accept the license.

3. If you have not set a Windows password you will be prompted to do so (note: If
you have not set a password Protector Suite cannot secure access to your

computer).
4. Click Submit when you have entered password.

5. You will then be prompted to enroll your fingerprints (you can click Tutorial to get

help with fingerprint enrollment at any time).

3l FTOLECTOR Suite AN

Contral Center Home »

Manage Fingerprints

Fingerprint
Enrollment

Note that it is strongly rec-
ommended that you enroll
more than one finger in
case of injury etc.

@ ¥ou e ki 10 use Bingerpaint logon Bnd other aoplications using yous Fngerpeing reader

Contrad Center Hume

Envoliment

Figure 7 - 29
Fingerprint
Enrollment
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L&
Fingerprint
Enrollment

Note that it is strongly rec-
ommended that you enroll
more than one finger in
case of injury etc.

Figure 7 - 30
Fingerprint Status

6. Click the button above any of the fingers to begin the enroliment process for that

finger.
7. Swipe the finger until the progress bar reaches 100% to enroll that finger.

8. Repeat the process for all the fingers you wish to enroll (see sidebar), and then

click Save and Continue.
9. Enter a backup password and click Apply.

10. Close the fingerprint status window.
4 rotector Surte 2UUY =R ]

Control Center Home »  Manage Fingerprints »  Status I User: 3-1 I
=
Ch -
Control Center Home Backup password Notset @ | Change | [N
Identity [ewaeses
Applications
Settings Weak rm— - Strong
Help [esssneas
Apply
Fingerprint logon Set .| Change
Automatic backup Set @ | Change
Recommendati )
<
e Number of enrolled fingers: 3 @ | Change |
Application or driver update No information "'| Change
With enrolled fingers you can use fingerprint applications:
E3 | ud .R.
e §.C 5 r‘:

Link an application to a finger and then launch it simply by scanning the finger on the sensor.
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11. Right-click the taskbar icon E! and select Start Control Center (and then swipe a
finger) to allow you to Edit Fingerprints, register Applications, edit Settings and
access the Help menu etc. You can also run the Control Center etc. from the
Protector Suite item in the Programs/All Programs menu

12. Click “Help” in Control Center Home to get more information on any topic.

13. You can also run the Tutorial, or Product Tour video to get more information.

Lfita A upek.
1 RS
g Lock computer Figure 7 = 31
& reasersas Control Center &
P Registered Sites .
Biomenu

c Register...

= E-Wallet

. Lock Personal Safe

s
o Strong Password Generator

Help

;‘} Contral Center...
2
-

14. See “Help & Manual” on page 7 - 34 for further details.

15. If you swipe your finger over the reader at any time you can access the Biomenu
to lock the computer, register websites, access the Personal Safe, E-Wallet or
Strong Password Generator, open the Control Center and access the Help
menu.

Fingerprint Reader Module 7 - 37



Modules & Options

4

Help

For more information on
these and other features
simply access “Help” in
the Fingerprint Control
Center and select the
item from the menu on
the left.

Fingerprint Control Center Features

Application Launcher

The Application Launcher allows you to register applications to be launched when
assigned to a particular finger. Simply copy the application icon on to one of the reg-
istered fingers and ten click OK to close the application window. Once registered the
application will launch when you swipe the appropriate finger across the sensor.

Password Bank

The Password Bank stores registrations of user names, passwords and other set-
tings for web sites etc.

Strong Password Generator
Strong Password Generator helps you to create complicated passwords resistant
to dictionary attacks from the Internet.

E-Wallet

The E-Wallet provides biometric security for important personal information such
as credit card details, account numbers etc.

File Safe

File Safe is an encrypted area assigned on your hard drive that allows you to store
files and folders to be protected by fingerprint protection.
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3.75G/HSPA Module

(Optional for Model A Computers Only) 4

If you have included an optional 3.75G/HSPA (High Speed Packet Access) module | 3.75G/HSPA Module
(see “Communication” on page C - 4 for specification details) in your purchase op- Options

tion, you will have the appropriate application (HSPA Modem Interface or Mobile | tiere are two optional
Partner) provided for your module. Follow the instructions on page 7 - 41 to install | 3.75G/HSPA  modules
the USIM card (supplied by your service provider), and then install the application ixz:ﬁtj)tl:rfo% tc:;sélsserie,assal ;:
(see over for further details). module is supplied with the

appropriate application
software.

\ A/
PR
. . The module type supplied
Important Notice - 3.75G/HSPA & Bluetooth/Wireless LAN Modules may depend upon the com-
puter model purchased.
Check with your service

center for details.

In order to comply with FCC regulations you should NOT operate the 3.75G/HSPA module
and the Bluetooth/Wireless LAN modules at the same time as this may disrupt radio fre-
qguency, and cause interference. When the 3.75G/HSPA module is powered on, make sure
that the Bluetooth/Wireless LAN modules are powered off. Install the driver from the
Drivers Installer menu and
check the instructions for
the appropriate application
on the following pages.
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4

3.75G/HSPA
Modules & System
Wake Up

Note that the 3.75G mod-
ules DO NOT support
system wake up on
3.75G/HSPA modem ac-
tivity.

Before installing the application, make sure that the 3.75G/HSPA module is ON
(installing the driver with the module off will not allow the software to detect the
module hardware correctly). Use the Fn + [Z ] key combination (see “Function/Hot
Key Indicators” on page 1 - 12) to toggle power to the 3.75G/HSPA module.
When the 3.75G/HSPA module is powered on, the on-screen indicator will briefly be
displayed. Make sure you install the drivers in the order indicated in Table 4 - 1, on
page 4 - 3. Note that exiting the application does NOT turn off the 3.75G/HSPA
module.

* HSPA Modem Interface - See “HSPA Modem Interface Installation” on
page 7 - 43 for driver installation information and “HSPA Modem Interface”
on page 7 - 44 for instructions on using the HSPA Modem Interface.

» Mobile Partner - See “Mobile Partner Application Installation” on page 7 -
52 for driver installation information and “Mobile Partner Application” on
page 7 - 53 for instructions on using the Mobile Partner application.
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USIM Card Installation

1. Turn off the computer, and turn it over and remove the battery (see “Removing 721’:
the Battery” on page 6 - 3). Power Safety
Warning

2. The SIMLOCK is located in the compartment under the battery.

3. Remove screw 0 from the SIMLOCK cover, and remove the cover.
4. Insert the USIM card as you would into your mobile phone. Before you undertake
any installation proce-
dures, make sure that
you have turned off the
power, and disconnect-
ed all peripherals and
cables (including tele-
phone lines). It is advis-
able to also remove your
battery in order to pre-
vent accidentally turning
the machine on.

SIMLOCK Location Figure 7 - 32
Battery & SIMLOCK

Cover Removal

3.75G/HSPA Module 7 - 41



Modules & Options

5. Slide the SIMLOCK towards the hinge (in the direction of the arrow illustrated in
Figure 7 - 33) in order to release the lock and lift it up.
6. Insert the USIM card as illustrated in (Figure 7 - 34) and close the SIMLOCK.

Figure 7 - 33
Unlock the
SIMLOCK
7. Lock the SIMLOCK by pushing it in the direction of the arrow in Figure 7 - 34 until
it clicks into the lock position.
Figure 7 - 34

SIMLOCK Lock

8. Replace the cover, screw and battery.
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HSPA Modem Interface

\ A/

With the 3.75G/HSPA module and USIM card (supplied by your service provider) 7£l<
installed you may then install the HSPA Modem Interface. The HSPA Modem In- Wireless Device

terface allows you to directly access your HSPA internet service from the computer. Operation Aboard
Aircraft

HSPA Modem Interface Installation
. . . . The use of any portable
1. Enable power to the module by pressing the Fn + [ ] key combination (the electronic transmission de-

on-screen indicator will indicate the module’s power status). If a Found :Ifes ?:ﬁﬁ.r?e Zifmfliies o
New Hardware window appears, click Cancel in all windows that appear, IS AR Tt
and then proceed to install the driver as below. you are using the computer
2. Click Option Drivers (button). aboard arcrait
3. Click 4.3.5 Generation Module > Yes. Use the Fn + ] key com-
4. Click Next > Install. bination to toggle power to
5. Click Finish to restart the computer. U2 SUSEln SR [elis)
6. Access the HSPA Modem Interface from the Start menu (Start > Pro- 222 ;hﬁk rf:fdl'ﬂ:'ff tggjﬁ
grams/All Programs > HSPA modem), or by double-clicking the HSPA ered on or not (see
modem icon on the desktop. /

).

|
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HSPA Modem Interface

a "\ The connection information is stored on the USIM card supplied by the service pro-
vider.

HSPA Modem Help

To get help on 3.75G/ 1. Power on the 3.75G/HSPA module using the Fn + key combination.

HSPA module configu- 2. Access the HSPA Modem Interface from the Start menu (Start > Programs/All

ration and settings, click Programs > HSPA Modem > HSPA Modem), or by double-clicking the desktop

the help icon [ icon Pz

select Help. 3. IfaUSIM card is not installed then a message will appear to notify you of this (click
OK to close the message and install the USIM card).

4. If you are required to enter a pin # then a message will appear to prompt you to
enter a pin #. (Note: to change pin # go to Settings and click OK in PIN
code.)

5. Click the Network connection [
window will display Connection Manager.

Figure 7 - 35 Connection Manager
HSPA Modem
Interface Window The connection information is commonly stored on the USIM

card supplied by the service provider. However if your ser-
vice provider requires details such as IP Address, User-
name and Password etc. to be entered before connection
you can enter them in the Connection Manager tab, or
save the details in Profiles.
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6. Click Connect to connect to your service provider.

2 HSPA modem

Figure 7 - 36
Connecting to
Network

Network connection

7. The message “Network is connected” will be displayed when the network
connection is successful.

Figure 7 - 37
Network is
Connected

s =

n I
I 5w |
F Jiten
r |
r I
I Fa I
I e frae |

e
8. You can then access the internet, download e-mail etc. as per any internet

connection.

|
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9. While you are connected the upper right corner of the HSPA Modem interface will
display the upload and download rates, and the taskbar icon will display the

Figure 7 - 38 connection speed.
Uploading/ 36
Downloading Rates
and Speed
10. To disconnect click the Disconnect icon (Connection Manager).
11. The program will disconnect from the service provider.
12. The module will still be on, and you will need to press the Fn + Ei key combination
to turn it off.
Adding a Profile
1. Access the HSPA Modem Interface from the Start menu (Start > Programs/All
Programs > HSPA Modem > HSPA Modem), or by clicking the desktop icon.
2. Click the Network connection [, and click Profiles (tab).
ode -
Figure 7 - 39
Profiles

i
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4,

Click Add (button) and input any Network Settings required by your service

provider.
Click OK to save the profile.

Network Settings
MName: !l
Primary DMS: 0 .0 .

Secondary DNS:

APM Mame: I

IP Address: o0

Username; I
Password: l

Authentication: ’NUHE j'

‘B HSPA modem

Network connection

Connection Manager

= e

Connection Log

Apply

5. You can Edit or Delete profiles from the Profiles tab.

6.

To use a profile click to select it, and then click Apply (button) and the settings will
be transferred to Connection Manager.

Modules & Options

Figure 7 - 40
Network Settings &
Profiles
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Contacts

1. Access the HSPA Modem Interface from the Start menu (Start > Programs/All
Programs > HSPA Modem > HSPA Modem), or by clicking the desktop icon.
2. Click Contacts (button).

B HSPA modem

Figure 7 - 41
Network Settings &
Profiles

@N Mt o
Contacts il
“MwPhoneBook
Storage ] Name: J Phione Murnber
@ S Eric @ 0933109428

[l S1M Zoe @ 0924526715
= 51 Shane @ 0227993500

3. Click Refresh (button) to download the contacts from the USIM card to the
computer.

4. The Contacts will then be displayed.

5. Double-click any contact to edit the information (or right-click and select Edit).

6. You can also Export/Import contacts by clicking the appropriate button.
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Messages
1. Access the HSPA Modem Interface from the Start menu (Start > Programs/All /
Programs > HSPA Modem > HSPA Modem), or by clicking the desktop icon. )
2. Click Messages | (button). SMS Service
2 HSPA modem In addition to standard in-
: 00 ternet services you may
also send and receive
SMS text messages us-
ing the HSPA Modem In-
terface, if your service
supports SMS.
=3 sMs | Time [ sender E
i 8 Inbox (12) | &Y 2008/10/16 18:35... 0936019801
%] Outbox 2008/10/1711:02...  +886931181825
8 Sent 2008/10/17 14:50... +886936010399
i ﬁ Draft @ 2008/10/1916:58... 0936019801
@l Personal Folder| () 2008/10/1916:58... 0936019801 |
@ merom i, st H Figure 7 - 42
e B Network Settings &
@2008/11!2417:01.. +886931188820 !_-I PrOfI'GS
Forward
Delate
3. Click Refresh (button) to download the messages from the USIM card to the
computer.
4. Click New (button) to create a new message.
5. You can either type the telephone number in the recipient field, or press To

(button) to select the contact from the list.
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6. Click to select a contact from the list and then click Add (button) and the phone
number will automatically be added to the recipient field.

7. Type the message information into the message body and click Send (button) to
send it, or Save to draft (button) to save the message.

8. Select any message to forward or delete it, or to reply to it.

Settings

1. Access the HSPA Modem Interface from the Start menu (Start > Programs/All
Programs > HSPA Modem > HSPA Modem), or by clicking the desktop icon.
2. Click Settings (button).

Figure 7 - 43

Settings

" Network Mode

PIN code

@ PINL
 PIN2

Others

& My number
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Click OK alongside any of the options to configure the settings.

The Network can be configured for an Automatic (usually from the USIM card) or
Manual connection.

The Network Mode can be configured for any appropriate mode required.

Network Mode
Figure 7 - 44
& Automatic & Automatic Settings - Network/
€ Manual " 26/GPRS/EDGE Network Mode
€ 3G/HSDPA/HSUPA/HSPA

You can also change your settings for the Pin #, and input your phone number.
Exiting the program DOES NOT turn off the 3.75G/HSPA module, and you will
need to press the Fn + [Z] key combination to turn off the module (pay careful
attention to this aboard aircraft - see “Wireless Device Operation Aboard
Aircraft” on page 7 - 16).

If the module is on and the computer enters a power-saving state, then the power
status of the module on resuming from the power-saving state will be as below:

If the 3.75G/HSPA module is on and the computer is Shut Down or Restarted,;
the module will be off when the computer starts up.

If the 3.75G/HSPA module is on and the computer enters Sleep or Hibernate;
the module will be off when the computer resumes from sleep.
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N /
2§
Wireless Device

Operation Aboard
Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if

you are using the computer
aboard aircraft.

Use the Fn + key com-
bination to toggle power to
the 3.75G/HSPA module,
and check the indicator to
see if the module is pow-
ered on or not (see

/

).

Mobile Partner

With the 3.75G/HSPA module and USIM card (supplied by your service provider)
installed you may then install the Mobile Partner application. The Mobile Partner
application allows you to directly access your HSPA internet service from the com-
puter.

Mobile Partner Application Installation

1. Enable power to the module by pressing the Fn + [= | key combination (the
on-screen indicator will indicate the module’s power status). If a Found
New Hardware window appears, click Cancel in all windows that appear,
and then proceed to install the driver as below.Insert the Device Drivers &
Utilities + User’s Manual disc into the CD/DVD drive.

Click Option Drivers (button).

Click 4.3.5 Generation Module > Yes.

Choose the language you prefer and click OK.

Click I Agree (button) to accept the license agreement.

Click Next > Install.

Click Finish to restart the computer.

Access the Mobile Partner application from the Start menu (Start > Pro-
grams/All Programs > Mobile Partner), or by double-clicking the Mobile
Partner icon on the desktop.

N~

|
7 - 52 3.75G/HSPA Module



Modules & Options

Mobile Partner Application

You will need to contact your service provider to obtain the exact details of how ex-
actly to configure the settings on this page.

4

Mobile Partner Help

Profile Management

1. Power on the 3.75G/HSPA module using the Fn + [Z] key combination.

2. Access the Mobile Partner application from the Start menu (Start > Programs/
All Programs > Mobile Partner), or by double-clicking the Mobile Partner icon
on the desktop E:3).

3. If you have not created a profile, click Tools and select Options, and then click
Profile Management.

4. Click New [ ®s  and input the appropriate information for Profile Name, APN
and Authentication etc. as supplied by your service provider. Online Help...

5. Click Save | s to save the profile.

To get help on Mobile
Partner  configuration
and settings, click the
Help menu and select
Online Help or press
F1.

_E!|[:| |

[Gomee  Onee e Figure 7 - 45
o I— Profile Management
oo [
Lier name:
Password!
[t |
|
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Connecting to the Service Provider

1. Power on the 3.75G/HSPA module using the Fn + [Z] key combination.

2. Access the Mobile Partner application from the Start menu (Start > Programs/
All Programs > Mobile Partner), or by double-clicking the Mobile Partner icon
on the desktop i3,

3. The software will run and you can select the Profile Name from the menu.

4. Click Connect to begin the connection process.

Figure 7 - 46 U - E B
Connect See

F i g ure 7 = 47 Authenticatin
Network @ g

Connection Prompt

7 - 54 3.75G/HSPA Module



Modules & Options

6. When the connection is successful you can move the cursor over the network icon

in the taskbar to display the connection information. Figure 7 - 48
Currently connected to: Connected
.&l ZEccess: Local and Internet TaSkbar
Notification

7. You can then access the internet, download e-mail etc. as per any internet
connection.

8. While you are connected the indicators in the Mobile Partner window will display
uploading and downloading icons and a network icon in the taskbar .

J_i. 0.00 kbps

9. To disconnect click the Disconnect [ giemeat | iCON, OF right click the taskbar icon
and select Disconnect.

Bl Oparabon Tock Hel

Disconnect from Figure 7 = 49

Connect to a network Disconnect

Puokle Wames: |12 @ Turn on activity animation

Turn off notification of new networks

@ Coerection :E Stai ﬂ Tewt ! Phonsbock
[P Mtisiial) ]

Diagnose and repair
Metwork and Sharing Center
RO g YRR YLke

CN|

Tl Hstes ooOoO | 8 {pocones oo

10. The program will disconnect from the service provider.
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11. The module will still be on, and you will need to press the Fn + [Z ] key combination
to turn it off.

12. If you click the Mobile Partner close icon [ a message will be displayed asking
you to click OK to confirm the program exit and to terminate the connection.

Figure 7 - 50 Prompt .

Exit Prompt .
I:el Do you want to teminate cument connection and close Maobile Partner?

0K || Cancal|

13. Exiting the program terminates the connection, but DOES NOT turn off the 3.75G/
HSPA module, and you will need to press the Fn + [Z ] key combination to turn off
the module (pay careful attention to this aboard aircraft - see “Wireless Device

Operation Aboard Aircraft” on page 7 - 52).
14. If the module is on and the computer enters a power-saving state, then the power
status of the module on resuming from the power-saving state will be as below:

 If the 3.75G/HSPA module is on and the computer is Shut Down or Restarted;
the module will be off when the computer starts up.

» If the 3.75G/HSPA module is on and the computer enters Sleep or Hibernate;
the module will be off when the computer resumes from sleep.

|
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TV Tuner Module

(Optional for Model B Computers Only)

If your purchase configuration includes the optional Hybrid (Analog & Digital)
USB Mini-Card TV Tuner module, you will be supplied with a remote control unit
and appropriate antenna and fittings for the module. Software support for the TV
Tuner module is provided by Windows Media Center in Windows Vista (Home
Premium Edition & Ultimate Edition) and in Windows 7 (not included in Starter
or Home Basic versions). In addition a driver is provided on the Device Drivers &
Utilities + User’s Manual disc for the remote control supplied with the TV Tuner.

The optional TV Tuner allows you to watch TV, play music CDs, video conference
and capture still images and video on your PC.

The Cable (CATV) antenna will only be enabled when a TV Tuner module is
installed. Make sure you connect the TV antenna.

Modules & Options

2N
2§

TV Antenna

The TV antenna sup-
plied with any TV Tuner
module is intended for
indoor use only. Please
do not use your TV Tun-

er module outdoors.

TV Tuner Remote

Point the remote at the
consumer IR transceiv-
er to change channels
etc.

Figure 7 - 51
TV Tuner Ports/
Jacks

1. Consumer Infra-
red Transceiver

2. CATV Antenna
Jack
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TV Tuner Module
Support

Note that the TV Tuner
module (factory) option in
Windows is supported by
the Windows Media Cen-
ter software which comes
built-in to the Windows
Vista Home Premium and
Ultimate Editions only.

If your purchase includes a
TV Tuner option, and you
are re-configuring your sys-
tem for a different system,
you should install either
Home Premium or Ulti-
mate Editions of Windows
Vista only. Note that Win-
dows Media Center is not
included in Starter or
Home Basic versions of
Windows 7.

7 - 58 TV Tuner Module

Consumer Infrared Driver

1.

arLN

Insert the Device Drivers & Utilities + User’s Manual disc into the CD/
DVD drive.

Click Option Drivers (button).

Click 5.1nstall CIR Driver > Yes.

Choose the language you prefer and click Next > Next.

Click Finish to restart the computer.

Windows Media Center

1.

2.

3.

This TV Tuner module is fully supported by Windows Media Center in
Windows Vista (Home Premium Edition & Ultimate Edition).

Run Windows Media Center directly from the Start menu (Start > Pro-
grams > Windows Media Center).

Windows Help and Support provides information on the Windows Media
Center functions. Click Start & and select Help and Support, and then
type “Media Center” in the Search Help box and click the magnifying
glass icon 2 to bring up the results.




Digital TV Broadcast Signal

The antenna is the most crucial factor in receiving a clear digital terrestrial TV
broadcast signal. The passive antenna provided should provide a clear signal when
placed beside a window. If the signal is not clear then you can purchase an active
antenna (it should also be placed beside a window) to improve the signal. You
should also check with any related government website which provides information
on digital terrestrial TV coverage for your area. Note that (unlike standard analog
TV) if the digital signal is weak then no picture will appear on the TV at all.

TV Recording and Power Plans

If you intend to use the optional TV Tuner to record live TV, then go to the Power
Options control panel and create a power plan (see “Power Plans” on page 3 - 4)
to prevent the power saving options from adjusting the computer’s performance lev-
el.

Remote Control Unit

The remote control unit allows you to remotely start and send the system into a pow-
er saving state, to run Windows Media Center and to navigate the Media Center
menus etc. The remote control unit also gives full control over all TV and video
functions.

. |
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2N
2§

CATV Cable Safety

Make sure that your
CATV system installer
has connected the Co-
axial cable shield to the
grounding system of the
building, as close to the
point of cable entry as
practical.

This reminder is provid-
ed to call the CATV sys-
tem installer's attention
to Article 820-93 of the
NEC (Section 54, Part |
of the Canadian Electri-
cal Code).
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RAID Hard Disks

All hard disks in a RAID
should be identical (the
same size and brand) in

order to prevent unex-
pected system behavior.

Setting Up SATA RAID or AHCI Modes

(RAID Mode is Optional for Model B Computers Only)
AHCI Mode

Advanced Host Controller Interface (AHCI) is an interface specification that allows
the storage driver to enable advanced serial ATA features such as Native Command
Queuing (for maximum hard disk efficiency and performance). AHCI mode can be
supported by one, two or three hard disks.

RAID (Model B Only)

You may use your hard disks (if you have included more than one hard disk in your
purchase option) in combination with Striping (RAID 0) or Mirroring (RAID 1) for
either fault tolerance or performance (see Table 7 - 1, on page 7 - 61). To configure
your system in Striping (RAID 0) or Mirroring (RAID 1) modes you will require two
hard disks installed.

Intel® Matrix Storage Manager

Make sure you install the Intel Matrix driver and application if you have set up your
hard disk(s) in RAID modes (see “Intel Matrix Driver Installation” on page 7 -
65).
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RAID Level Description Table7 -1
Identical drives reading and writing data in parallel to increase performance. RAID 0 RAID Levels
RAID 0 implements a striped disk array and the data is broken into blocks and each block is

written to a separate disk drive.

4

Identical drives in a mirrored configuration used to protect data. Should a drive that is

RAID 1 part of a mirrored array fail, the mirrored drive (which contains identical data) will Array Types
handle all the data. When a new replacement drive is installed, data to the new drive is
rebuilt from the mirrored drive to restore fault tolerance. A Mirrored Array

. . . . ] (RAID 1) provides full
Prepare the following before setting up your serial ATA hard disks in RAID mode data protection, as

(to configure AHCI mode you do not need to prepare any extra hard disks but will data can simply be
need to install the Intel Matrix driver): copied from a healthy
disk to a replacement

1. The Microsoft Windows OS CD. for any failed disk.
2. Asecond (identical) hard disk installed in the secondary HDD bay for RAID level A  Striped  Array
0 or 1 (required for RAID but not required for AHCI). (RAID 0) is NOT fault-
3. The Device Drivers & Utilities + User’s Manual disc. tolerant. The failure of

one drive will result in
the loss of all data in
the array. It is de-
signed to increase disk
performance by
spreading the I/O load
across the channels
and drives.

Setting Up SATA RAID or AHCI Modes 7 - 61



Modules & Options

SATA RAID Setup Procedure (BIOS)

m 1. Start-up your notebook computer and press <F2> to enter the BIOS.
RAID and Ready- 2. Gotothe Advanced menu, select "SATA Mode Selection" and press Enter (see

Drive Compatibility page 5 - 8).

On a system configured  [IRSI M aNaVEN D

in RAID mode, a condi-
T e Y 3. Press Esc and go to the Boot menu.

Cache commands will 4. Set the CD/DVD-ROM Drive (make sure the Microsoft Windows OS CD is
not be sent to the Win- inserted) as the first device in the boot order from the Boot menu.

dows ReadyDrive* 5. Select Exit Saving Changes from the Exit menu (or press F10 and Enter) and
cache provided by In- press Enter to exit the BIOS and reboot the computer.

tel® Turbo Memory. 6. For RAID mode see the instructions in “RAID Setup (Intel Matrix)” on page 7 - 63.

Microsoft has released a
Knowledge Base article
and QFE that addresses
this issue. (http://sup-

port.microsoft.com/
kb/954943).

Intel recommends that
customers who encoun-
ter this issue directly
contact Microsoft to ob-
tain the QFE.
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RAID Setup (Intel Matrix)
1. Press Ctrl +i to enter RAID configuration menu.

Coppeignt (0 200909 Tntel Corpenation. ALL Rights Reserved. Figure 7 - 52
Intel(R) Matrix

Storage Manager
Option ROM

RAID Volumes:
None Defined

Physical Disks:

Port Drive Model Serial # Size Type/Status (Vol ID)
0 FUJITSU MHY2120B K404T812P22B 111.7GB

1 FUJITSU MHY2120B K404T7C2KJ14 111.7GB

[M]-Select [ESC]-Exit [ENTER] -Select Menu

2. Select 1.Create RAID Volume and press Enter.

3. Type the RAID volume name and then press Tab or Enter to advance to the next
field.

4. Specify (use the up and down arrow keys) the RAID level (RAID 0 or RAID 1 see

Table 7 - 1, on page 7 - 61) and then press Tab or Enter to advance to the next

field.

Press Enter and the system will select the physical disks to use.

Press Enter and select (if applicable) the Strip Size (best set to default).

Press Enter and select the Capacity size (best set to default).

Press Enter to select Create Volume.

Press Enter to create the volume, and confirm the selection by pressing V.

© NG
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10. This will now return to the main menu.

Intel (R) Rapid Storage Technology - Option ROM - 9.5.0.1021
Copyright (C) 2003-09 Intel Corporation. All Rights Reserved.

. . Recovery Volume Options
Flgure 7 - 53 2. Delete RAID Volume . Acceleration Options

3. Reset Disks to Non-RAID . Exit
RAID Created

RAID Volumes:
D Name Level Strip Size Status Bootable
[} MyRAID RAIDI1 (Mirror) N/A 111.8GB Yes

Physical Disks:

Port Drive Model Serial # Size Type/Status (Vol ID)
0 FUJITSU MHY2120B K404T812PPG5 111.7GB

4 FUJITSU MHY2120B K404T7C2KJKJ 111.7GB

[MV]-Select [ESC]-Exit [ENTER] -Select Menu

11. Select 6.Exit and press Enter, then press Y to exit the RAID configuration menu.

12. As the computer starts up, press a key when you see the message "Press any
key to boot from CD".

13. Press Enter to continue installing the operating system as normal (see your
Windows documentation if you need help on installing the Windows OS).

14. Install the Windows drivers from the Device Drivers & Utilities + User’s Manual
disc as per Table 4 - 1, on page 4 - 3.

15. After installing all the necessary system drivers you need to install the Intel Matrix
driver (see “Intel Matrix Driver Installation” on page 7 - 65).
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Intel Matrix Driver Installation

1. Make sure you have installed all the necessary drivers from the Drivers Installer /
menu (see Figure 4 - 2 on page 4 - 2).

2. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive e-SATA Port

of the operable computer and click Browse CD/DVD. Install the Intel Matrix
3. Navigate (Browse...) to D:\Others\and double-click the iMXM\iata_cd file. Storage driver to dis-
4. Click Next > Next > Yes > Next > Next. play the safe removal
5. Click Finish to restart the computer. icon for e-SATA devices

. in the taskbar
Intel® Matrix Storage Manager
The Intel Matrix Storage Console displays status information on your RAID con-
figuration. Run the Intel® Matrix Storage Console from the Intel® Matrix Stor-

age Manager in the Programs/All Programs menu. The Intel® Matrix Storage Figure 7 - 54
Manager provides information on the RAID status. Intel Matrix Storage
z Console
| (Basic & Advanced
i e e Views)

==

.|
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Figure 7 - 55
Intel Matrix Storage
Manager Help

If a hard drive member of a RAID volume is reported as “Degraded” or “Failed” it
may be possible to recover the volume. If the volume cannot be restored then you
will need to recreate the RAID volume and restore the data from a back up. The Help
menu (press F1 or select Contents and Index from the Help menu) provides in-
structions on how to recover or recreate RAID Volumes.

/2 C\Program Files (xB6]MinteNintel Matrix Storage Manager\ENU\shell_ ENU.HTML - Windows Intemet Explorer

& C:\Program Files (:86)\InteNlntel Matrix Storage Manager\ENU\shell ENU.HTML

¢ 4 | @ CProgram Files (B6)ntehintel Matrix Storage . | |

INTEL® MATRIX STORAGE MANAGER HELP CONTENTS
Intel® Matrix Storage Console Overview

Basic Mode

Advanced Mode

Menu Bar

Right-Click Menus
Intel® Matrix Storage Manager Overview

Intel Matrix Storage Manager Driver

Event Monitor

Intel Matrix Storage Manager Option ROM
Inte] Matrix Storage Manager Features

Intel® Rapid Recover Technology

RAID Technology

Intel® Matrix RATD Technology

Other Intel Matrix Storage Manager Features
Intel Matrix Storage Manager Information
Intel Mairix Storage Manager Options

Basic Mode - Overview of Actions
Advanced Mode - Overview of Actions
Volume Creation Options
Volme Conversion Options
Volume Capacity Expansion Options
Troubleshooting
System Requirements
Recovery Volimes
RAID Volumes
Technical Support
Glossarv
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RAID Volumes

The instructions in this section apply only to RAID vohimes. If a RAID vohmme is reported as 'De
possible, you must recreate the RAID volume and restore data manually from a back up. Refer tc

FAILED RAID 0 VOLUME

DEGRADED RAID 1 VOLUME

DEGRADED RAID 1 AND FAILED RAID 0 VOLUME (SINGLE RAID ARRAY)
DEGRADED RAID
FAILED RAID 5§
DEGRADED RAID 10 VOLUME
FAILED RAID 10 VOLUME

FAILED RAID 0 VOLUME
A RAID 0 volume is reported as 'Failed' when one of its members fails or is disconnected. If eith:
recovered if a member is disconnected, but cannot be recovered if 2 member has failed.

Missing Member Drive

. Make sure the system is powered off.

Reconnect the missing hard drive.

. Power on the system. During the system startup, the Intel® Matrix Storage Manager optio
Affter the operating system is running, select Intel® Matrix Storage Console from the Start
From the View menn, select 'Advanced Mode' to see a detailed view of device storage inf
. Click on the RAID 0 volme in the device pane to confirm that it is operating normally. The

o Lh B L ko

Failed Member Drive

. Make sure the system is powered off.

. Replace the failed hard drive with a new one that is of equal or greater capacity.

. Power on the system. During the system startup, the Intel Matrix Storage Manager option
user interface.

A Deoce (141 2T tr antar tha WA T MEMTT

LD =
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RAID Volume Data Verification and Repair

The RAID volume data verification process identifies any inconsistencies or bad
data on a RAID 0, RAID 1 or Recovery volume. The table outlines what occurs for
each RAID level:

RAID . . .
Verif Verif Repair
Level erify erify & Repa
RAID 0 Bad blocks are identified. N/A
Bad blocks are reassigned.
Bad blocks are identified.
If the data on the mirrored drive does not Table 7 -2
RAID 1 . L ) e .
Data on the mirrored drive is compared to match the data on the source drive, the RAID Verification &
data on the source drive. data on the mirrored drive is overwritten by R irs
the data on the source. epair Status

See over for details on how to verify and repair RAID volume data.

Replacing and Reverting Recovery and Master Volumes

If a master or recovery drive fails you will need to add a new identical drive and re-
build the recovery volume to the drive. You can also revert the master drive to the
state of the previous volume update. For details on how to do this see “Intel Matrix
Storage Manager Help” on page 7 - 66.
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Verifying and Repairing RAID Volume Data

Run the Intel® Matrix Storage Console from the Intel® Matrix Storage Man-
ager in the Programs/All Programs menu.

Click View > Advanced Mode.

Right-click on the RAID volume and select either Verify Volume Data or Verify
and Repair Volume Data.

1.

2.
3.

Figure 7 - 56
RAID Verification
(Intel® Matrix
Storage Console)

4.
5.

Figure 7 - 57
Verification Status

5 8 InrdR] Makis Sionge Mnnager
2 I ICHOM-C ACHSM £/PCHM SATA RAID Connlar Yerfioation is in progress.
Anage
E‘J Horay 0000 e Ve Ta 1eopen this dialog at any point duiing the
5 Yok e [ verfication, right-click. an the volume whilz in the
b ien M You Advanced Mode of the Intel[F) Maix Storage
oy R: - Moy Velume ook Cac Bt Console and select Show Verlfication Progress.
4D Hay che E
Sl D Volume | RAID 1 parg]
@l | MG —
ok Unsed s e U e S S12Bum 207 Complete - Tiie Remaining: 35 i 36 sec
{ Po Tl Vendy and Repain Velume Dite e 51260
< y
= PoRZUne  Enasle Voyme Wite Back Cache = Deves : —
L=y i b § FLUITSL MHYZ1208H
£ P 3 MATSHTADVE- M LU0R045 i Cvive Mo 1 FLUITSU MHYZ1206H

Parert by oy 000

The verification or verification and repair process will run and display progress.
A dialog box will display the final status of the verification or verification and repair
status.

Verification Status

¥ _,I - Number of verification errors found: 0.

- Mumber of blocks reassigned due to media errors: 0,

@ The verification was completed successfully,
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Chapter 8: Troubleshooting

Overview

Should you have any problems with your computer, before consulting your service representative, you may want
to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This
can’t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these
pages, make sure you have followed the instructions carefully and observed the safety precautions in the preface.
If all else fails, talk to your service representative. You should also make a record of what happened and what
remedies you tried.

Of course, if something goes wrong, it will happen at the most inconvenient time possible, so you should preview
this section just in case. If, after you’ve tried everything, and the system still won’t cooperate, try turning it off
for a few minutes and then rebooting. You will lose any unsaved data, but it may start working again. Then call
your service representative.

. |
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Basic Hints and Tips

Many of the following may seem obvious but they are often the solution to a problem when your computer ap-
pears not to be working.

Power - Is the computer actually plugged into a working electrical outlet? If plugged into a power strip,
make sure it is actually working. Check the LED Power & Communication Indicators (see “LED Indica-
tors” on page 1 - 9) to see the computer’s power status.

Connections - Check all the cables to make sure that there are no loose connections anywhere.

Power Savings - Make sure that the system is not in Hibernate or Sleep mode by pressing the keys config-
ured in your Power Options (see “Power-Saving States” on page 3 - 6), the Fn + F4 key combination, or
power button to wake-up the system.

Brightness - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust the bright-
ness.

Display Choice - Press Fn + F7 to make sure the system is not set to “external only” display.

Boot Drive - Make sure there are no optical media and/or USB storage devices in any connected drive
(this is a common cause of the message “Invalid system disk - Replace the disk, and then press any key” /
“Remove disks or other media. Press any key to restart”).

.|
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Backup and General Maintenance

» Always backup your important data, and keep copies of your OS and programs safe, but close to hand.
Don’t forget to note the serial numbers if you are storing them out of their original cases, e.g. in a CD wal-
let.

* Run maintenance programs on your hard disk and OS as often as you can. You may schedule these pro-
grams to run at times when you are not using your computer. You can use those that are provided free with
your OS, or buy the more powerful dedicated programs to do so.

» Write down your passwords and keep them safe (away from your computer). This is especially important if
you choose to use a Supervisor password for the BIOS (see “Security Menu” on page 5 - 10).

» Keep copies of vital settings files such as network, dialup settings, mail settings etc.(even if just brief notes).

N A
2

Warranty

The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your war-
ranty.
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Viruses

Install an Anti-Virus program and keep the definitions file (the file which tells your program which viruses
to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm
your computer and cause you to lose data. Anti-Virus programs are commercially available and the defini-
tions file updates are usually downloadable directly from the internet.

Be careful when opening e-mail from sources you don’t know. Viruses are often triggered from within e-
mail attachments so take care when opening any attached file. You can configure most Anti-Virus pro-
grams to check all e-mail attachments. Note: You should also beware of files from people you know as the
virus may have infected an address book and been automatically forwarded without the person’s knowl-
edge.

Keep a “Bootable CD-ROM/DVD-ROM/USB storage device” (this CD/DVD/USB device provides basic
information which allows you to startup your computer) handy. You may refer to your OS’s documentation
for instructions on how to make one, and many Anti-Virus programs will also provide such a disk (or at
least instructions on how to make one).
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Upgrading and Adding New Hardware/Software

» Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are
doing, otherwise you will risk severely damaging your system.

» Don’t open your computer or undertake any repair or upgrade work if you are not comfortable with what
you are doing.

* Read the documentation. We can assume, since you are reading this that you are looking at the computer’s
manual, but what about any new peripheral devices you have just purchased? Many problems are caused by
the installation of new hardware and/or software. Always refer to the documentation of any new hardware
and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

* When installing a new device always make sure the device is powered on, and in many cases you will need
to restart the computer. Always check that all the cables are correctly connected.

» Make sure you have installed the drivers for any new hardware you have installed (latest driver files are
usually available to download from vendor’s websites).

.|
Upgrading and Adding New Hardware/Software 8 - 5



Troubleshooting

» Thoroughly check any recent changes you made to your system as these changes may affect one or more

system components, or software programs. If possible, go back and undo the change you just made and see
if the problem still occurs.

» Don’t over complicate things. The less you have to deal with then the easier the source of the problem may
be found; Example - if your computer has many devices plugged into its ports, and a number of programs
running, then it will be difficult to determine the cause of a problem. Try disconnecting all of the devices and
restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and

removing devices and restarting where necessary) will often find the source of a problem, although this may
be time consuming.
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Problems and Possible Solutions

Problem Possible Cause - Solution

You turned on the power but it doesn’t | Battery missing / incorrectly installed. Check the battery bay, make sure the
work. battery is present and seated properly (the design of the battery only allows it to
go in one way). Make sure there’s nothing interfering with the battery contacts.

The battery LED power indicator m is | Low Battery. Plug in the DC power source. If the computer doesn’t start up
blinking orange. immediately, turn it off then on again.

You are losing battery power too quickly. | The system is using too much power. If your OS has a Power Options scheme
(see “Power Plans” on page 3 - 4) check its settings. You may also be using
an ExpressCard/USB device/external device that is drawing a lot of power.

Actual battery operating time is shorter | The battery has not been fully discharged before being recharged. Make sure
than expected. the battery is fully discharged and recharge it completely before reusing (see
“Battery Information” on page 3 - 10).

Power Options have been disabled. Go to the Control Panel in Windows and
re-enable the options.

A peripheral device/USB device/ExpressCard is consuming a lot of power. Turn
off/remove the unused device to save power.

. |
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Problem Possible Cause - Solution

The computer feels too hot. Make sure the computer is properly ventilated and the Vent/Fan intakes are not
blocked. If this doesn’t cool it down, put the system into Hibernate mode or turn
it off for an hour. Make sure the computer isn't sitting on a thermal surface (see
“Overheating” on page 1 - 16). Make sure you're using the correct adapter.

Make sure that your notebook is completely powered off before putting it into a
travel bag (or any such container). Putting a notebook which is powered on in a
travel bag may cause the Vent/Fan intakes to be blocked.

Nothing appears on screen. The system is in a power saving mode. Toggle the sleep/resume key
combination, Fn + F4 (see “Configuring the Power Buttons” on page 3 - 8).

The screen controls need to be adjusted. Toggle the screen control key
combinations Fn + F8/F9. If you're connected to an external monitor, make sure
it's plugged in and turned on. You should also check the monitor’s own
brightness and contrast controls.

The computer is set for a different display. Toggle the screen display key
combination, Fn + F7. If an external monitor is connected, turn it on.

The screen saver is activated. Press any key or touch the TouchPad.

No image appears on the external | You haven't installed the video driver and configured it appropriately from the
monitor | have plugged in and powered | Control Panel. See Appendix B for instructions on installing and configuring
on. the video driver.

. |
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Problem

Possible Cause - Solution

You forget the boot password.

If you forget the password, you may have to discharge the battery of the CMOS.
Contact your service representative for help.

AN
I

Password Warning

If you choose to set a boot password, NEVER forget your password. The consequences of this could be serious. If you cannot
remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.

The sound cannot be heard or the volume
is very low.

The volume might be set too low. Check the volume control in the Volume
Control Panel in the Windows taskbar, or use the key combination Fn + F5 and
F6 (see “Function/Hot Key Indicators” on page 1 - 12) to adjust.

The CD/DVD cannot be read.

The CD/DVD is dirty. Clean it with a CD/DVD cleaner kit.

The CD/DVD tray will not open when
there is a disc in the tray.

The CD/DVD is not correctly placed in the tray. Gently try to remove the disc
using the eject hole (see “Loading Discs” on page 2 - 3).

The DVD regional codes can no longer
be changed.

The code has been changed the maximum 5 times. See “DVD Regional
Codes” on page 2 - 5.

Unwelcome numbers when

typing.

appear

If the LED [T} is lit, then Num Lock is turned ON. (see “LED Indicators” on
page 1-9).
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Problem Possible Cause - Solution

4

Other Keyboards

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will
detect and enable it automatically. However special functions/hot keys unique to the system’s regular keyboard may not
work.

The system freezes or the screen goes | The system’s power saving features have timed-out. Use the AC/DC adapter,
dark. press the sleep (Fn + F4) key combination, or press the power button if no LEDs
are lit.

The system never goes into a power | Power Options features are not enabled. Go to the Windows Power Options

saving mode. menu and enable the features you prefer (see “Power-Saving States” on
page 3 - 6). Make sure you have enabled Hibernate mode from the control
panel.

The  Wireless LAN/Bluetooth/3.5G | The modules are off. Check the LED indicator and/or function key indicator to
modules cannot be detected. see if the WLAN/Bluetooth/3.75G/HSPA module is on or off (see “LED
Indicators” on page 1 - 9). If the LED indicator is off, then press the Fn + F11
(WLAN), Fn + F12 (Bluetooth) or Fn + [ (3.75G) key combination(s) in order
to enable the modules (see “Function/Hot Key Indicators” on page 1 - 12).
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Troubleshooting

Problem

Possible Cause - Solution

The PC Camera module cannot be
detected.

The module is off. Press the Fn + F10 key combination in order to enable the
module (see “Function/Hot Key Indicators” on page 1 - 12). Run the camera
program from the desktop shortcut to view the camera picture.

The Wireless LAN/Bluetooth/ PC
Camera/3.75G/HSPA modules cannot be
configured.

The driver(s) for the module(s) have not been installed. Make sure you have
installed the driver for the appropriate module (see the instructions for the
appropriate module in “Modules & Options” on page 7 - 1).

The transfer of data between the computer and a Bluetooth enabled device is
supported in one direction only (simultaneous data transfer is not
supported). If you are copying a file from your computer to a Bluetooth enabled
device, you will not be able to copy a file from the Bluetooth enabled device to
your computer until the file transfer process from the computer has been
completed

A file cannot be copied to/from a
connected Bluetooth device.
The Bluetooth module is off after

resuming from Sleep.

The Bluetooth module’s default state will be off after resuming from the Sleep
power-saving state. Use the key combination (Fn + F12) to power on the
Bluetooth module after the computer resumes from Sleep.

Problems and Possible Solutions 8 - 11




Troubleshooting

Problem Possible Cause - Solution

The Hibernate function has disappeared. You have a computer with 4GB of RAM and have installed Windows Vista Serv-
ice Pack 1. This is a known issue if your computer has 4GB of RAM and is run-
ning Windows Vista Service Pack 1. To re-enable Hibernate mode go to the
Command Prompt and type the command “powercfg -h on” (make sure you
are logged on as an Administrator):

1. Click Start & (menu button).

2. Type “cmd” in the Start Search box [k 2].

3. Double click the Command Prompt Ecmd when it appears in the
menu.

4. Type “powercfg -h on” in the Command Prompt window.

5. Close the Command Prompt window.

6. The Hibernate function will now be enabled.

. |
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Troubleshooting

Screen Resolution Error

If you are experiencing either screen resolution reduction, or screen flickering after resuming from Sleep in
Windows Vista only then follow the instructions below to fix this problem. This error arises in compliance with
Windows Vista policy, which triggers TMM (Transient Multi-Monitor Manager) when the notebook lid (S3) is
closed. TMM disconnects the LCD display from the OS and then adds the LCD display back when the lid is
opened. This may trigger TMM to restore an old display setting which may result in screen flickering or a screen
resolution change. To fix this problem you will need to disable TMM in the OS:

1. Go to the Control Panel in the Windows OS and double-click the Administrative Tools icon (System and
Maintenance).

2. Double-click Task Scheduler (Schedule Tasks).

O@v | » Comtrol Paned

Calor

Indsing  Iotemet  SCHInitator  Keyboard se  Networkand  NVIDIA
Options  Options Sharing Ce.  Contr..

PE/ Yy S

Offime Files  Parerdal Penand  Prople New Peformance Perensks..  Phore n
Controls  Input Devices Me Informatio.. Modem .

LU L1 Fa N LS

Figure 8 - 1 - Control Panel System and Maintenance
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Troubleshooting

3. Double-click Task Scheduler Library > Microsoft > Windows.
4. Click MobilePC to open the control panel.
5. Right-click TMM and select Disable.

T et =]

File Action View Help

2 i Name Status  Triggers Next Run Time  Last Run Time Last Run Result Autho| |Actions
7% Task Scheduler Library : ‘ e N
2 B Wikt @ Hotstart Ready  Atlog on of any user 1/9/2007 532:21 PM _ The operation completed successfully, (0:0) Micro
= Windows Running At log on of any user PB The task is currently minning, (x41301) I | B Creste Basic Task..

% Create Task...

> Import Task...

[ Display All Running Tasks

| CertificateServicesClient
7 Customer Experience Improv
71 Defrag

1 DiskDiagnostic Properties 9 NewFolder..
. - Delete X Delete Folder
1 Multimedia |6 Refresh

= gl i | ;
] NetworkAccessProtection

@ Hel
General | Triggers | Actions | Conditiens | Settings | History | LB

< RAC Selected ltem -
J RemoteAssistance Name: TMM B Run
1 shel Author: Microsoft Corporation a End
1 SideShow
™ SyncCenter Description: Microsoft Transient Multi-Monitor Manager ¥ Disable
1 SystemRestore Export...
L Tepip
| TextServicesFramework B ipmrens
= Delets
. Security options X Delete
= wot Help
(] Windows Error Reporting When running the task, use the following user account:
I WisdausCaleridar Authenticated Users
1 Wired
=1 Wireless Run only when user is logged on

| Windows Defender )
Run whether user is logged on or not

Do not store password. The task will only have access to local resources

| Run with highest privileges

Figure 8 - 2 - TMM Disable
6. Close all the control panels.
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Interface (Ports & Jacks)

Appendix A: Interface (Ports & Jacks)

Overview

The following chapter will give a quick description of the interface (ports & jacks) which allow your computer
to communicate with external devices, connect to the internet etc.

Item

Description

Cable (CATV)
Antenna Jack

Use this jack to connect a CATV cable if you have included the optional TV Tuner in your
purchase configuration for Model B computers only.

CATV
Card Reader Port The card reader allows you to use some of the latest digital storage cards. Push the card into the
DMMCISD/MS slot and it will appear as a removable device. The card reader allows you to use the following

digital storage cards:

MMC (MultiMedia Card) RS MMC (requires PC adapter)
SD (Secure Digital) Mini SD (requires PC adapter)
MS (Memory Stick) MS Duo (requires PC adapter)

MS (Memory Stick Pro)

Consumer Infrared
Transceiver

The consumer infrared transceiver at the front of the computer allows the computer to
communicate with the remote control unit supplied with the optional TV Tuner for Model B
computers only.

Interface (Ports & Jacks) A- 1




Interface (Ports & Jacks)

Item Description
DC-In Jack Plug the supplied AC/DC adapter into this jack to power your computer.
DVI-Out Port The DVI-Out (Digital Visual Interface) Port (at the rear of the computer) allows you to connect an

|

external monitor, or Flat Panel Display, to allow dual video or simultaneous display on the LCD
and external monitor/FPD (see “Display Devices” on page B - 5). If you are using an older type
of monitor you will need to use a converter to convert the signal from DVI to VGA.

e-SATA Port

eSATA

Plug external Serial ATA hard drives into this e-SATA (external Serial Advanced Technology
Attachment) port.

HDMI-Out Port
HDMI

The HDMI-Out (High-Definition Multimedia Interface) is an audio/video connector interface for
transmitting uncompressed digital streams. This allows you to connect an external monitor, TV or
Flat Panel Display etc. as a display device by means of a HDMI cable. Note that HDMI carries
both audio and video signals (see “HDMI Audio Configuration” on page B - 11).

Headphone-Out Jack

Headphones or speakers may be connected through this jack. Note: Set your system’s volume to
a reduced level before connecting to this jack.

Line-In Jack

»

The Line-In jack allows you to play audio sources through the computer’s speakers. Note that
audio input through Line-in will default to the mute setting. To set up your audio sources to play
through the Line-in jack go to the Sound [ .y control panel and make sure the Mute box is not
ticked. -
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Item

Description

Microphone-In Jack
N

Va

Plug an external microphone in to this jack to record on your computer.

Mini-IEEE 1394 Port

IEEE
1394

This allows high-speed connection to various peripheral devices, e.g. external disk drives and
digital cameras (see note below).

4

IEEE 1394

The Mini-IEEE 1394 port only supports SELF POWERED IEEE 1394 devices. Make sure you
install the Firewire IEEE 1394 driver (see page 4 - 6).

RJ-11 Phone Jack

[

This port connects to the built-in modem. You may plug the telephone line directly into this RJ-11
telephone connection.

RJ-45 LAN Jack

Ba

This port supports LAN (Network) functions.
Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

Security Lock Slot
+3t3

To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be
purchased at any computer store.
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Item

Description

S/PDIF-Out Jack

[]=3.4

This S/PDIF (Sony/Philips Digital Interface Format) Out Jack allows you to connect your DVD-
capable PC to a Dolby AC-3 compatible receiver for “5.1” or ‘dts’ surround sound.

USB 2.0/1.1 Ports

e

These USB 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are for low-speed
peripherals such as keyboards, mice or scanners, and for high-speed peripherals such as
external HDDs, digital video cameras or high-speed scanners etc. Devices can be plugged into
the computer, and unplugged from the computer, without the need to turn the system off (if the
power rating of your USB device is 500mA or above, make sure you use the power supply which
comes with the device).
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NVIDIA Video Driver Controls

Appendix B: NVIDIA Video Driver Controls

The basic settings for configuring the LCD are outlined in “Video Features” on
page 1 - 20. ;ﬁl’;

NVIDIA Video Driver Installation
If you are experiencing

Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 3. screen  resolution  prob-

lems/screen flickering after

1. Insert the Device Drivers & Utilities + User’s Manual disc and click Install resuming from Sleep in

Drivers (bUttOI"I). Windows Vista see page

1. Click 2.Install Video Driver > Yes.
2. Click Next > Next.

3. Click Finish to restart the computer.

Resolution Error

4

Video Card Options

Note that card types, specifications and drivers are subject to continual updates and chang-

es. Check with your service center for the latest details on video cards supported.

NVIDIA Video Driver Installation B - 1



NVIDIA Video Driver Controls
NVIDIA Control Panel

More advanced video configuration options are provided in the NVIDIA Control

4

NVIDIA Control
Panel

To access the Ge-
Force..... control panel
from the desktop; right-
click the desktop, then
click NVIDIA Control

Panel.

View
Sort By
Refresh

Paste
Paste Shortcut

NVIDIA Control Panel

MNew

Es Personalize

FigureB -1
NVIDIA GeForce.....
Control Panel

Panel tab.
1. Open the Display Settings (see page 1 - 21) control panel.
2. Click Advanced Settings (button).
3. Click GeForce..... (tab).
4. Click Start the NVIDIA Control Panel to make any video adjustments.
OR
1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Double-click NVIDIA Control Panel (click "Classic View" from the left of the

menu if you are in Control Panel Home).

& Generic Pl Manitor and NVIDIA GeForce GTX 280M MM.@

Loosang for the NVIDIA Cusplay Control Panel?

A of ihe NVIDIA harve beon te 2 angle
sophcation, the NVIDIA Cortrol Paned, | can be lsunched from the Windows
Cortrol Parl o bry night <licking on Lhe Winduws deskiop.

Keyboad  Mouse

L ¥

Penand  Pecpie Hew
ewces  Me
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The NVIDIA Control Panel provides additional video configuration controls and

NVIDIA Video Driver Controls

Navigating the
Control Panel

Navigate through the
control panels in much
the same way as you
would a web page.
Click on the sub-head-
ing tasks in the left

tools which allow quick access to features such as display configuration, 3D Settings Z
and Help menus etc.
e — o e =
[ o At e s i Peview U [T hange Resaaion —
s

NVIDIA Control Panel B - 3

menu (and on the high-
lighted links) for infor-
mation. Use the
buttons on the top left
to go back, forward
etc.

Figure B - 2
NVIDIA Control
Panels
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The Help menus provide index and search features, and direct links to the NVIDIA
website etc.

SApyIna

T | MVEDIA Contred Panc

Figure B -3
Help Menus

— - &1

——

B - 4 NVIDIA Control Panel



NVIDIA Video Driver Controls

Display Devices

Note that you can use a DVI cable connected to the DVI-Out port, or an HDMI Z

(High-Definition Multimedia Interface) cable connected to the HDMI-Out port to Display Devices
connect an external display (if you are using an older type of monitor you can use @ | gesides the built-in
converter to convert the signal from DVI to VGA). See your display device manual LCD, you can also use

to see which formats are supported. an external monitor/flat
panel display as your
display device. The dis-
play options are:

1. The built-in LCD.
2. An external display connected to the DVI-Out Port.
3. An external display/TV (if the TV supports an HDMI connection) connected to the The built-in LCD.

HDMI-Out Port. An external display
connected to the DVI-
Out port.
\ A/
7&( An external display
. connected to the
Monitor and TV Tuner HDMI-Out port.

Note that HDMI sup-
ports video and audio
signals.

DO NOT use the Fn +
F7 key combination to
toggle through display
options when SLI is en-
abled.

If you are connecting both a monitor/flat panel display to the DVI-Out Port, and a cable/aeri-
al to the optional TV Tuner module, make sure you attach the cable/aerial to the TV Tun-
er first, then the monitor.

Display Devices B - 5
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Attaching Other Displays

Configuring an External Display in Windows Vista

1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.

2. If a New Display Detected window does not appear in Windows Vista, go to the
Windows Mobility Center control panel (Mobile PC > Adjust commonly used
mobility settings) and click Connect display.

3. Click on any of the buttons to configure the displays to your preferences, or click
Display Settings (in the New Display Detected window) to access the control

panel.

(5 Windows Mobility Center

FigureB -4
New Display

¥ Display @ Ll Fully charged % Display
B &) [Dtue 200%) R | connected

Choose the appearance of your display

Detected J | (| Bolanced E |

Battery Status

T

& Duplicate my desktop on all displays (mrored]

e my deskdap play (o )

Shenw ey desktop o the edemal display gnly
To sebect dfferent sestings, g Yuntred Parel.

Turm on Presentaticn Settings

ok | [ Caneel

.|
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Configuring an External Display using the NVIDIA Control Panel

Alternatively you can use the NVIDIA control panel to configure any attached dis-
plays.
Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.

Go to NVIDIA Control Panel (see “NVIDIA Control Panel” on page B - 2).
Double-click Display (if the sub-menus are not visible), and then click Set up

1.
2.
3.

multiple displays.

Any attached display will appear under “1.Select the displays you want to use.”

Figure B-5

B VO Gt Paned
Fle Edt Yiew Profies Dipley Hep

Select & Tack,..

B e s

D sk = @) | [ Advanced Settings =

=i

[],3) Set Up Multiple Displays

Revtore Dofadty

Set Up Multiple
Displays

Attaching Other Displays B - 7



NVIDIA Video Driver Controls

4

Display Not Shown

If the attached display
does not appear in the
“1.Select the displays
you want to use.” win-
dow, click “My Display
is not shown..” and
then click the appropri-
ate button to force de-
tection of the missing
display.

Figure B - 6
Select Display to
Use

o o

8.

Click the tickbox alongside any display you wish to use.

Click Apply > Yes to save the changes.

The default display mode will be in Extended mode (i.e the desktop will be
extended on to the external display - see “Display Devices” on page B - 5), and
you can use the built-in NVIDIA controls (“Enabling Clone Mode” on page B -
9) or New Display Detected (“Attaching Other Displays” on pageB - 6)
window to configure the display.

B8 HVIDRA Cantol Pt =)
Fie fde Yiew Pofies Duply Help

0 Eack v@ Advanced Settings =
e [173; Set Up Multiple Displays.

Restore Detaclts
WADIA rView technolegy slows you 82 B0008y how you woukt e 10 Lse mutple deolay
L Select the desplays you want te use.
GeForce GTX 250M
| Lagnop Desplay
B) Sy TV XV [E]
‘Apply Changes =]
@ Vour desktop configuration has changed
: Would you ke to heep these changes?
1 Verdy your deplay confiquration.

Reverting in 7 seconds

[ e Informaton | ey ] Concel |

If you prefer to use Clone mode see overleaf.
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Enabling Clone Mode

1.
2.
3.

No oA

Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
Go to NVIDIA Control Panel (see “NVIDIA Control Panel” on page B - 2).
Double-click Display (if the sub-menus are not visible), and then click Set up
multiple displays.

Any attached display will appear under “1.Select the displays you want to use.”
Click the tickbox alongside any display you wish to use.

Click Apply > Yes to save the changes.

The default display mode will be in Extended mode, to change to Clone Mode
right-click one of the display icons and click “Clone Laptop Display and....” (a tick
will appear alongside it) option from the pop-up menu and click Apply.

B I ot Pard =)
T e ———

Q vt - D) | [T dvancnd tetiogs - i
= [1.3: Set Up Multiple Displays e

VAo tachrokogy sk you s mpach how jou waid o 1 et haplays

Figure B-7
Enable Clone Mode

1. Select the diuplerys you mant s e

@ Your desktop configuration has changed
; Would you ke to keep these changes?

Reverting in 7 seconds

2. Venty your dnpley contgention.
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8. To switch back to Extended Mode right-click one of the display icons and click
“Clone Laptop Display and....” (to remove the tick) option from the pop-up menu
and click Apply.

[ [P
fde fde Vs Pecfin Dapley Help

Q bk - () | [ ssvances mings =

“Apply Changes =

@ Your desktop configuration has m ged.
y Semy e W\MV like to keep these chany

Figure B -8
Switch to Extended
Mode
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HDMI Audio Configuration

As HDMI (High-Definition Multimedia Interface) carries both audio and video sig-
nals you will need to configure the audio output as per the instructions below. The
settings will depend upon the video card you have installed in your purchase option.

Windows Audio Setup for HDMI

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Sound » (Hardware and Sound).
3. Click Playback (tab), and click to select Realtek Digital Output.
4. Click Set Default (button).
5. Click OK to close the Sound » control panel.
6. You will now be able to hear audio sources when played in Windows Media Player.
e \| Figure B -9
g ) Sound Playback
S;taefaultDevice Options
e |
Properties 'H |
\ -
R ( — i Miger |
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Figure B - 10
HDMI Device
Properties

7.
8.
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HDMI Notes

Connect a device with HDMI support to the HDMI-Out port BEFORE attempt-
ing to play audio/video sources through the device.

If you disconnect the HDMI cable the default audio playback device will not
revert to speakers until the computer is restarted (if you do not wish to restart the
computer then go to the Sound control panel and select Speakers as the default
audio playback device).

HDMI Video Configuration

1.
2.

3.

Connect an HDMI cable from the HDMI-Out port to your external display.
Configure your external display as per the instructions in “Configuring an
External Display using the NVIDIA Control Panel” on page B - 7.

Set up your external display (TV or LCD) for HDMI input (see your display device
manual).

You can now play video/audio sources through your external display.

4

HDMI Audio Support

Note that some NVIDIA video card models DO NOT support High Definition Audio through
HDMI. When connecting these video cards to an external display (using an HDMI cable), it
is recommended that you use a third party video application (e.g. Power DVD) that provides
appropriate audio decoding to play DVDs etc. Alternatively you can output audio through
an alternative source to the HDMI connection.

Attaching Other Displays B - 13
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Other Applications

If you are using a third
party application to play
DVDs etc. you will need
to consult the applica-
tion’s documentation to
see the appropriate au-
dio configuration (the
application must support
digital to analog transla-
tion).
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Display Modes

Single Display Mode
Only one of your displays is used.

SLI Configuration &
Multiple Displays

Note that if SLI configu- Clone Mode

r;tri]‘;rl‘ eis diesnp"’l‘gl/e(:n(;';'yb: Clone Mode simply shows an exact copy of the Primary display desktop on the other
T e el display(s). This mode will drive multiple displays with the same content.

vice.

DO NOT use the Fn + Dualv.lew Mode ) ) )

E7 key combination to = BRELEUYEW Mode (or Extended que in Windows Vista - see overleaf) treats bo'_[h
leleleues TS EVAl  connected displays as separate devices, and they act as a virtual desktop resulting in
CIENERMENESIEREECIE 3 large workspace. When Dualview is enabled, you can drag any icons or windows
oS RRRESIEE  across to the other display desktop. It is therefore possible to have one program vis-

a Single display, and at- . . . . . . . .
tempt?ng té) Zonﬁgure ible in one of the displays, and a different program visible in the other display.

dual displays may cause
an error. Use the NVID-
IA control panel to select
the display to be used.

.|
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Using New Display Detected to Enable Extended Mode

1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. If a New Display Detected window does not appear in Windows Vista, go to the
Windows Mobility Center control panel (Mobile PC > Adjust commonly used
mobility settings) and click Connect display.

Click to select Show different parts of my desktop on each display (extended).
Click Right or Left under Extend your desktop.

Click Apply > OK.

aprw

.)l;J New Display Detected

Choose the appearance of your display

Figure B - 11
Extend your desktop: .
S - New Display
Detected
(Extended)

() Duplicate my deskto mirrored)

@ Show different parts of my desktop on each display (extended)

() Show my desktop on Ihe external display only

To select different settings, go to Display Settings in Contrel Panel.

.|
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Using Display Settings to Enable Extended Mode

4 1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. Click start, and click Control Panel (or point to Settings and click Control

Display Settings
Extended Desktop

Panel).

3. Click Adjust screen resolution under the Appearance and Personalization
Use the control panel to menu (or double-click Personalization > Display Settings).
drag the monitors to 4. Click the monitor icon (e.g. B), and make sure you have checked “Extend the

match the physical ar-
rangement you wish to
use.

You can drag any icons
or windows across to ei-
ther display desktop,
which makes it possible
to have one program
visible in one of the dis-
plays, and a different
program visible in the

desktop onto this monitor.” and click Apply.

Monitor |

& ooy I ==

Drag the icons te match your monitors,

‘ Identify Monitors ‘

2. (Default Monitor) on NVIDIA GeForce GTX 280M

other display. || o Thisis
B | g;solutmn: Colors:
Low [ High [Highest(azbit) v|
Figure B-12 1024 by 768 pixels
Display Settings How do  get the best display? | Aduenced Settings..|
(Extend the o | [ conl | [ oo |

Desktop)

B - 16 Display Modes

Click the appropriate monitor
icon (e.g. A) to be able to select
the option to extend the desktop
on to it.

In this example the Primary mon-
itor @ is on the left, the secondary
display B is on the right.
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Enabling TV Display

To display desktop images on a TV, connect the TV to your computer by using an
HDMI cable/DVI cable from the TV to the HDMI-Out port/DVI1-Out port (if sup-
ported by your TV).

1. You will need to enable the TV display from the NVIDIA Control Panel as per the
instructions on page B - 7. The TV will appear as a display option (“1.Select the
displays you want to use.”) when attached to the appropriate port.

2. Apply the settings, and then click Yes to save the changes.

3. The settings for TV and Video may be adjusted using the sub-menus under Video
& Television.

[ T — 1 v
[T ol

QO et - ) | [T Adurced tumg
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Detect Displays

To get a full range of dis-
play options click “My
Display is not
shown...”

HDMI Audio Setup

See “HDMI Audio Con-
figuration” on page B -
11 for instructions on
configuring audio for
HDMI display devices.

Set up your external dis-
play (TV or LCD) for
HDMI input (see your
display device manual).

Figure B - 13
Video & Television
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Changing the TV Signal or HD Format

1. Whenthe TV is enabled as a display device click the sub-menus under Video &
Television.

2. Click “Select the format you would like to use.”.

Select the TV signal format you would like to use.

4. Apply the settings, and then click Yes to save the changes.

w

Figure B - 14 s a— S
Change the Signal or S
HD Format l_—?,_;-,, Change the Signal or HD Format

courtryapechc sgnal o the HOTV daplay foemst § you s g 87 HOTV

L 2 voa nae.
Sy TV IV
2. Select the coanector you weuld like to use.
L - b dafrton tekeascns - d

3. Select the sigual fsrmat you would Mor o wse.

oty Rorgers Sigrusd Formal
108050 HOTY

Any

Ay 1080024 HOTV

Any 10V050HOTY

Ay TS0 HOTY
Description

The tyzee of cabie hiat conrects the computer 10 the tekevisen

Tyecal Lsage scenaries:
» Vins are: i HOTV st Bt usses i b cokored comporent video output cornvarcton
» Vo HEITV i eyt with 1 DT conraec S ancd you want S s tis higher quality digital conecson
» Tou hve & stanciard tsevison with 5-ides of . 54 af
Brovides better pecture gualty
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Appendix C: Specifications
e

Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/
speeds and CD/DVD device types) may be changed, updated or delayed due to the manufacturer's release schedule. Check
with your service center for details.

.|
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Specifications

Intel® Core i7-820QM Processor:
1.73GHz

45nm (45 Nanometer) Process
Technology, 8M L3 Cache &

FSB 1333MHz - TDP 45W
rPGA988A Package

Intel® Core i7-720QM Processor:
1.6GHz

45nm (45 Nanometer) Process
Technology, 6M L3 Cache &

FSB 1333MHz - TDP 45W
rPGA988A Package

For Model B Only:
Intel® Core i7-920XM Processor:
2.00GHz

45nm (45 Nanometer) Process
Technology, 8M L3 Cache & FSB
1333MHz - TDP 55W

rPGA988A Package

Intel® PM55 Chipset

For Model A Computers:

15.6" HD (1366 * 768) / HD+(1600 * 900)
/ FHD (1920 * 1080) 16:9 Wide Screen
LED Panel

Model B Computers:

17.3” HD+(1600 * 900) / FHD (1920 *
1080) 16:9 Wide Screen LED Backlit
Panel

Two 64-bit Wide DDRIII (DDR3) Data
Channels

Two 204 Pin SO-DIMM Sockets
Supporting DDRIII (DDR3) 1333MHz
Memory Expandable up to 4GB Using
2GB DDRIII Modules

For Model A & B Computers:
nVIDIA® GeForce GTX 280M PCle * 16
Video Card

1GB GDDR3 Video RAM on board
Supports Microsoft DirectX® 10
Supports HDCP

EFor Model A Only:

nVIDIA® GeForce GTX 260M PCle * 16
Video Card

1GB GDDR3 Video RAM on board
Supports Microsoft DirectX® 10
Supports HDCP

One 32Mb SPI Flash ROM
Phoenix™ BIOS

.|
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One Changeable 12.7mm(h) Optical
Device (CD/DVD) Type Drive (see
“Factory Options for All Models” on
page C - 5)

For Model A Computers:

Easy Changeable 2.5" 9.5 mm (h) SATA
(Serial) HDD

For Model B Computers:

Easy Changeable 2.5" 9.5 mm (h) SATA
(Serial) HDD (RAID 0/1 Support)

or 2.5” SATA (Serial) Solid State Drive

High Definition Audio Compliant Interface
3D Stereo Enhanced Sound System
S/PDIF Digital Output

Built-In Microphone

For Model A Computers:

2 * Built-In Speakers

For Model B Computers:

5 * Built-In Speakers (Supporting 2
Channel Stereo)

Full Size WinKey Keyboard

Built-in TouchPad with Multi Gesture
Function

Three Instant Keys (WWW, E-Mail, Silent
Mode)

Four USB 2.0 Ports

One eSATA Port

One IEEE1394a Port
One DVI-I Out Port

One HDMI Out Port
One Headphone-Out Jack
One Microphone-In Jack
One S/PDIF-Out Jack
One Line-In Jack

One RJ-11 Jack

One RJ-45 LAN Jack
One DC-In Jack

For Model B Computers:

Note: External 5.1CH Audio Output
Supported by Headphone, Microphone
and Line-In Jacks

Specifications

Embedded 7-in-1 Card Reader (MS/ MS
Pro/ SD/ Mini SD/ MMC/ RS MMC/ MS
Duo) Note: MS Duo/ Mini SD/ RS MMC
Cards require a PC adapter

One ExpressCard/34/54 Slot

Two Mini-Card Slots (USB/PCle):
Slot 1 for Half Mini-Card WLAN Module
with PCle Interface (Factory Option)

For Model A Computers:
Slot 2 for UMTS/HSPA 3.75G Module with
USB Interface (Factory Option)

For Model B Computers:
Slot 2 for TV Tuner Card with USB
Interface (Factory Option)

Specifications C - 3



Specifications

Built-In 56K Fax Modem V.90 & V.92
Compliant

Built-In 10/100/1000Mb Base-TX Ethernet LAN

Intel® WiFi Link Wireless LAN Module 5300
3*3 802.11 a/g/n Half Mini-Card with PCle
Interface (Factory Option)

3rd Party 802.11b/g/n Half Mini-Card
Wireless LAN Module with PCle Interface
(Factory Option)

Bluetooth 2.1 + EDR (Enhanced Data
Rate) Module with USB Interface
(Factory Option)

2.0M Pixel USB PC Camera Module with
USB Interface (Factory Option)

For Model A Computers Only:
UMTS/HSPDA-based 3.75G Module with
USB Mini-Card Interface (Factory Option)
Quad-band GSM/GPRS (850 MHz, 900
MHz, 1800 MHz, 1900 MHz)

UMTS WCDMA FDD (2100 MHz)

Note that UMTS modes CAN NOT be
used in North America.

C - 4 Specifications

Supports Wake on LAN
Supports Wake on USB
Supports Resume From Modem Ring

Full Range AC/DC Adapter

AC input 100 - 240V, 50 - 60Hz,

DC Output 20V, 6.0A OR 18.5V, 6.5A
Removable Polymer Smart Lithium-lon
Battery Pack, 42.18WH

Security (Kensington® Type) Lock Slot
BIOS Password

Fingerprint Reader Module (Factory
Option)

Windows® Vista (with Service Pack 2)
Windows® 7

Temperature
Operating: 5°C - 35°C
Non-Operating: -20°C - 60°C

Relative Humidity
Operating:
Non-Operating:

20% - 80%
10% - 90%

Model A Computers:

374mm (w) * 263.5mm (d) * 42mm (h)
3.3kg +/- 0.1kg With ODD & Battery
Model B Computers:

412mm (w) * 279mm (d) * 39-48mm (h)
4kg With ODD & Battery

For Model A Computers Only:
UMTS/HSPDA-based 3.75G Module with
USB Mini-Card Interface

For Model B Computers Only:
Hybrid TV Tuner Card with USB Interface




Super Multi Drive ODD Module
Blu-Ray ODD Module

Intel® WiFi Link Wireless LAN Module 5300
3*3 802.11 a/g/n Half Mini-Card with PCle
Interface

3rd Party 802.11b/g/n Half Mini-Card
Wireless LAN Module with PCle Interface

Bluetooth 2.1 + EDR (Enhanced Data
Rate) Module

Fingerprint Reader Module
2.0M Pixel USB PC Camera Module

Specifications
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Windows 7 Information

Appendix D: Windows 7 Information

This Appendix contains information (including control panel information, driver installation etc.) for users of
the Windows 7 OS where there are significant differences from Windows Vista, or where is it helpful to have
essential information or features repeated. For items not specifically covered here see the remainder of the man-
ual for information.




Windows 7 Information

DVD Regional Codes
s

Changing DVD Regional Codes

Go to the Control Panel and double-click Device Manager (System and Security > System), then click the + next to DVD/CD-ROM

drives. Double-click on the DVD-ROM device to bring up the Properties dialogue box, and select the DVD Region (tab) to bring up the
control panel to allow you to adjust the regional code.

DVD region detection is device dependent, not OS-dependent. You can select your module’s region code 5 times. The fifth selection is
permanent. This cannot be altered even if you change your operating system or you use the module in another computer.

Region Geographical Location - =
| Ganacai| EVT Rogion |Valumes | Dover | Desails

MostDVDs ded for pl fic: reg Taph d

1 USA, Canada VD o yout ompar you miet 30 your DVE v 1 oy htcs som o4
regran by 35l82ang A gRographic A2aA fom Ta follewang et

2 Western Europe, Japan, South Africa, Middle East & Egypt CAUTION You can change the rogion a bméed rusmbor of imes
Ahar O 1RBchEs 281D, ange the redgl ifyou
rinstall Windaws or mave your OVD dive 1o 2 dfierent compuar

3 South-East Asia, Taiwan, South Korea, The Philippines, Indonesia, Hong Kong Changes remaining 5
T 18 tha cunrant ragan, sal qeeq aras, and than chek OK

4 South & Central America, Mexico, Australia,

New Zealand Ploheeislan
Aigena
) . . American Samoa

5 N Korea, Russia, Eastern Europe, India & Most of Africa peterl
Aralle = -

6 China Cunentflegan [l Selecled

MewRegiom [
Table D - 1 - DVD Region Codes

D - 2 DVD Regional Codes



Windows 7 Information

Windows 7 Start Menu & Control Panel

Most of the control panels, utilities and programs within Windows 7 (and most other Windows versions) are ac-
cessed from the Start menu. When you install programs and utilities they will be installed on your hard disk
drive, and a shortcut will usually be placed in the Start menu and/or the desktop. Right-click the Start menu

icon [, and then select Properties if you want to customize the appearance of the Start menu.

Stid 4 o .

N T @ n

L e Y o e
| P r > g
B o & - [

iy
o

Click here to t.bgélé .Céte_éo,ry.Vi.ew

2 nor ; " . v v
Properties
l Open Windows Explorer Figure D - 1 - Start Menu & Control Panel
In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features
in Windows (e.g. power, video, network, audio etc.). Windows 7 provides basic controls for many of the features,

however many new controls are added (or existing ones are enhanced) when you install the drivers. To see all
controls it may be necessary to toggle off Category View to view the control panel icons.

Windows 7 Start Menu & Control Panel D - 3



Windows 7 Information

Function/Hot Key Indicators

The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down. In addition
to the basic function key combinations; visual indicators are available when the hot key utility is installed.

Fn Keys Function Fn Keys Function
Fn+~ Play/Pause (in Audio/Video Programs) Fn + F5/F6 Volume Decrease/Increase OQ GQ
At dl T ¢!
3.75G Module Power .
Fn+_ [zi Toggle* Fn+F7 Display Toggle
Fn+F1 Touchpad Toggle Fn + F8/F9 Br|ghtr:ess Decrease/ Q’Q _m
ncrease nmanm / f
Turn LCD Backlight Off PC Camera Power " B = '
Fn+F2 (Press a key to or use TouchPad to turn on) Fn+F10 Toggle on) ~»g &
4 4
Fn+F3 Mute Toggle on ) ) Fn + F11 WLAN Module Power on L | (iore : y
" Toggle ’
4 4 | e 4
En+ E4 Sleep Toggle En+ E12 Bluetooth Module Power I» & 7> @
Toggle A
*Silent Mode Toggle e g *When enabled, Silent Mode will reduce fan noise and save power
99 oo Ko/ consumption. Note this may reduce computer performance.
4 4

Table D - 2 - Function & Hot Key Indicators
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Windows 7 Information

Hot Key Buttons & Keyboard

The LED hot key buttons give instant access to the default Internet browser and e-
mail program, and allow you to toggle Silent Mode with one quick button press.

Hot Key Function

Activate the Default E-Mail Browser (Note that In Windows 7 without Outlook/
Outlook Express installed this button has no function. If Outlook/Outlook Express are
installed then the button will activate the application)

Activate the Default Internet Program

Toggle *Silent Mode (for power saving)

2% G

Table D - 3 - LED Hot Key Buttons
*When enabled, Silent Mode will reduce fan noise and save power consumption.
Note this may reduce computer performance.

4

Special Characters

Some software applications allow the number-keys to be used with Alt to produce special characters.
These special characters can only be produced by using the numeric keypad. Regular number keys (in
the upper row of the keyboard) will not work. Make sure that NumLKk is on.

Hot Key Buttons & Keyboard D - 5

4

Other Keyboards

If your keyboard is
damaged or you just
want to make a
change, you can use
any standard USB key-
board. The system will
detect and enable it
automatically. Howev-
er special functions/
hot-keys unique to the
system’s regular key-
board may not work.

NumLk & ScrLk

Hold down the Fn Key
and either NumLk or
ScrLk to enable num-
ber or scroll lock, and
check the LED indica-
tor for status.



Windows 7 Information

Video Features

You can configure display options from the Display control panel in Windows, and from the NVIDIA Control
Panel as long as the appropriate video driver is installed. For more detailed video information see “NVIDIA

Video Driver Controls” on page B - 1. o ;
Sort b 3

To access Display (Control Panel) and Screen Resolution in Windows: !

1. Click Start and click Control Panel. Paste

2. Click Display (icon) - In the Appearances and Personalization category. Paste shartcut

3. Click Adjust Screen Resolution/Adjust resolution. New b

OR | B8 Screen resolution

4. Alternatively you can right-click the desktop and select Screen resolution (see right). & Gedosts

5. Use the dropbox to select the screen Resolution @ (Figure D - 2 on page D - 7). & Pesenafie

6. Click Advanced settings @ (Figure D - 2 on page D - 7) to bring up the Advanced properties tabs.

To access the NVIDIA Control Panel:

1. Click Start, and click Control Panel.

2. Click NVIDIA Control Panel @ (Figure D - 3 on page D - 8) - In the Appearances and Personalization
category.

OR

3. Click Start and click All Programs > NVIDIA Corporation.

4. Click to select NVIDIA Physx Properties @ (Figure D - 3 on page D - 8) .

OR

5. Click Advanced settings in the Screen Resolution control panel in Windows.

6. Click GeForce....(tab) and click Start the NVIDIA Control Panel 6 (Figure D - 3on page D - 8).

D - 6 Video Features



Screen Resolution

Windows 7 Information

Besides the built-in LCD, you can also use an external VGA monitor (CRT)/external Flat Panel Display as

your display device.

o
@U"ﬂ“ « Appearance and Personalization » Display » Screen Resolution

Change the appearance of your display

- |¢-,| | Search Control Panel

Identify

Display: 1. Mobile PC Display = l

Resolution: [1600 = 900 [recommended) v]

Connect to a projector [or press the & key and tap P)
Make text and other items larger or smaller

What display settings should I choose?

Advanced settings

Figure D - 2 - Screen Resolution

4

Video Options

Note that card types, specifications
and drivers are subject to continual
updates and changes. Check with
your service center for the latest de-
tails on video cards supported.

Video Features D - 7



Windows 7 Information

NVIDIA Control Panel
Besides the built-in LCD, you can also use an external VGA monitor (CRT)/external Flat Panel Display as

your display device.

1=/ + ControtPana » 48 Cortoet Pt s +

Adjust your computer's settings

WY action Center

§io Administrative Tools

ak Backup and Restore

@) Credential Mansger ]

_‘a Desvice Manager
D 5se of Access cemer

5 Geting started

) wnsenet Options

Date and Time
W Destaop Gadgess
B oty
h Fams.

s Indexing Options

Py Location and Other
3

=3 Sersors
[ Metification Area lcons

* Parental Conrols

- i

. Perfarmance I| =

and Toals

% BitLocker Drive Encryplicn

W Autoblay

-.,; Color Managernent
o Debsult Progeams
iy Devices and Printers
[E Folder options

1,& HereGroup

- Keyboard

Metwork and Sharing
Center

D - 8 Video Features

‘ @ Default Programs
| @ Desktop Gadget Gallery
& Intemet Explorer
@) Windows DVD Maker
5 Windows Fax and Scan
 Windows Media Center
@ Windows Media Player
Ej' Windows Update
- XP5 Viewer
. Accessories
| Games
. Intel® Matrix Storage Manager
. Maintenance
. NVIDIA Corporation

1 NVIDIA PhysX Properties

| Startup

1  Back

o

Search programs a

o

Documents
Pictures

Music

Games

Computer

Control Panel
Devices and Printers
Default Programs

Help and Support

& Generic P Manitar and NVIDIA GeForoe GTX Z80M _ Proper. S|

e | Troudleshoot |
X GrFoeon GTX 281N

Logkang for the NVIDIA Drsplay Control Panel?

A2 of the MVIDILA h te 2 gl
aophcation, the NVIDIA Cortrol Panel. & can be lsunched from the Windows:
Cortrel Parml or by nightcbching on Lhe Winduws deskiog.

Figure D - 3 - NVIDIA Control Panel



Attaching Other Displays

Configuring an External Display in Windows 7
1. Attach your external display to the external monitor port/HDMI-Out port and turn it on.
Go to the Screen resolution control panel.

2.
3. Click the Detect button.
4,

The computer will then detect any attached displays.

Windows 7 Information

1024 =768  +

Display: 1]2. Multiple Menitors ~
Resolution:
Orientation: Landscape -

Multiple displays: |Duplicate these displays =

This is currently your main display. Advanced settings

Connect te 2 projecter (or press the &Y key and tap P)
Make text and other items larger or smaller

What display settings should I choose?

. —-
@Qv’i RIDEPE SR hton ~ [ 9 || Seorch Controt Pane! 2|
Change the appearance of your display M
G
-

il

Figure D - 4 - Screen Resolution - Multiple Displays

Video Features D - 9



Windows 7 Information

5. You can configure the displays from the Multiple Displays menu.

Display: 1]2. Multiple Monitors =

Resolution: 1024768
Orientation: Landscape -

)

Multiple displays: ffuplicate these displays

Duplicate these displays
This is currentlylro Extend these displays
Show desktop only on 1
Connect to a projecgoW desktop only on2_/4ap p)

Make text and other items larger or smaller

What display settings should I choose?

[ECancel ] [ el

Advanced settings

. -
@Qvﬁ « Display b Screen Resolution .|¢,|'\' Search Control Pane! 2|
Change the appearance of your display
-

Figure D - 5 - Screen Resolution - Multiple Display Options

» Show desktop only on 1/2 - Only one of your displays is used.

Duplicate these displays - Shows an exact copy of the main display desktop on the other display(s)
Extend these displays - Treats both connected displays as separate devices

See “Attaching Other Displays” on page B - 6 for more details on the above modes when using the NVIDIA
driver to configure attached displays.

D - 10 Video Features



Windows 7 Information

The Power Sources

The computer can be powered by either an AC/DC adapter or a battery pack. Z
Silent Mode
AC/DC Ad apter Use the W key to tog-

Use only the AC/DC adapter that comes with your computer. The wrong type of AC/ | dle Silent Mode to re-

DC adapter will damage the computer and its components. CUED (2D SIS ENE S
power consumption.

1. Attach the AC/DC adapter to the DC-in jack at the rear of the computer. Note this may reduce

2. Plug the AC power cord into an outlet, and then connect the AC power cord to the || COmPuter performance.
AC/DC adapter.

3. Raise the lid/LCD to a comfortable viewing angle.

4. Press the power button to turn “On”.

Battery

The battery allows you to use your computer while you are on the road or when an
electrical outlet is unavailable. Battery life varies depending on the applications and
the configuration you're using. To increase battery life, let the battery discharge
completely before recharging (see “How do I completely discharge the battery?”
on page D - 23).

We recommend that you do not remove the battery. For more information on the bat-
tery, please refer to “Battery Information” on page D - 19.

The Power Sources D - 11
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4

Forced Off

If the system “hangs”,
and the Ctrl + Alt + Del
key combination doesn’t
work, press the power
button for 4 seconds, or
longer, to force the sys-
tem to turn itself off.

Power Button as
Stand by or
Hibernate Button

You can use the OS’s
“Power Options” control
panel to set the power
button to send the sys-
tem into Stand by or Hi-
bernate mode (see your
OS’s documentation, or
“Configuring the Pow-
er Buttons” on page D
- 17 for details).

Turning On the Computer

Now you are ready to begin using your computer. To turn it on simply press the pow-
er button on the front panel.

When the computer is on, you can use the power button as a Stand by/Hibernate/
Shutdown hot-key button when it is pressed for less than 4 seconds (pressing and
holding the power button for longer than this will shut the computer down). Use
Power Options in the Windows control panel to configure this feature.

4

Shut Down

Note that you should always shut your computer down by choosing the Shut Down com-
mand from the Lock Button Menu in Windows 7. This will help prevent hard disk or system
problems.

Switch user

Default Program| Log off

Lock

Help and Suppol

Restart

Sleep

Hibernate

D - 12 Turning On the Computer



Power Plans

Windows 7 Information

The computer can be configured to conserve power by means of power plans. You
can use (or modify) an existing power plan, or create a new one.

The settings may be adjusted to set the display to turn off after a specified time, and
to send the computer into Sleep after a period of inactivity.

Click Change plan settings and then click Change advanced power settings to ac-
cess further configuration options in Advanced Settings.

" = Al Contici Panel eens + Fowsr Options » £dit Plan Seftings

Change settings for the plan: Balanced

§ oy

Chaocse the skeep and display settings that you want your computer 16 &

e,

A Prggedin

|5 mites

* |10 miewtes

* |30 miewtes.

Advanced selbngs

Select the power plan that you want to customize, and

; then choose settings that reflect how you want your
computer lo manage power.

W

urrently unavailable
Balanced [Active] -

Balanced
Require a password on wakeup
Flugged in: Yes =
& Hard disk
L f Desktop background settings

Wireless Adapter Settings
i ¥ Sleep
& USE settings

# Power buttons and lid

Restore plan defaults

[ox || conn

4

Resuming
Operation

See TableD - 4, on
page D - 18 for informa-
tion on how to resume
from a power-saving
state.

Password

It is recommended that
you enable a password
on system resume in or-
der to protect your data.

FigureD - 6
Power Plan
Advanced Settings

Power Plans D - 13
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Figure D -7
Power Plans

Each Windows power plan will also adjust the processor performance of your ma-
chine in order to save power. This is worth bearing in mind if you are experiencing
any reduced performance (especially under DC/battery power).

Choose High performance (you may need to click Show additional plans to view
the High performance plan) for maximum performance when the computer is pow-
ered from an AC power source. Choose the Power saver (bear in mind that this
scheme may slow down the overall performance of the computer in order to save
power) for maximum power saving when the computer is battery (DC power) pow-
ered.

"# » Control Panel + All Control Panel Jtems » Power Options

Click to Show/Hide | = =" sespaern

additional
power plans\

@ Balanced (r: nded)

Automatically balances porfarmance with energy consumgtion on capable harcware.

ing your computer’s performance where possible.

Sereen biightness: @

D - 14 Power Plans
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Power-Saving States

You can use power-saving states to stop the computer’s operation and restart where you left off. Sleep is the
default power-saving state in Windows 7.

Earlier versions of Windows used Stand By and Hibernate as system power-saving states. Windows 7 combines
the features of Stand By and Hibernate into the default Sleep power-saving state.

Sleep

In Sleep all of your work, settings and preferences are saved to memory before the system sleeps. When you are
not using your computer for a certain length of time, which you specify in the operating system, it will enter
Sleep to save power.

The PC wakes from Sleep within seconds and will return you to where you last left off (what was on your desk-
top) without reopening the application(s) and file(s) you last used.

If your mobile PC in Sleep is running on battery power the system will use only a minimum amount of power.
After an extended period the system will save all the information to the hard disk and shut the computer down
before the battery becomes depleted.

.|
Power-Saving States D - 15
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Figure D - 8
Lock Button Menu

Hibernate

Hibernate uses the least amount of power of all the power-saving states and saves
all of your information on a part of the hard disk before it turns the system off. If a
power failure occurs the system can restore your work from the hard disk; if a power
failure occurs when work is saved only to memory, then the work will be lost. Hi-
bernate will also return you to where you last left off within seconds. You should
put your mobile PC into Hibernate if you will not use the computer for a period of
time, and will not have the chance to charge the battery.

Shut down

You should Shut down the computer if you plan to install new hardware (don’t for-
get to remove the battery and follow all the safety instructions in Chapter 6), plan to
be away from the computer for several days, or you do not need it to wake up and run
a scheduled task. Returning to full operation from Shut down takes longer than from
Sleep or Hibernate.

Switch user
Default Program Log off
Lock
Help and Suppol
Restart

f— : Sleep
»
l Hibernate

D - 16 Power-Saving States
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Configuring the Power Buttons

The power/sleep button (Fn + F4 key combo) and closed lid may be set to send the computer in to a power-
saving state. Click Choose what the power buttons do on the left menu in Power Options to bring up the menu.

/ ‘,; « Power Options » System Settings ~ | +¢ W Search Control Panel o)

Password Protection

Define power buttons and turn on password protection

Choose the power settings that you want for your computer. The changes you make to the settings on this
page apply to all of your power plans.

It is recommended that you
enable a password on wake p e
. Paower and sleep buttons and lid settings
up in order to protect your j
On battery

data. ,-’ Plugged in

@ When I press the power button: [Sleep '1 lSIeep vl
Do nothing

However you can disable

thlS Settlng from the Power @ When I press the sleep button: Hnate Sleep
Shut down

Options menu by clicking f‘ When I close the lid: |Sleep <1 [Sleep -

Require a password on
wakeu p in the left menu, Password protection on wakeup
and Selecting the OptiOI’lS & Change settings that are currently unavailable

. . (@ Require a password (recommended)
(CIICK Ch an ge setti n_gs th at When your computer wakes from sleep, no one can access your data without entering the correct
are cu rrently unavailabl e)_ password to unlock the computer. Create or change your user account password

Don't require a password
‘When your computer wakes from sleep, anyone can access your data because the computer isn't
locked.

FigureD -9
Power Options Define
POWGI’ BUttOI’]S Save changes Cancel a

.|
Configuring the Power Buttons D - 17
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Resuming Operation

You can resume operation from power-saving states by pressing the power button, or in some cases pressing the

sleep button (Fn + F4 key combo).

Power Status

lcon ~/(!) Color

To Resume

Orange (AC/DC adapter)

Power Off Off Press the Power Button
Press the Power Button
Sleep Blinking Green
Press the Sleep Button (Fn + F4 Key Combo)
Off (battery)
Hibernate Press the Power Button

Display Turned Off

Green

Press a Key or Move the Mouse/Touchpad

4

Power Button

When the computer is on, you can use the power button as a Sleep/Hibernate/Shut Down
hot key button when it is pressed for less than 4 seconds (pressing and holding the power
button for longer than this will force the computer to shut down).

D - 18 Configuring the Power Buttons

4

Closing the Lid

If you have chosen to
send the computer to
Sleep when the lid is
closed, raising the lid
will wake the system up.

TableD -4
Resuming
Operation
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Battery Information
Follow these simple guidelines to get the best use out of your battery.

Battery Power

Your computer’s battery power is dependent upon many factors, including the pro-
grams you are running, and peripheral devices attached. You can set actions to be
taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from
power plan Change plan settings > Change advanced power settings (see Figure
D - 6 on page D - 13).

Click the battery icon (& in the taskbar to see the current battery level and charge
status.

=)

E 81% remaining || Advancadssmacn
Select the power plan that you want 1o customize,

v
; &nd then ehocse settings that reflect how you wast
' your computer to

Select a power plan:

@ Balanced

(7)) Power saver

# Desklop background settings
i Wireless Adapter Settings

+ Sleep

# LSS settings

& Pt buittrne aned il

Adjust screen brightness
Maore power options

Bewore plan defaults

[ ][ Comem

Low Battery
Warning

When the battery is criti-
cally low, immediately
connect the AC/DC
adapter to the computer
or save your work, oth-
erwise, the unsaved
data will be lost when
the power is depleted.

Figure D - 10
Battery Icon
(Taskbar) & Battery
Advanced Settings
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4

Windows Mobility
Center

The Windows Mobility
Center control panel
provides an easy point
of access for information
on battery status, power

Conserving Battery Power

Use a power plan that conserves power (e.g Power saver), however note that
this may have an affect on computer performance.

Lower the brightness level of the LCD display. The system will decrease LCD
brightness slightly to save power when it is not powered by the AC/DC adapter.

Reduce the amount of time before the display is turned off.

Close wireless, Bluetooth, modem or communication applications when they are

plans used and wireless

not being used.
device status etc.

» Disconnect/remove any unnecessary external devices e.g. USB devices,

ExpressCards etc.

98 Windows Mobility Center [ [ e |
Figure D _ 11 & 2‘,5;1?"):655 ¢ _"‘fW | Mute jl 71% remaining g Wireless off
WlndOWS MObIlIty U U Balanced irn wireless on
Center

Brightness

No display
S connected

®

Volume

No sync
partnerships

Battery Status

@g@ Not presenting

Connect display

J| |

Sync settings

J|

Turn on

External Display

Sync Center

Presentation Settings

Wireless Network

€
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Battery Life
Battery life may be shortened through improper maintenance. To optimize the life and improve its perfor-
mance, fully discharge and recharge the battery at least once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to remove the battery for any reason
(e.g. long term storage) see “Removing the Battery” on page 6 - 3.

New Battery
Always completely discharge, then fully charge, a new battery (see “Battery FAQ” on page D - 23 for instruc-
tions on how to do this).

Recharging the Battery with the AC/DC Adapter

The battery pack automatically recharges when the AC/DC adapter is attached and plugged into an electrical out-
let. If the computer is powered on, and in use, it will take several hours to fully recharge the battery. When the
computer is turned off but plugged into an electrical outlet, battery charge time is less. (Refer to “LED Indica-
tors” on page 1 - 9 for information on the battery charge status, and to “Battery Information” on page D - 19
for more information on how to maintain and properly recharge the battery pack.)

.|
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Proper handling of the Battery Pack

7[:1: *DO NOT disassemble the battery pack under any circumstances
Gl *DO NOT expose the battery to fire or high temperatures, it may explode

*DO NOT connect the metal terminals (+, -) to each other
Danger of explosion if
battery is incorrectly re-
placed.

AN
I

Damaged Battery Warning

Replace only with the
same or equivalent type
recommended by the
manufacturer. Discard
used battery according
to the manufacturer’s in-
structions.

Should you notice any physical defects (e.g. the battery is bent out of shape after being
dropped), or any unusual smells emanating from the notebook battery, shut your computer

down immediately and contact your service center. If the battery has been dropped we do
not recommend using it any further, as even if the computer continues to work with a dam-
aged battery in place, it may cause circuit damage, which may possibly result in fire. It is
recommended that you replace your computer battery every two years.

.|
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How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t turn off the computer even

if a message indicates the battery is critically low, just let the computer use up all of the battery power and shut

down on its own.

1. Save and close all files and applications.
2. Create a power plan for discharging the battery and set all the options to Never.
3. Click Change plan settings (after creating it) and click Change plan settings > Change advanced power

settings.

Sl # = P Cpsons b Lkt Fuan Settege

el F = A Cremi Pavel Baerra ¢ Poome Opsiomn.

Sl 7 = Power Optom b it Pas Sertrgs

Windows 7 Information

Figure D - 12 - Create Power Plan - Discharge Battery
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4. Scroll down to Battery and click + to expand the battery options.
5. Choose the options below (click Yes if a warning appears):

(53 rover ooy R T T | | [ rover cpion WS ) e
Advanced setiings Advanced setiings /
\ Select the power plan that you want to customize, \ 5~ Selectthe power plan that you want to customize, B attery Ch arg | n g &
and then choose settings that reflect how you want P and then choose settings that reflect how you want g
= your computer to manage power. = your computer to manage power. Mal nten ance
% Change settings that are currently unavailable % Change settings that are currently unavailable
?
[Discharge Battery [Active] - [Discharge Battery [Active] - How do | fully charge the battery
When charging the battery, don’t sto
# Multimedia settings = Plugged in: 5% = N g g . . ry’. . p
= Battery = Low battery natification until the LED charging indicator light
(= Critical battery action On barter_y: Off ChangeS from Orange to green_
On battery: Shut down Plugged in: Off

[= Low battery action

On baﬂery:' Do nothing ™

Plugged in: Do nathing
= Low battery level

(|

On battery (%): _ = Plugged in: Do nothing \j HOW do | maintain the battery?
Plugged in: 0% & Reserve battery level (3 Completely discharge and charge the
= Criti On battery: 0%
. (mf:'hgifi?jli:e' . 7 S i ‘ - battery at least once every 30 days or
| il ' : <l U : after about 20 partial discharges.
Restore plan defaults Restore plan defaults
[ ok |[ cancer ][ apoy | [ ok [ camcel |[ appy |

Figure D - 13 - Power Options Advanced Settings - Battery

* Low battery levels = 0%

« Critical battery Levels = 0%

* Low battery action = Do Nothing

« Critical battery action (On battery) = Shut Down
* Critical battery action (Plugged in) = Do Nothing
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Driver Installation

Insert the Device Drivers & Utilities + User’s Manual
disc, click Install Drivers/Option Drivers (button) and
then click the appropriate driver name from the Drivers
Installer menu. Follow the instructions to install the
driver. Alternatively click Start, navigate (Browse..) to
the executable file and then follow the manual setup in-
structions.

Figure 5 - Drivers Installer Screen 1

Windows 7 Information

1. Check the driver installation order from Table D - 5 (the

drivers must be installed in this order) which is the
same as that listed in the Drivers Installer menu
below.

2. Click to select the driver you wish to install, after
installing each driver it will become greyed out (if you
need to reinstall any driver, click the Unlock button).

3. Follow the instructions for each individual driver
installation procedure as listed on the following pages.

Figure 6 - Drivers Installer Screen 2

Driver Installation D - 25




Windows 7 Information

Windows 7 Drivers Page # Windows 7 Drivers Page #
Chipset Page D - 28 PC Camera Module (Win7) Page D - 36
Video Page D - 28 Wireless LAN Module (Win 7) Page D - 30
Audio Page D - 29 Fingerprint Reader Module (Win7) Page D - 30
Modem Page D - 28 3.75G/HSPA Module (Win 7) (Model A Only) | Page D - 52
LAN Page D - 28 TV Tuner Module (Model B Only) Page 7 - 58
Firewire (EEE 1394) | Page D - 28 f’;:ligﬂomig;g%ﬁﬁor AHCI Modes Page 7 - 60

CardReader Page D - 28
TouchPad Page D - 28
Hot Key Page D - 29
Audio Page D - 29

Table D - 5 - Driver Installation

. |
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Updating/Reinstalling Individual Drivers

If you wish to update/reinstall individual drivers it may
be necessary to uninstall the original driver.To do this go
to the Control Panel in the Windows OS and double-
click the Programs and Features item (Programs >
Uninstall a program). If you see the individual driver
listed (if not see below), uninstall it, following the on
screen prompts (it may be necessary to restart the com-
puter). Go to the appropriate section of the manual to
complete the update/reinstall procedure for the driver in
guestion.

If the driver is not listed in the Programs and Features

item:

1. Click Start and click Control Panel.

2. Double-click System (icon); System (icon) is in
System and Security (category).

3. Click Device Manager (in the left menu).

4. Double-click the device you wish to update/reinstall the
driver for (you may need to click “+").

5. Look for the Update Driver button (check the Driver
tab) and follow the on screen prompts.

Windows 7 Information

4

Driver Installation General Guidelines

The driver installation procedure outlined in this
Chapter are accurate at the time of going to press.

Drivers are always subject to upgrade and revision
so the exact procedure for certain drivers may differ
slightly. As a general guide follow the default on
screen instructions for each driver (e.g. Next > Next
> Finish) unless you are an advanced user. In many
cases a restart is required to install the driver.
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Driver Installation Procedure

Insert the Device Drivers & Utilities + User’s Manual
disc and click Install Drivers (button).

Chipset

1. Click 1.Install Chipset Driver > Yes.
2. Click Next > Yes > Next > Next.

3. Click Finish.

Video

1. Click 2.Install Video Driver > Yes.
2. Click Next > Next.
3. Click Finish to restart the computer.

Modem

1. Click 3.Install Modem Driver > Yes.

2. Click OK.

3. The modem is ready for dial-up configuration.

LAN

1. Click 4.Install LAN Driver > Yes.

2. Click Next > Install.

3. Click Finish.

4. The network settings can now be configured.

Firewire (IEEE 1394)
1. Click 5.FireWire drivers > Yes.

2. Click Install.

3. Click Finish.

CardReader

1. Click 6.Install Cardreader Driver > Yes.

2. Click Install.

3. Click Finish.

TouchPad

1. Click 7.Install Touchpad Driver > Yes.

2. Choose the language you prefer and click OK.
3. Click Next > Finish.

e

Click Restart Now to restart the computer.
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Hot Key Optional Drivers
1. Click 8.Install Hotkey Utility > Yes. See the pages indicated for the driver installation pro-
2. Click Next > Next. cedures for any modules included in your purchase op-

3. Click Finish > Finish to restart the computer. ~ tion. Where Windows 7 information differs from
Windows Vista it will be included in this chapter; if
Audio Windows 7 information is the same as Windows Vista
. . . then refer to Chapter 7 as indicated on the following

1. Click 9.Install Audio Driver > Yes.

) page.
2. Click Next.
3. Click Finish to restart the computer.

) Drivers Installer

P e 'g,‘l\/liobﬂ_e C‘Ei_i}mutin -
Note that after installing the audio driver the system B e e—
will not return to the Drivers Installer screen. To in- Ca

stall any of the optional drivers listed overleaf, eject
the Device Drivers & Utilities + User’s Manual disc
and then reinsert it (or double-click the disc icon in My
Computer), and click Option Drivers (button) to ac-
cess the optional driver menu.

Figure D - 1 - Drivers Installer - Option Drivers Menu ﬂ
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Bluetooth Module (Win 7)

Note: The operating system is the default setting for
Bluetooth control in Windows 7, and does not require
a driver. See “Bluetooth Module (Win 7)” on page D
- 31 for configuration instructions.

PC Camera Module (Win 7)

See “PC Camera Module (Win 7)” on page D - 44 for
driver installation and configuration information.

Wireless LAN Module (Win 7)

See the specific Windows 7 driver installation and
configuration information in “Wireless LAN Module
(Win 7)” on page D - 42.

Fingerprint Reader Module (Win 7)

See the introduction in “Fingerprint Reader Module
(Win7)” on page D - 48, and check the installation
procedure.

3.75G/HSPA Module (Win 7 - Model A
Only)

See the introduction in “3.75G/HSPA Module (Win
7)” on page D - 52, and check the installation proce-
dure.

TV Tuner Module (Model B Only)

See the introduction in “TV Tuner Module” on page 7
- 57, and check the installation procedure for the Con-
sumer Infrared (CIR) driver.

RAID and AHCI Configuration

(RAID for Model B Only)

See the configuration instructions in “Setting Up
SATA RAID or AHCI Modes” on page 7 - 60. The In-
tel Matrix driver is required to support hard disk in
RAIN or AHCI modes (see “Intel Matrix Driver In-
stallation” on page 7 - 65).
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Bluetooth Module (Win 7)

\ A/
The operating system’s Bluetooth Devices control panel is used to configure the . ’Ll\ .
Bluetooth settings in Windows Vista, and therefore does not require a driver. Use the Wireless Device
Fn + F12 key combination (see “Function/Hot Key Indicators” on page D - 4) to i et et
toggle power to the Bluetooth module. When the Bluetooth module is powered on, Alfcrait

the ¢ LED will be illuminated and the on-screen indicator will briefly be displayed. iSRG AL ENE
electronic transmission de-

vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if

4

Bluetooth Data Transfer

you are using the computer
aboard aircraft.

Note that the transfer of data between the computer and a Bluetooth enabled device is sup-
ported in one direction only (simultaneous data transfer is not supported). Therefore
if you are copying a file from your computer to a Bluetooth enabled device, you will not be
able to copy a file from the Bluetooth enabled device to your computer until the file transfer
process from the computer has been completed.

Use the Fn + F12 key com-
bination to toggle power to
the Bluetooth module, and
check the LED indicator to
see if the module is pow-
ered on or not (see

/

).

Bluetooth Module & Resuming From Sleep Mode

The Bluetooth module’s default state will be off after resuming from the Sleep power-saving
state. Use the key combination (Fn + F12) to power on the Bluetooth module after the com-
puter resumes from Sleep.
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Bluetooth Configuration in Windows Vista

el | Setup your Bluetooth Device so the Computer Can Find it

Add a Device 1. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on.

2. Make the device discoverable (to do this check your device documentation).
Click Start, and click

Control Panel and then | To Turn the Bluetooth Module On
click ~ Devices and § 1 Ppressthe Fn + F12 key combination to power on the Bluetooth module.
Printers  (Hardware | 5 A Bjyetooth icon J will appear in the taskbar.

ane Spund). Cligk &2l 3. You can then do any of the following to access the Bluetooth Devices control
a device to search for panel

any available Bluetooth
devices. +  Double-click the taskbar icon EJ to access the Bluetooth Devices control panel.
«  Click/Right-click the taskbar icon gg and choose an option from the menu.

= L Add 2 Device
[\ | o Devices and Printess » Bluetooth Devices « | 43 | Search Devices and Printens a L . _
B - = Allow a Device to Connect
A Addadeoce A a prntes - @
Flgure D - 2 I Show Bluetooth Devices
Bluetooth Devices & Send a File
Click Icon Menu Receive a File
Jaoin a Personal Area Network
0 Rems
et
ﬁ'!.f Open Settings
¥ .
Add a device Remove Icon

7/14/2009

Right-Click Taskbar Icon EJ
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To Add a Bluetooth Device

1. Access the Bluetooth Devices control panel and click Add a device.
2. Double-click the device you want to pair with the computer.

. =)

() I Addadevice

Select a device to add to this computer

Windows will continue to lock for new devices and display them here,

=] W35 - Phone Memory Y
e Bluetooth b Bluetooth
l i) Phone i, Phone

What if Windows doesn't find my device?

3. Onfirst connection the computer will provide you with a pairing code to be entered
onto the device.

Bluetooth Module (Win 7) D - 33

4

Pairing Options

If a device has been pre-
viously connected then
the pairing option menu
will appear when you at-
tempt subsequent con-
nections. You can choose
to have the computer cre-
ate a pairing code for you,
use the device’s existing
pairing code or you can
pair certain devices with-
out using a code.

Figure D - 3
Add a Device
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4. Enter the code into your Bluetooth enabled device and follow any on-screen
instructions to complete the pairing.

* hdd s dev /
L hdd pdeace

Figure D = 4 Type the following code into your device
Pairing Code m e oo - Pairing Codes
Example 86855920

The example outlined here shows a connection to

N M ke ' a mobile device. Other devices e.g. computers,
may have a slightly different connection proce-
dure, and may require you to confirm a pairing

iVt ke g s code is correct on both devices. Follow the on-

SRR screen instructions to complete the pairing.

5. Windows will check to see if any drivers are required to complete the pairing.
6. Follow any on-screen instructions on the computer if device drivers are required to

be installed.
7. Click Close.
Figure D -5 ' =
Pairing Complete & | rotyimase il -l
Bluetooth Device | S T e
Enabled
(=" ‘T‘_‘E B
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To Change Settings for the Bluetooth Device
1. Click the taskbar icon and select Show Bluetooth Devices. /
2. Right-click on the device you want to change and click Properties to:

¢ Change the name of the device (click Bluetooth, type a new name and click OK).
« Enable/Disable a service (click Services, clear/tick the check box next to the service and click OK).

Bluetooth Help

To get help on Bluetooth
To Make your Computer Discoverable to Bluetooth Devices 52;29”;"';; :gl‘:'o :ﬁg
1. Cl!ck the Faskbar icon and select Open Settings. _ _ _ Support from the Start
2. Click Options, and make sure that Allow Bluetooth devices to find this

. R menu. Type Bluetooth in
computer check box (Discovery) has a tick inside it. the Search Help box, and

3. Make sure that the Alert me when a new Bluetooth device wants to connect select an item from the re-
check box (Connections) has a tick inside it, if you want to be notified when a turned search results to
Bluetooth device wants to connect. get more information.

0 Eluetosth Settings =)
| [Gotrs |com ports | Hardware
Discovery
] laliow Exietacth devices tn find this coemputer
{, Ta protect your privacy, select this cheek hew oaly when
you want & Dluetooth device to find this computer,
Figure D - 6
/| Alest me when a new Bluctaoth device wants 1o connect Bluetooth Settin gs-
7] Show the Bluetooth icon in the potilsstion ares Optlo n S

Bestare Defauhs |
w | cevcel || ool
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PC Camera Module (Win7)

\ A/

’ﬁl\ If you have included a PC Camera module in your purchase option, make sure that
LSS EER ] the PC Camera module is on before installing the driver. Use the Fn + F10 key com-
SUERMEERIR ination (see “Function/Hot Key Indicators” on page 1 - 12) to toggle power to

o SRl the PC Camera module. When the PC Camera module is powered on, the on-screen
SRS BHINEER R BECEl  indicator will briefly be displayed. Make sure you install the drivers in the order in-
MEUEERCEE A dicated in Table D - 5, on page D - 26.

accompanying insert

pages, for the latest up- . ] ] ]
Sl it ke @ There are a number of different camera modules available with this computer model

Fel el CUIEE series. You will have the appropriate application installed for your camera. Make
WISIRLE EREEERUERE  sure you access the application via the WebCam desktop shortcut.

information provided
here.

N A
Z S

PC Camera Device and TV Module

If you have both an optional PC Camera and an optional TV Tuner module present, you will
need to select which device to use with the BisonCap program. Go to the Devices menu
in the BisonCap application and select the BisonCam, NB Pro device.

.|
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PC Camera Driver Installation

1. Make sure the module is powered on, then insert the Device Drivers & Utilities + User’s Manual disc
into the CD/DVD drive.

Click Option Drivers (button).

Click 1.PC Camera, Web cam > Yes.

Choose the language you prefer and click Next > Next.

Click Finish to restart the computer.

Run the camera application program from the shortcut on the desktop (if the hardware is turned off use
the Fn + F10 key combination to turn it on again).

ook wn

PC Camera Audio Setup
If you wish to capture video & audio with your camera, it is necessary to setup the audio recording options in
Windows.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).

2. Click Sound » (Hardware and Sound).

3. Click Recording (tab).

4. Right-click Microphone (Realtek High Definition Audio) and make sure the item is not disabled.

5. Double-click Microphone (or select Properties from the right-click menu).

6. Click Levels (tab), and adjust the Microphone and Microphone Boost sliders to the level required.

7. Click OK and close the control panels.

8. Run the camera application program from the desktop shortcut.

9. Go tothe Devices menu heading and select Microphone (Realtek....) (it should have a tick alongside it).

10. Go to the Capture menu heading and select Capture Audio (it should have a tick alongside it). a

.|
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4

Pre-Allocating File
Size/Space

You may pre-allocate the
file size (File > Allocate
File Size/Space) for the
capture file in the camera
program (you may need
to set a folder location
first).

Pre-allocating space on
the hard disk can improve
the capture quality (par-
ticularly of large capture
files), by reducing the
amount of work the hard
disk has to do in finding
space for the video data
as it is being captured.

See also “Reducing Vid-
eo File Size” on page D
- 39.

Camera Application

. The WebCam application is a video viewer for general purpose video viewing and

testing, and for capturing video files to .avi format.

1. Run the camera application from the desktop shortcut (it is recommended that you
set the capture file before the capture process - see “Set Capture File” on
page D - 39).

2. Go to the Capture menu heading (if you wish to capture audio check “PC Camera
Audio Setup” on page D - 37) and select Start Capture.

3. Click OK (the file location will be displayed in the pop-up box) to start capturing the
video, and press Esc to stop the capture (you can view the file using the Windows
Media Player).

D - 38 PC Camera Module (Win7)



Windows 7 Information

Set Capture File
Prior to capturing video files you may select the Set Capture File... option in the File menu, and set the file
name and location before capture (this will help avoid accidentally overwriting files). Set the name and location
then click Open, then set the ""Capture file size:" and click OK. You can then start the capture process as on
the previous page.

Note the important information in reducing video file size below in order to save file space, and help pre-
vent system problems.

Reducing Video File Size

Note that capturing high resolution video files requires a substantial amount of disk space for each file. After
recording video, check the video file size (right-click the file and select Properties) and the remaining free space
on your hard disk (go to My Computer, right-click the hard disk, and select Properties). If necessary you can
remove the recorded video file to a removable medium e.g. CD, DVD or USB Flash drive.

Note that the Windows 7 system requires a minimum of 15GB of free space on the C: drive system partition. In
order to prevent system problems it is recommended that you save the captured video file to a location other than
the C: drive (see set capture file above), limit the file size of the captured video (see “Pre-Allocating File Size/
Space” on page D - 38) or reduce video resolution (see below).

To Reduce Video Resolution Output Size:

1. Run the camera application program from the desktop shortcut.

2. Goto Options and scroll down to select Video Capture Pin....

3. Click the Output Size drop box and select a lower resolution size in order to reduce the captured file size.
4. Click OK.
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Eliminating Screen Flicker
If you find that the video screen in the camera program is flickering, you can try to
adjust the setting in the Video Capture Filter options.

1. Run the camera program from the desktop shortcut.
2. Go to Options and scroll down to select Video Capture Filter....
3. Click either 50Hz or 60Hz under Frequency in Property Page (tab).

Properties [ Properties |
Property Page | Video Proc Amp ] Camera Control 1 Property Page | Video Proc Amp |
[¥ Auto White Balance RGE gain [¥] Auto White Balance RGE gain
. 1~ Environmenit R <] | En\.d!rﬁr.\.r‘nem i
Flgure D = 7 * {utol " Tungsten G | | 9 fudo! (20 Tungsten
H H " Daylight " Fluorescent . < () Daylight | Fluorescent
Video Capture Filter . :
Rotation T < Rotation Frequency
™ Horizontal ™ Vertical " Disable " 50Hz * BDHz [T Horzental [ vetical | Disable ) 50 Hz @ 60 Hz
[ Effect Mode
Efect
12
™ Low Light Mode
" SEPIA, ﬁ
o Reset [ Resmt |
3 Carcd | & | ok | [ Concel Aopt
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Zoom
The WebCam program allows you to zoom the camera in and out.

1. Run the camera application from the desktop shortcut.
2. GotoZoom and select Zoom Out/Zoom In.

[Zoom | Help Figure D - 8

Zoom Qut Zoom/Setting

ZoomIn

Taking Still Pictures

S
The WebCam program allows you to take still pictures. ZN
Snapshot Folder

1. Run the camera application from the desktop shortcut. ,
The Snapshot folder’s de-
2. Goto Options and select Take Picture. fault location is on the desk-
3. The picture (in JPEG format) will be placed in the Snapshot folder ﬁ |on the top. Do not move this folder
desktop (see sidebar). = or an error may appear

when you try to take a still
picture.

If you accidentally delete or
move the folder, you can
create a new Snapshot
folder on the desktop in or-
der to capture the files.
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\ 7/
L&
Wireless Device

Operation Aboard
Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if

you are using the computer
aboard aircraft.

Use the Fn + F11 key com-
bination to toggle power to
the WLAN module, and
check the indicator to see if
the module is powered on
or not (see

/

).

Wireless LAN Module (Win 7)

If you have included an Intel® Wi-Fi Link 5300 Series or 3rd Party 802.11b/g/n
WLAN module in your purchase option, make sure that the Wireless LAN module is
on before installing the driver.

Use the Fn + F11 key combination (see “Function/Hot Key Indicators” on page 1 -
12) to toggle power to the Wireless LAN module. When the WLAN module is pow-
ered on, the () LED will be illuminated and the on-screen indicator will briefly be dis-
played. Make sure you install the drivers in the order indicated in Table 4 - 1, on
page 4 - 3.
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Intel® Wi-Fi Link Series Driver Installation
If you see the message “Found New Hardware” click Cancel to close the window.

1. Make sure the module is powered on, then insert the Device Drivers & Utilities + User’s Manual disc
into the CD/DVD drive.
Click Option Drivers (button).

2
3. Click 2.Wireless Lan > Yes.

4. An on-screen message will appear to show the progress of the WLAN installation.
5

When the message disappears the driver will be installed.
Note: The operating system is the default setting for Wireless LAN control in Windows 7 (see overleaf).

3rd Party 802.11b/g/n Driver Installation

1. Make sure the module is powered on, then insert the Device Drivers & Utilities + User’s Manual disc
into the CD/DVD drive.

Click Option Drivers (button).

Click 2.Wireless Lan > Yes.

Choose the language you prefer and click Next.

Click Next > Install.

Click Finish.

ok wn

Note: The operating system is the default setting for Wireless LAN control in Windows 7 (see overleaf).

.|
Wireless LAN Module (Win 7) D - 43



Windows 7 Information

Connecting to a Wireless Network
/ Make sure the Wireless LAN module is turned on.

Network and 1. Click the taskbar wireless icon ki, and then double-click an access point to connect
Sharing Center to or click to Open Network and Sharing Center if you do not see a network you
want to connect to in the taskbar menu (a list of options will appear allowing setting

You can also use the Net- changes, and creating a new network).

work and Sharing Cen-

ter control panel in

' Naot connected *
Windows (Network and
Internet) to connect to Iﬂ!l(onnections are available
any available wireless
irel I N r i ~
networks. Wireless Network Connection
ZyXEL ol
PDA_DLINK M
CADD ) i R b
. ADSL-LINKSYSY-N %
Figure D -9 - dow -
Click Taskbar Icon DI-524K ol o ot -
Menu & Network DWL-g Al
and Sharing Center 3
corega 1’1!_U
Open Network and Sharing Center

408 AM |

- me R | )
Pe W ¢ 8/11/2009
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2. You may need to enter a security key for any access point to which you are trying to
connect.

3. Click to select a network location (e.g. Home, Work or Public).

4,

Click “View or change settings in Network and Sharing Center” to access
further options for the connection.

. Figure D - 10
_ = Network Location
\:J &1 Set Network Location Set

The network location is now Work

I}, Network name: Work.com
N

Location type: Work

On Work networks, you can see other computers
and devices on the network, and your computer is
discoverable.

View or change settings in Network and Sharing Center

View computers and devices on the network

Close

.|
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N 5. Click the taskbar icon i to see any currently connected networks.
ﬂ< 6. To disconnect from the wireless network you can click the taskbar wireless icon .\,
Security Enabled click the active connection and then click Disconnect (button).

Networks

Currently connected to:
You should try to make
sure that any network you
are connecting to is a se-
cure network.

W, Work.com
EY No Internet access

Wireless Network Connection o

-
default Connected !!!!!

11

Connecting to unsecure
networks may allow unau-
thorized access to your ZyXAL. i
Computer, documents, PDA_DLINK ﬁ!ﬂ
websites and files etc.

CAOD o

corega ﬁﬂ]
Figure D - 11 il alll -
CI |Ck Tas kbar lcon Open Network and Sharing Center I

Menu - Disconnect .
5:08 AM

o e me o
o MW A ® g0
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Windows Mobility Center

The Windows Mobility Center control panel provides an easy point of access for
information on battery status, power plans used and wireless device status etc.

To access the Windows Mobility Center:

1.
2.
3.

Windows 7 Information

Click Start, and click Control Panel (or point to Settings and click Control Panel).
Double-click Windows Mobility Center (Mobile PC).

Click the button to Turn wireless off/on, or click the icon [

to access the network

menu.
@ Windows Mobility Center
-oN Display (P CImute jl 71% remaining
#=  brightness o = 3 9
U U Balanced

Brightness Volume Battery Status

i No display @ No sync . " _,
connected partnerships = Rotpresenting

Connect display I I Sync settings ‘ I Turn on

External Display Sync Center Presentation Settings

[ = | =
'JM Wireless off Flgure D - 12
Windows Mobility
Turn wireless on Center

Wireless Network

€
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Fingerprint Reader Module (Win7)

& The fingerprint reader module provides a high level of security for your computer.
Help & Manual Make sure you have administrator’s rights to your computer, and have a Windows

Right-click the taskbar icon password enabled for full security protection.

[A to bring up the menu to

select Help. Before beginning the enrollment process it is recommended that you go through the

fingerprint tutorial. To run the tutorial click Start > Programs/All Programs > Pro-

Insert the Device Drivers & 1 tactor Suite QL > Fingerprint Tutorial after installing the driver.
Utilities + User's Manual

disc and click Option Driv-

ers (button). Click Unlock | Fingerprint Reader Driver Installation

b d th lick . . - ..
él,liitf;g,p?;t >\t(ee; 1 1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD

drive.

Click Option Drivers (button).

Click 3.FingerPrint > Yes.

Click Software Installation.

Click Next > Next > Next.

Click Finish > Yes to restart the computer.

Click Documentation to
open the folder containing
the manual in .pdf format.

To install the Adobe Acrobat
Reader software to read the
file, insert the Device Driv-
ers & Utilities + User’s Man-
ual disc and click User's
Manual (button), and click
Install Acrobat Reader
(button).

ok wn

.|
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User Enrollment

1.

2.

Click Start > Control Center (Start > All Programs > Protector Suite > Control
Center), or double click the taskbar icon

On the first run of the program you will be asked to click the Accept button to
accept the license.

If you have not set a Windows password you will be prompted to do so (note: If
you have not set a password Protector Suite cannot secure access to your
computer).

Click Submit when you have entered password.

You will then be prompted to enroll your fingerprints (you can click Tutorial to get
help with fingerprint enrollment at any time).

ﬁg’,
ome *  Manage Fingerprints ¥ Usens RDOL |

@ Clicks bution ever a finger to start enroliment. Figure D _ 13
Hm.!.! mm ..’T Fingerprint
f |

| |
\

‘ | 1 Enrollment
] || M
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6. Click the button above any of the fingers to begin the enrollment process for that
2k finger.
Fingerprint 7. Swipe the finger until the progress bar reaches 100% to enroll that finger.

8. Repeat the process for all the fingers you wish to enroll (see sidebar), and then click
the close [ button to close the window.

Enrollment

Note that it is strongly rec-
ommended that you enroll
more than one finger in
case of injury etc.

Figure D - 14 —
Fingerprints
Enrolled

.|
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9. Click the taskbar icon and select Start Control Center (and then swipe a
finger) to allow you to Edit Fingerprints, register Applications, edit Settings and
access the Help menu etc. You can also run the Control Center from the Start
menu or Protector Suite > Control Center item in the All Programs menu.

10. Click “Help” in Control Center Home to get more information on any topic.

11. You can also run the Tutorial, or Product Tour video to get more information.

@ vpek.
RDO1

g Lock computer

Applications Figure D = 15
e *é Registered Sites Fingerprint Control
& regist Center & Biomenu
egister...

: Initialize Personal Safe
3

&} Control Center...

?, Help

12. If you swipe your finger over the reader at any time you can access the Biomenu
to lock the computer, register websites, access the Personal Safe, open the
Control Center and access the Help menu.
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3.75G/HSPA Module (Win 7)

Z (Optional for Model A Computers Only)
3.75G/HSPA Module || If you have included an optional 3.75G/HSPA (High Speed Packet Access) module
Options (see “Communication” on page C - 4 for specification details) in your purchase op-
There are two optional || 10N, you will have the appropriate application (HSPA Modem Interface or Mobile
3.75G/HSPA modules | Partner) provided for your module. Follow the instructions on page D - 54 to install
available for this series © the USIM card (supplied by your service provider), and then install the application

of computer models. £ (see gver for further details).
Each module is supplied
with the appropriate ap-

plication software.
The module type sup-

%
: Important Notice - 3.75G/HSPA & Bluetooth/Wireless LAN Modules
plied may depend upon
the computer model pur-
chased. Check with your
service center for de-
tails.

In order to comply with FCC regulations you should NOT operate the 3.75G/HSPA module
and the Bluetooth/Wireless LAN modules at the same time as this may disrupt radio fre-
guency, and cause interference. When the 3.75G/HSPA module is powered on, make sure
that the Bluetooth/Wireless LAN modules are powered off.

Install the driver from
the Drivers Installer
menu and check the in-
structions for the appro-
priate application on the
following pages.

|
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Before installing the application, make sure that the 3.75G/HSPA module is ON
(installing the driver with the module off will not allow the software to detect the 4
module hardware correctly). Use the Fn + [Z] key combination (see “Function/Hot

Key Indicators” on page D - 4) to toggle power to the 3.75G/HSPA module. When Mojjgggjgpgem
the 3.75G/HSPA module is powered on, the on-screen indicator will briefly be dis- Wake Ug

played. Make sure you install the drivers in the order indicated in Table D - 5, on

page D - 26. Note that exiting the application does NOT turn off the 3.75G/HSPA | Note that the 3.75G mod-
module. ules DO NOT support

system wake up on
. 3.75G/HSPA modem ac-
* HSPA Modem Interface - See “HSPA Modem Interface Installation” on tivity.

page D - 56 for driver installation information and “HSPA Modem Interface”
on page D - 57 for instructions on using the HSPA Modem Interface.

* Mobile Partner - See “Mobile Partner Application Installation” on page D -
66 for driver installation information and “Mobile Partner Application” on
page D - 67 for instructions on using the Mobile Partner application.
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USIM Card Installation

?ﬁl’: 1. Turn off the computer, and turn it over and remove the battery (see “Removing the
Battery” on page 6 - 3).
2. The SIMLOCK is located in the compartment under the battery.
3. Remove screw @ from the SIMLOCK cover, and remove the cover.
EEEIEGIIIGGEREICE] 4. Insert the USIM card as you would into your mobile phone.
any installation proce-
dures, make sure that
you have turned off the
power, and disconnect-
ed all peripherals and
cables (including tele-
phone lines). It is advis-
able to also remove your
battery in order to pre-
vent accidentally turning
the machine on.

Power Safety
Warning

Figure D - 16
Battery & SIMLOCK
Cover Removal

SIMLOCK Location

|
D - 54 3.75G/HSPA Module (Win 7)



Windows 7 Information

5. Slide the SIMLOCK towards the hinge (in the direction of the arrow illustrated in
Figure D - 17) in order to release the lock and lift it up.
6. Insert the USIM card as illustrated in (Figure D - 18) and close the SIMLOCK.

Figure D - 17
Unlock the
SIMLOCK
7. Lock the SIMLOCK by pushing it in the direction of the arrow in Figure D - 18 until
it clicks into the lock position.
Figure D - 18

SIMLOCK Lock

8. Replace the cover, screw and battery. a
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HSPA Modem Interface
\ A/ . . - .
2§ With the 3.75G/HSPA module and USIM card (supplied by your service provider)
Wireless Device installed you may then install the HSPA Modem Interface. The HSPA Modem In-
Operation Aboard terface allows you to directly access your HSPA internet service from the computer.
Aircraft .
HSPA Modem Interface Installation
The use of any portable ) _ B )
e a8 1. Enable power to the module by pressing the Fn + [Z ] key combination (the
vices aboard aircraftis usu- on-screen indicator will indicate the module’s power status). If a Found New
ally prohibited. Make sure . . . .
the module(s) are OFF if Hardware window appears, click Cancel in all windows that appear, and
you are using the computer then proceed to install the driver as below.Insert the Device Drivers & Utili-
aboardaircrat ties + User’s Manual disc into the CD/DVD drive.
Click Option Drivers (button).
Click 4.3.5 Generation Module > Yes.
Click Next > Install.
Click Finish to restart the computer.
Access the HSPA Modem Interface from the Start menu (Start > Pro-

Use the Fn + ﬁ key com-
bination to toggle power to
the 3.75G/HSPA module,
and check the indicator to
see if the module is pow-
ered on or not (see

/ grams/All Programs > HSPA modem), or by double-clicking the HSPA

oukwN

4 modem icon on the desktop.

|
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HSPA Modem Interface
The connection information is stored on the USIM card supplied by the service pro-

vider.

1. Power on the 3.75G/HSPA module using the Fn + key combination.

2. Access the HSPA Modem Interface from the Start menu (Start > Programs/All
Programs > HSPA Modem > HSPA Modem), or by double-clicking the desktop
icon fiz.

3. IfaUSIM card is not installed then a message will appear to notify you of this (click
OK to close the message and install the USIM card).

4. If you are required to enter a pin # then a message will appear to prompt you to
enter a pin #. (Note: to change pin # go to Settings and click OK in PIN
code.)

5. Click the Network connection button and the HSPA Modem interface

window will display Connection Manager.

4

Connection Manager

The connection information is commonly stored on the USIM :
card supplied by the service provider. However if your ser- Bl
vice provider requires details such as IP Address, User- S
name and Password etc. to be entered before connection i ——
you can enter them in the Connection Manager tab, or ==
save the details in Profiles. [

4

HSPA Modem Help

To get help on 3.75G/
HSPA module configu-
ration and settings, click
the help icon [&3
select Help.

Figure D - 19
HSPA Modem
Interface Window
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6. Click Connect to connect to your service provider.

Figure D - 20
Connecting to

Network —

€ |
Network connection F
7. The message “Network is connected” will be displayed when the network
connection is successful.

Figure D - 21

Network is

Connected R

s =
n I
I 5w |
F Jiten
r |
r I
I Fa I
I e frae |
e
B 8. You can then access the internet, download e-mail etc. as per any internet
connection.

|
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9.  While you are connected the upper right corner of the HSPA Modem interface will
display the upload and download rates, and the taskbar icon will display the

connection icon . Figure D - 22
Uploading/
Downloading Rates
and Speed
10. To disconnect click the Disconnect icon (Connection Manager).
11. The program will disconnect from the service provider.
12. The module will still be on, and you will need to press the Fn + Eid key combination
to turn it off.
Adding a Profile
1. Access the HSPA Modem Interface from the Start menu (Start > Programs/All
Programs > HSPA Modem > HSPA Modem), or by clicking the desktop icon.
2. Click the Network connection [, and click Profiles (tab).
Figure D - 23
Profiles

i
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3. Click Add (button) and input any Network Settings required by your service
provider.
4. Click OK to save the profile.

‘2 HSPA modem

MNetwork Settings 00 100
i .
Figure D - 24 e —
Network Settings & Frimary DIS: 5.0 .0 0
Profl IeS Secondary DNS: (R R ] Network connection
APN Name: I Connection Manager Cormection Log
IP Address: 0.8 .0 .0

Username: i
Password: I

Authentication: iNone ]‘

5. You can Edit or Delete profiles from the Profiles tab.
6. To use a profile click to select it, and then click Apply (button) and the settings will
be transferred to Connection Manager.
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1. Access the HSPA Modem Interface from the Start menu (Start > Programs/All
Programs > HSPA Modem > HSPA Modem), or by clicking the desktop icon.

2. Click Contacts (button).

® HSPA modem

Ten T M= FeT

Contacts

‘MyPhoneBock
Storage | Mame: I Phone Number
[@ S Eric @ 0923109428
[@ SiM Zoe @ 0924596715
[ER= Shane @ 0227995200

Figure D - 25
Network Settings &
Profiles

3. Click Refresh (button) to download the contacts from the USIM card to the

computer.
The Contacts will then be displayed.

o0k

Double-click any contact to edit the information (or right-click and select Edit).
You can also Export/Import contacts by clicking the appropriate button.
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4

SMS Service

In addition to standard in-
ternet services you may

also send and receive
SMS text messages us-
ing the HSPA Modem In-
terface, if your service
supports SMS.

Figure D - 26
Network Settings &
Profiles

Messages

1. Access the HSPA Modem Interface from the Start menu (Start > Programs/All
Programs > HSPA Modem > HSPA Modem), or by clicking the desktop icon.

2. Click Messages [ (button).

2 HSPA modem

i 1000

| Time [ sender
2008/10/1618:35... 0936019801
2008/10/171102...  +886931181825
(D) 2008/10/17 14:50...  +886936010350

i Draft [f) 2008/10/1916:58... 0936019801

@l Personal Folder [(i3) 2008/10/1916:58... 0936019801
2008/10/2218:35... 0936019801
2008/10/2218:35... 0936019801
() 2008/11/1815:20... +886931188820
(D) 2008/11/241336.. +886931181938
(D) 2008/11/241707.. +886931188820 |-

Forward Reply
Delete m’m’a‘;’—
—eres |
3. Click Refresh (button) to download the messages from the USIM card to the
computer.
4. Click New (button) to create a new message.
5. You can either type the telephone number in the recipient field, or press To (button)

to select the contact from the list.

|
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6. Click to select a contact from the list and then click Add (button) and the phone number will automatically be
added to the recipient field.

7. Type the message information into the message body and click Send (button) to send it, or Save to draft
(button) to save the message.

8. Select any message to forward or delete it, or to reply to it.
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Settings
1. Access the HSPA Modem Interface from the Start menu (Start > Programs/All
Programs > HSPA Modem > HSPA Modem), or by clicking the desktop icon.

2. Click Settings [l@8 (button).

@ Network
" Network Mode

PIN code

Figure D - 27 o
Settings P2

Others

& My number

——

|
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3. Click OK alongside any of the options to configure the settings.

4. The Network can be configured for an Automatic (usually from the USIM card) or
Manual connection.

5. The Network Mode can be configured for any appropriate mode required.

Network Mode
Figure D - 28
* Automatic + Automatic Settings - Network/
© Manual  2G/GPRS/EDGE Network Mode

" 3G/HSDPA/HSUPA/HSPA

You can also change your settings for the Pin #, and input your phone number.

7. Exiting the program DOES NOT turn off the 3.75G/HSPA module, and you will
need to press the Fn + [Zi key combination to turn off the module (pay careful
attention to this aboard aircraft - see “Wireless Device Operation Aboard
Aircraft” on page D - 56).

8. If the module is on and the computer enters a power-saving state, then the power
status of the module on resuming from the power-saving state will be as below:

o

» If the 3.75G/HSPA module is on and the computer is Shut Down or Restarted;
the module will be off when the computer starts up.
» If the 3.75G/HSPA module is on and the computer enters Sleep or Hibernate;
the module will be off when the computer resumes from sleep. a

|
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\ 7/
L&
Wireless Device

Operation Aboard
Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn + ﬁ key com-
bination to toggle power to
the 3.75G/HSPA module,
and check the indicator to
see if the module is pow-
ered on or not (see

/

).

Mobile Partner

With the 3.75G/HSPA module and USIM card (supplied by your service provider)
installed you may then install the Mobile Partner application. The Mobile Partner
application allows you to directly access your HSPA internet service from the com-
puter.

Mobile Partner Application Installation

1. Enable power to the module by pressing the Fn + [ | key combination (the
on-screen indicator will indicate the module’s power status). If a Found New
Hardware window appears, click Cancel in all windows that appear, and
then proceed to install the driver as below.Insert the Device Drivers & Utili-
ties + User’s Manual disc into the CD/DVD drive.

Click Option Drivers (button).

Click 4.3.5 Generation Module > Yes.

Choose the language you prefer and click OK.

Click Next.

Click I Agree (button) to accept the license agreement.

Click Next > Install.

Click Finish.

Access the Mobile Partner application from the Start menu (Start > Pro-
grams/All Programs > Mobile Partner), or by double-clicking the Mobile
Partner icon on the desktop.

CoNoU~WN

|
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Mobile Partner Application

You will need to contact your service provider to obtain the exact details of how ex-
actly to configure the settings on this page.

Profile Management

1. Power on the 3.75G/HSPA module using the Fn + [ ] key combination.

2. Access the Mobile Partner application from the Start menu (Start > Programs/All
Programs > Mobile Partner), or by double-clicking the Mobile Partner icon on the
desktop i3,

3. If you have not created a profile, click Tools and select Options, and then click
Profile Management.

4. Click New [ ®ws  and input the appropriate information for Profile Name, APN
and Authentication etc. as supplied by your service provider.

5. Click Save | s to save the profile.

Optign:
(=g ]
12 Toxt Meage Mo
- & -
2 Network. elabe
(S 0ymasec Cistat :m
Gl [
Lndn
Aigeis e s
Lisar name.
Pagswond
Bvarwed... |
3 Cancel |

4

Mobile Partner Help

To get help on Mobile
Partner  configuration
and settings, click the
Help menu and select
Online Help or press
F1.

_E!|[:| |

Orline Help...

Figure D - 29
Profile Management
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Connecting to the Service Provider

1. Power on the 3.75G/HSPA module using the Fn + key combination.

2. Access the Mobile Partner application from the Start menu (Start > Programs/All
Programs > Mobile Partner), or by double-clicking the Mobile Partner icon on the
desktop 3.

3. The software will run and you can select the Profile Name from the menu.

4. Click Connect [ zameat | to begin the connection process.

Figure D - 30 EE]
Connect =

Tul weomas oooo

F i g ure D - 3 1 Authenticatin
Network @ g

Connection Prompt
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display the connection information.

Currently connected to:

ﬁ::: Internet access

Dial-up and VPN ~
Connected a’:; 3

Wireless Network Connection ~

ZyXEL ol

PDA_DLINK M T

RD18-05_G ol

RD18-ADSL-LINKSYSY-N Ml

dlink Al

dd-wrt T

Open Network and Sharing Center

11:07 AM
9/10/2009

#® |13
—_

Windows 7 Information

6. When the connection is successful you can click the network icon in the taskbar to

Figure D - 32
Connected
Taskbar
Notification

Figure D - 33

Disconnect

You can then access the internet, download e-mail etc. as per any internet

connection.

While you are connected the indicators in the Mobile Partner window will display

uploading and downloading icons and a network icon in the taskbar .

BB 1] 0.00 kops

J_; 0.00 kbps
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9. To disconnect click the Disconnect [“gseameat | icon, or right click the taskbar icon,
click the connected icon <# and select Disconnect.

Currently connected to:

A oy Internet access
Figure D - 34

" Dhial- d VPN -~
Disconnect S

Connected (/)

|

Wireless Network Connection ~

ZyXEL o

PDA_DLINK A

Tl Hsten ooOOD0 ! B {omone oo

RO18-ADSL-LINKSYSY-N M |
o
RD18-05_G 1"|1|f

dlink Al

Open Metwork and Sharing Center

11:16 AM

- Wz @ 4T
B #0500

10. The program will disconnect from the service provider.
11. The module will still be on, and you will need to press the Fn + key combination
to turn it off.
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The module will still be on, and you will need to press the Fn + [Z] key combination

to turn it off.
If you click the Mobile Partner close icon & a message will be displayed asking
you to click OK to confirm the program exit and to terminate the connection. Figure D - 35

Exit Prompt
- ]

|9| Do you want to terminate cument connection and close Mabile Partner?

| ok || cancel |

Exiting the program terminates the connection, but DOES NOT turn off the 3.75G/
HSPA module, and you will need to press the Fn + key combination to turn off
the module (pay careful attention to this aboard aircraft - see “Wireless Device

Operation Aboard Aircraft” on page D - 66).
If the module is on and the computer enters a power-saving state, then the power
status of the module on resuming from the power-saving state will be as below:

If the 3.75G/HSPA module is on and the computer is Shut Down or Restarted;
the module will be off when the computer starts up.

If the 3.75G/HSPA module is on and the computer enters Sleep or Hibernate;
the module will be off when the computer resumes from sleep.
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